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Avsedd användning

Avsedd användning
CFX Opus Dx realtids-PCR-systemTMmed CFXMaestro Dx programvara, Security EditionTM är avsett att
utföra fluorescensbaserad PCR för att detektera och kvantifiera nukleinsyrasekvenser. System och
programvara är avsedda för in vitro-diagnostiskt bruk av utbildade laboratorietekniker. Systemen är
avsedda att användas med tredje parts diagnostiska nukleinsyratester vilka har tillverkats och märkts för
diagnostiska syften.

Symbollexikon

Tillverkare Partinummer

Används före För in vitro-diagnostik

Temperaturgräns Katalognummer

Se bruksanvisningen Antal tester

För användning med Serienummer

Endast receptbelagd användning Innehåller latex
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CE-märkning – Förordning
(EU) 2017/746 IVDR

Översättningar
Produktdokument kan tillhandahållas på ytterligare språk på elektroniska medier.
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Säkerhet och efterlevnad av föreskrifter
CFX Opus 96 Dx, CFX Opus 384 Dx och CFX Opus Deepwell Dx realtids-PCR-system (kallas i den här
guiden CFX Opus Dx-system) hettas upp och svalnar mycket snabbt under drift. För säker drift av
realtids-PCR-systemet rekommenderar Bio-Rad starkt att du följer de säkerhetsspecifikationer som
anges i det här avsnittet och i den här handboken.

Säkerhetsvarningsetiketter
Varningsetiketter uppsatta på CFX Opus Dx-system och i denna handbok varnar dig för källor till skada. I
Tabell 1 definieras alla säkerhetsvarningsetiketter.

Ikon Betydelse

Om du använder CFX Opus Dx-system innan du har läst den här handboken finns
risk för personskada. Användningen av detta instrument på ett sätt som inte
specificeras i denna handbok eller av Bio-Rad kan leda till att instrumentets
skyddsfunktioner försämras eller inaktiveras.

Det finns inga biologiska risker eller radioaktiva risker förknippade med CFX Opus
Dx-system i sig. Dessa risker blir bara ett problem när de införs i systemet via de
prover som testas. Följ de rekommenderade försiktighetsåtgärderna och
riktlinjerna för ditt laboratorium och din arbetsplats när du hanterar biofarliga eller
radioaktiva prover. Dessa riktlinjer bör omfatta rengörings-, övervaknings- och
bortskaffningsmetoder för de farliga ämnen du använder.

Dessutom finns det en liten risk för explosion eller för utdrivning av vätskor eller
ångor från provbehållarna, enligt ovan identifierad risk. När du arbetar med farligt
material förenas risken för skada från utdrivet material med risken att det farliga
materialet i sig kan spridas i och runt instrumentet. Användare bör vidta lämpliga
försiktighetsåtgärder för en sådan situation.

Tabell 1. Allmänna säkerhetsvarningar
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Säkerhet och efterlevnad av föreskrifter

Ikon Betydelse

CFX Opus Dx-system verkar på temperaturer som är tillräckligt höga för att orsaka
allvarliga brännskador. Låt alltid provblocket återgå till rumstemperatur innan du
öppnar locket och tar ut proverna. Även när provblocket har svalnat kan de
omgivande områdena såväl som värmeplattan förbli heta under en längre tid. I
situationer där det inte finns tillräckligt med tid för att låta instrumentet svalna
rekommenderas användning av skyddsutrustning som värmeskyddande handskar.

Ansvaret för säkerheten och prestandan hos alla system som innehåller ett CFX
Opus Dx-system åligger enbart den sommonterar systemet.

CFX Opus Dx-system kan bli tillräckligt varmt under normal drift för att få vätskor i
proverna att koka eller förångas, vilket gör att provbehållarna trycksätts. Det finns
en risk att provbehållarna kan gå sönder, vilket kan leda till läckage, vätskespray
eller explosiv bristning och utdrivning av ångor eller vätskor i och runt instrumentet.

Användare ska alltid använda instrumentet med locket stängt eller bära
skyddsglasögon, värmeskyddande handskar och annan personlig
skyddsutrustning under drift för att undvika skador. Om du öppnar instrumentet
medan proverna fortfarande är heta, till exempel efter att en körning har avbrutits,
kan behållare under tryck läcka, spraya eller spruta vätska. Låt alltid proverna
svalna innan du öppnar locket.

Användare ska aldrig köra en reaktion med lock eller tätning som är öppen, lös,
punkterad eller på annat sätt skadad eftersom det ökar sannolikheten för en farlig
bristning eller explosion.

Användare ska aldrig köra en reaktion med flyktiga reagenser som kan öka
sannolikheten för en farlig bristning eller explosion.

Tabell 1. Allmänna säkerhetsvarningar, forts.
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Säkerhet och efterlevnad av föreskrifter

Säkerhet och efterlevnad av föreskrifter

Säkerhetsöverensstämmelse
CFX Opus Dx-system har testats och befunnits vara i överensstämmelse med alla tillämpliga krav i
följande säkerhets- och elektromagnetiska standarder:

n IEC 61010-1:2010 Safety requirements for electrical equipment for measurement, control and
laboratory use, Part 1: General requirements

n IEC 61010-2-010:2019 Safety requirements for electrical equipment for measurement, control and
laboratory use— Part 2-010: Particular requirements for laboratory equipment for the heating of
materials

n IEC 61010-2-081:2019 Safety requirements for electrical equipment for measurement, control and
laboratory use— Part 2-081: Particular requirements for automatic and semi-automatic laboratory
equipment for analysis and other purposes

n IEC 61010-2-101:2018 Safety requirements for electrical equipment for measurement, control and
laboratory use— Part 2-101: Particular requirements for in vitro diagnostic (IVD) medical equipment

n CAN/CSA-C22.2 NO. 61010-1-12:2018 Safety requirements for electrical equipment for
measurement, control, and laboratory use, Part 1: General Requirements

n CAN/CSA-C22.2 NO. 61010-2-010:19 Safety requirements for electrical equipment for
measurement, control, and laboratory use, Part 2-010: Particular requirements for laboratory
equipment for the heating of materials

n CAN/CSA-C22.2 NO. 61010-2-081:19 Safety requirements for electrical equipment for
measurement, control, and laboratory use, Part 2-081: Particular requirements for automatic and
semi-automatic laboratory equipment for analysis and other purposes

n CSA-C22.2 NO. 61010-2-101:19 Safety requirements for electrical equipment for measurement,
control and laboratory use— Part 2-101: Particular requirements for in vitro diagnostic (IVD) medical
equipment

n EN 61010-1:2010 Safety requirements for electrical equipment for measurement, control, and
laboratory use, Part 1: General requirements

n EN 61010-2-010:2014 Safety requirements for electrical equipment for measurement, control and
laboratory use— Part 2-010: Particular requirements for laboratory equipment for the heating of
materials
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Säkerhet och efterlevnad av föreskrifter

n EN 61010-2-081:2015 Safety requirements for electrical equipment for measurement, control and
laboratory use— Part 2-081: Particular requirements for automatic and semi-automatic laboratory
equipment for analysis and other purposes

n EN 61010-2-101:2017 Safety requirements for electrical equipment for measurement, control and
laboratory use— Part 2-101: Particular requirements for in vitro diagnostic (IVD) medical equipment

n UL 61010-1:2012 Safety requirements for electrical equipment for measurement, control and
laboratory use— Part 1: General Requirements

n UL 61010-2-010:2019 Safety requirements for electrical equipment for measurement, control and
laboratory use— Part 2-010: Particular requirements for laboratory equipment for the heating of
materials

n UL 61010-2-081:2019 Safety requirements for electrical equipment for measurement, control and
laboratory use— Part 2-081: Particular requirements for automatic and semi-automatic laboratory
equipment for analysis and other purposes

n UL 61010-2-101:19 Safety requirements for electrical equipment for measurement, control and
laboratory use— Part 2-101: Particular requirements for in vitro diagnostic (IVD) medical equipment

Elektromagnetisk kompatibilitet (EMC)
CFX Opus Dx-system har testats och befunnits vara i överensstämmelse med alla tillämpliga krav i
följande elektromagnetiska kompatibilitetsstandarder:

n IEC 61326-1:2012 Electrical equipment for measurement, control and laboratory use— EMC
requirements — Part 1: General requirements. Testad som en enhet av klass A

n IEC 61326-2-6:2012 Electrical equipment for measurement, control and laboratory use— EMC
requirements — Part 2–6: Particular requirements – In vitro diagnostic (IVD) medical equipment

n EN 61326-1:2013 Electrical equipment for measurement, control and laboratory use— EMC
requirements — Part 1: General requirements. Testad som en enhet av klass A

n EN 61326-2:-6:2013 Electrical equipment for measurement, control and laboratory use— EMC
requirements — Part 2–6: Particular requirements – In vitro diagnostic (IVD) medical equipment

n FCC del 15, kapitel B, avsnitt 15.107 och 15.109. Testad som en digital enhet av klass A

n CAN ICES-003v6:2019 Interference-causing equipment standard, information technology equipment
(including digital apparatus) — Limits and methods of measurement. Testad enligt gränser för klass
A
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Säkerhet och efterlevnad av föreskrifter

Varningar och anmärkningar om EMC
n Varning! Ändringar av den här enheten som inte uttryckligen har godkänts av Bio-Rad kan upphäva

användarens behörighet att använda utrustningen.

n Obs! Den här utrustningen har testats och befunnits uppfylla gränsvärdena för en digital enhet av
klass A i enlighet med del 15 i FCC:s regler. Dessa gränsvärden är utformade för att ge ett rimligt
skydd mot skadlig interferens när utrustningen används i kommersiella miljöer. Denna utrustning
genererar, använder och kan utstråla radiofrekvensenergi. Om den inte installeras och används i
enlighet med bruksanvisningen kan den orsaka skadlig interferens på radiokommunikation.
Användning av den här utrustningen i bostadsområden kan orsaka skadlig interferens, i vilket fall
användaren måste korrigera interferensen på egen bekostnad.

n Anmärkning avseende överensstämmelse med FCC:s regler: Det här instrumentet har testats
och befunnits uppfylla del 15, kapitel B i FCC:s regler för en digital enhet av klass A, men denna
överensstämmelse är frivillig eftersom instrumentet kvalificeras som en ”undantagen enhet” enligt
47 CFR 15.103(c) med avseende på de nämnda FCC-förordningarna som gällde vid
tillverkningstillfället.

n Anmärkning avseende kablar: Detta instrument testades för EMC-överensstämmelse med
specialdesignade USB-kablar som levereras med instrumentet. Dessa kablar, eller av Bio-Rad
godkända ersättningar, måste användas med detta instrument för att säkerställa fortsatt
överensstämmelse med EMC-gränsvärdena.
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Säkerhet och efterlevnad av föreskrifter

Miljökrav
CFX Opus Dx-system har utformats för att användas säkert under de miljöförhållanden som anges i
följande tabell.

Parameter Specifikation

Miljö Endast inomhusbruk

Arbetshöjd Upp till 2 000 meter över havet

Omgivande rumstemperatur 15–31 °C

Transport- och lagringstemperatur –20° till 60 °C**
–4 till 140 °F

Relativ luftfuktighet 20 % till 80 % (icke-kondenserande)***

Driftskraft 100 till 240 V AC ±10 %, 50/60 Hz, 850 Wmax

Nätspänningsfluktuationer ±10%

Högsta effektförbrukning <850 watt

Säkringar 10 A, 250 V, 5 x 20 mm, glas (antal: 2)

Överspänningskategori II

Föroreningsgrad 2

*Om instrumentet används utanför detta temperaturområde kanske prestandaspecifikationerna inte
uppfylls. En rumstemperatur på 5–40 °C anses vara säker.

**Förvara och transportera instrumentet i dess transportbehållare för att uppfylla dessa
temperaturförhållanden.

***Användning av instrumentet vid 4 ⁰C bör begränsas till 18 timmar vid dessa förhållanden. Hållning vid
4 ⁰C kan utföras i upp till 72 timmar om luftfuktigheten är mindre än 60 % (icke-kondenserande).

Tabell 2. Miljökrav för CFX Opus Dx realtids-PCR-system
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Faror

Faror
CFX Opus Dx-system har utformats för att fungera säkert vid användning enligt tillverkaren instruktioner.
Om systemet eller någon av de tillhörande komponenterna används på ett sätt annat sätt än vad som
specificerats av tillverkaren kan instrumentets inbyggda skydd försämras. Bio-Rad är inte ansvarig för
personskada eller skada som orsakas av användningen av denna utrustning på annat sätt än vad som
specificerats, eller genommodifieringar av instrumentet som inte utförs av Bio-Rad eller ett auktoriserat
ombud. Service av CFX Opus Dx-system bör endast utföras av utbildad Bio-Rad-personal.

Biologiska risker
CFX Opus Dx-system är en laboratorieprodukt. Om prover som utgör biologiska risker förekommer, följ
nedanstående riktlinjer samt alla lokala riktlinjer som är specifika för ditt laboratorium och din arbetsplats.

Obs! Inga biologiskt farliga ämnen avges under normal användning av det här instrumentet.

Allmänna försiktighetsåtgärder

n Bär alltid laboratorierock, laboratoriehandskar och tättslutande skyddsglasögon med sidoskydd.

n Håll händerna borta från mun, näsa och ögon.

n Skydda eventuella skär- eller skrubbsår fullständigt innan du arbetar med potentiellt smittförande
material.

n Tvätta händerna noga med tvål och vatten innan du lämnar laboratoriet efter att du har arbetat med
potentiellt smittförande material.

n Ta av dig armbandsur och smycken innan du arbetar vid bänken.

n Förvara allt smittsamt eller potentiellt smittsamt material i okrossbara, läckagesäkra behållare.

n Ta av skyddskläderna innan du lämnar laboratoriet.

n Använd inte din behandskade hand för att skriva, svara i telefon, trycka på en strömbrytare eller
vidröra något som andra personer kan komma att vidröra utan handskar.

n Byt handskar ofta. Ta omedelbart av handskarna när de är märkbart kontaminerade.

n Material som inte kan saneras ordentligt ska inte exponeras för potentiellt smittsamt material.

n När ett arbete som involverar biologiskt riskavfall avslutats ska arbetsområdet saneras med lämpligt
desinfektionsmedel (t.ex. hushållsblekmedel som utspätts 1:10).
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Säkerhet och efterlevnad av föreskrifter

Ytdekontaminering

VARNING! Förhindra elektriska stötar genom att alltid stänga av och koppla ur
instrumentet innan du utför dekontamineringsprocedurer.

Följande områden kan rengöras med valfritt desinfektionsmedel av sjukhuskvalitet med baktericid, virucid
eller fungicid effekt:

n Yttre lock och hölje

n Inre provblocksyta och provblocksbrunnar

n Kontrollpanel och skärm

Se anvisningarna från produkttillverkaren när du ska bereda och applicera desinfektionsmedlet. Skölj
alltid provblocket och provblockbrunnarna flera gånger med vatten efter applicering av
desinfektionsmedel. Torka provblocket och provblocksbrunnarna noggrant efter sköljning med vatten.

Viktigt! Använd inte slipande eller frätande rengöringsmedel eller starka alkaliska lösningar. Dessa
medel kan repa ytor och skada provblocket, med förlust av exakt termisk kontroll som följd.

Kassering av smittförande material

Kassera följande potentiellt kontaminerade material i enlighet med gällande bestämmelser:

n Kliniska prover

n Reagenser

n Förbrukade reaktionskärl eller andra förbrukningsartiklar som kan vara kontaminerade

Kemiska faror
CFX Opus Dx-system innehåller inga potentiellt farliga kemiska material.

Explosions- eller brandfaror
CFX Opus Dx-systemmedför ingen ovanlig fara relaterad till brandfarlighet eller explosion när det
används på ett korrekt sätt enligt specifikationen av Bio-Rad Laboratories.

Elektriska faror
CFX Opus Dx-system utgör ingen ovanlig elektrisk fara för operatörer om det installeras och används på
rätt sätt utan fysiska modifieringar och ansluts till en strömkälla med korrekt specifikation.
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Transport

Transport
Innan du flyttar eller skickar CFX Opus Dx-systemmåste dekontamineringsprocedurer utföras. Flytta eller
transportera alltid systemet i en separat behållare i av Bio-Rad levererat förpackningsmaterial som
skyddar systemet från skador.

Kontakta ditt lokala Bio-Rad-kontor för information om transport av systemet och för att beställa lämpligt
förpackningsmaterial.

Batteri
CFX Opus Dx-system använder ett 3 V litiummetall-knappcellsbatteri för att bevara tidsinställningar vid ett
strömavbrott. Om tidsinställningen inte finns kvar när enheten har stängts av kan det tyda på att
batterierna börjar laddas ur.

VARNING! Försök inte byta batterierna. De kan inte bytas av användare. Kontakta i
stället Bio-Rads tekniska support för hjälp.

Gäller endast i delstaten Kalifornien i USA

n Perkloratmaterial – litiumbatterier innehåller perkloratmaterial, varför speciell hantering kan gälla. Se
www.dtsc.ca.gov/hazardouswaste/perchlorate.

Kassering
CFX Opus Dx-system innehåller elektrisk utrustning som inte får kasseras som osorterat avfall och måste
insamlas separat enligt EU-direktiv 2012/19/EU om elektriskt och elektroniskt avfall – WEEE-direktivet.
Före kassering ska du kontakta den lokala Bio-Rad-representanten och få landsspecifika instruktioner.

Garanti
CFX Opus Dx-system och dess tillbehör omfattas av en standardgaranti från Bio-Rad. Kontakta ditt lokala
Bio-Rad-kontor för utförlig information om garantin.
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Kapitel 1 Inledning
Bio-Rads avancerade PCR-amplifieringssystem är utformade med de senaste tekniska framstegen och
ger högre noggrannhet och reproducerbarhet vid nukleinsyreamplifiering för genomiska experiment.

Bio-Rads CFX Maestro Dx programvara, Security Edition är kompatibel med följande instrument och har
optimerade körfiler för Bio-Rads PrimePCR primer- och probanalyser:

n CFX Opus 96 Dx realtids-PCR-system (kallas CFX Opus 96 Dx i den här guiden)

n CFX Opus 384 Dx realtids-PCR-system (kallas CFX Opus 384 Dx i den här guiden)

n CFX Opus Deepwell Dx realtids-PCR-system (kallas CFX Opus Deepwell Dx i den här guiden)
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Kapitel 1 Inledning

Med hjälp av CFX Maestro Dx programvara, Security Edition (kallas CFX Maestro Dx SE i den här
vägledningen) kan du tolka komplexa data och utforma kraftfulla studier för genetisk analys. Med några få
klick kan du konfigurera studier och förstå genuttrycksstudien med hjälp av verktyg som t-test,
envägsanalyser av ANOVA, PrimePCR-kontroller samt utvärderingsverktyg för referensgener. Sedan
kan du förbereda dina resultat för publicering och presentationer med de mycket flexibla verktygen för
visning och annotation av data i CFX Maestro Dx SE.

Obs! Visningen av vissa skärmar i CFX Maestro kan se annorlunda ut än de som visas i den här
användarhandboken. Visningen i programvaran är korrekt och funktionen är densamma.

Viktigt! Cybersäkerhet innebär att skydda tillgångar i cyberrymden från cyberattacker.
Cybersäkerhet är Bio-Rads förmåga att skydda personer, information, system och sitt rykte i
cyberrymden. Cyberrymden är en tekniskt sammankopplad värld som alltid är igång. Den består av
personer, organisationer, information och teknik.

När det kommer till cybersäkerhetsproblem är det viktigt att reagera snabbt! Om du misstänker ett
cybersäkerhetsproblem rörande ditt instrument eller ett cybersäkerhetsintrång på din webbplats kontaktar
du omedelbart din Bio-Rad-representant för teknisk support.
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Viktiga funktioner i CFX Maestro Dx programvara, Security Edition

Viktiga funktioner i CFX Maestro Dx programvara, Security
Edition

Med CFX Maestro Dx SE kan du göra följande:

n Analysera data med hjälp av stapeldiagram, clustergram eller spridningsdiagram för att snabbt tolka
och förstå dina resultat.

n Anpassa din datarepresentation och exportera grafik med hög upplösning för publicering och
rapportgenerering.

n Bestämma RNA-kvalitet och felsöka experiment med PrimePCR-analysreglagen.

n Välja lämplig referensgen och analysera dess stabilitet med verktyget Reference Gene selection
(Referensgensval).

n Utföra statistisk analys, bl.a. envägs-ANOVA, i genuttrycksanalysen.

I den här användarhandboken förklaras dessa funktioner och hur de används.

Ytterligare information
När du har installerat CFX Maestro Dx SE och konfigurerat tillhörande Bio-Rad PCR-instrument har du
åtkomst till den här guiden och detaljerad hjälp för CFX Maestro Dx SE på menyn Help (Hjälp) i alla vyer.

Tips: Klicka på Bio-Rad-logotypen i det övre högra hörnet av ett CFX Maestro Dx SE-fönster för att
gå till Bio-Rads webbplats. På webbplatsen finns länkar till tekniska anteckningar, handböcker,
videor, produktinformation och teknisk support. Den här webbplatsen erbjuder även många tekniska
resurser för ett flertal metoder och applikationer relaterade till PCR, realtids-PCR och genuttryck.
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Kapitel 2 Installera CFX Maestro Dx programvara,
Security Edition

I det här kapitlet beskrivs hur du installerar CFX Maestro Dx programvara, Security Edition. Information
om konfiguration av realtids-PCR-instrument som stöds av Bio-Rad finns i motsvarande handbok.

CFX Maestro Dx SE krävs för att analysera realtids-PCR-data från realtids-PCR-systemen CFX Opus 96
Dx, CFX Opus 384 Dx och CFX Opus Deepwell Dx. Du kan också använda den här programvaran för att
kontrollera dessa system i ett programvarukontrollerat läge.

CFX Opus Dx-system levereras med en USB-kabel i tillbehörsväskan. Använd USB-kabeln för att ansluta
datorn som kör CFX Maestro Dx SE till CFX Opus Dx-system.

Ta bort förpackningsmaterialet och spara det för framtida användning. Om en artikel saknas eller är
skadad kontaktar du det lokala Bio-Rad-kontoret.
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Kapitel 2 Installera CFX Maestro Dx programvara, Security Edition

Systemkrav
I Tabell 3 listas minimisystemkraven och de rekommenderade systemkraven för datorn som kör
CFX Maestro Dx SE.

System Minimikrav Rekommenderat krav

Operativsystem Microsoft Windows 10 (endast 64-
bitars), build 1511 eller senare,
med de senaste
säkerhetsuppdateringarna.

Microsoft Windows 10 (endast 64-bitars),
build 1511 eller senare, med de senaste
säkerhetsuppdateringarna.

Obs!Windows 11 stöder också CFX Maestro Dx programvara, Security Edition.

Viktigt! Säker start måste inaktiveras på datorer som kör CFX Maestro Dx SE. Datorer som kör
CFX Maestro Dx SE ska konfigureras så att de inte startar om automatiskt efter en system- eller
säkerhetsuppdatering om en körning pågår. Kontakta systemadministratören om du behöver hjälp.

Portar 2 USB 2.0-höghastighetsportar 2 USB 2.0-höghastighetsportar

Hårddiskutrymme 128 GB 128 GB

Processorhastighet 2,4 GHz, Dual Core 2,4 GHz, Quad Core

RAM 4 GB RAM 8 GB RAM

Skärmupplösning 1 024 x 768 med True Color-läge 1 280 x 1 024 med True Color-läge

PDF-läsare Adobe PDF Reader eller Windows PDF
Reader från en av Microsoft Office-
programsviterna som stöds:

n 2016

n 2019

Lokalisering Microsoft Windows 64-bitars
operativsystem som stöds på
engelska, kinesiska och ryska

Microsoft Windows 64-bitars
operativsystem som stöds på engelska,
kinesiska och ryska

Tabell 3. Datorkrav för CFX Maestro Dx SE

Obs! Om du planerar att köra CFX Automation Control-programvaran på samma dator som
CFX Maestro Dx SE ska du ställa in skärmupplösningen på 1 280 x 1 024 med True Color-läge.
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Installera CFX Maestro Dx SE-programvaran

Installera CFX Maestro Dx SE-programvaran
Viktigt! Du måste koppla bort alla anslutna instrument från CFX Maestro Dx SE-datorn innan du
installerar eller uppgraderar programvaran. Du behöver inte stänga av instrumentet under
programvaruinstallationen. Säkerställ att du har sparat alla körningar och att inga experiment körs.

Obs! Kontrollera att Säker start är inaktiverat innan du påbörjar installationen. Kontrollera att datorn
är konfigurerad så att den inte startar om automatiskt efter en system- eller säkerhetsuppdatering om
en körning pågår. Kontakta systemadministratören om du behöver hjälp.

Så här installerar du programvaran CFX Maestro Dx SE

1. Koppla bort eventuella anslutna instrument från datorn.

Sök upp och koppla bort instrumentets USB-kabel på CFX Maestro Dx SE-datorn. Änden som är
inkopplad i CFX Opus Dx-system kan sitta kvar.

2. Logga in på CFX Maestro Dx SE-datorn med administratörsbehörighet.

3. Sätt in USB-enheten med CFX Maestro Dx SE-programvaran i datorns USB-port.

4. Gå till och öppna USB-enheten CFX Maestro Dx SE i Utforskaren.

På USB-enheten finns Release Notes (Versionsinformation) och följande mappar:

n CFX

n Drivers (Drivrutiner)

n Firmware (Fasta program)

n Quick Start (Snabbstart)

Utöver andra filer innehåller mappen CFX installationsprogrammet för CFX Maestro Dx SE
(CFXMaestroDxSetup.exe).

5. Öppna mappen CFX och dubbelklicka på CFXMaestroDxSetup.exe för att starta
installationsprogrammet.

6. Följ installationsanvisningarna på skärmen.

När det är klart visas ikonen Bio-RadCFX Maestro Dx programvara, Security Edition på datorns
skrivbord.

Tips: CFXMaestro-installationsprogrammet installerar automatiskt användarhandboken för
CFX Maestro Dx programvara, Security Edition. Du hittar dessa guider genom att gå till menyn
Help (Hjälp) och välja Open User Guides (Öppna användarhandböcker).

7. När installationen är slutförd är det säkert att mata ut programvarans USB-enhet.
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Kapitel 2 Installera CFX Maestro Dx programvara, Security Edition

Detektera anslutna instrument
Installationsprogrammet för CFX Maestro Dx SE installerar automatiskt instrumentets drivrutiner på
CFX Maestro Dx SE-datorn. CFX Maestro Dx SE detekterar anslutna instrument när du startar
programvaran.

Så här detekterar du anslutna instrument

1. Om du inte har gjort det ännu sätter du in den fyrkantiga (han-)änden av den medföljande USB
Type B-kabeln i USB Type B-porten på baksidan av instrumentets bas.

2. Sätt in den andra (port-)änden i en USB-port på CFX Maestro Dx SE-datorn.

3. Om instrumentet inte är igång trycker du på strömbrytaren på instrumentet för att starta det.

4. Starta CFX Maestro Dx SE.

Programvaran detekterar automatiskt det anslutna instrumentet och visar dess namn i rutan Detected
Instruments (Hittade instrument) i hemfönstret.

Obs! Om inte instrumentet visas i rutan Detected Instruments (Hittade instrument) kontrollerar du att
USB-kabeln sitter fast ordentligt. Du installerar om drivrutinerna genom att välja Tools > Reinstall
Instrument Drivers (Verktyg > Installera om instrumentdrivrutiner) i hemfönstret i CFX Maestro Dx
SE.
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Programvarufiler

Programvarufiler
I Tabell 4 listas filtyperna i CFX Maestro Dx SE.

Filtyp Tillägg Information

Protokoll .prcl Innehåller information om protokollinställning för att utföra
en PCR-körning.

Platta .pltd Innehåller information om plattinställning för att utföra en
PCR-körning.

Data .pcrd Innehåller resultaten av en experimentkörning och PCR-
analys.

PrimePCR-körning .csv Innehåller protokollet och plattlayouten för PrimePCR-
plattor.

Genstudie .mgxd Innehåller resultaten av flera PCR-körningar och
genuttrycksanalyser.

Fristående fördatafil .zpcr Innehåller fluorescensavläsningar från fristående drift som
har konverterats till en datafil.

LIMS .plrn Innehåller information om plattinställning och -protokoll som
krävs för att utföra en LIMS-kompatibel körning.

JSON .json En skrivskyddad fil som endast genereras av CFX Opus Dx-
system. Den här filen innehåller körningsfilsdata som visas i
informationsfönstret i filläsaren när en körningsfil väljs. Den
här filen genereras när en körning har slutförts. Den
exporteras med .zpcr-filen och sparas med datafilerna när
Save Location (Plats för att spara) är antingen en USB-
enhet eller en delad nätverksmapp.

Tabell 4. CFX Maestro Dx SE filtyper
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Kapitel 3 Hantera användarkonton i CFX Maestro
Dx programvara, Security Edition

I CFX Maestro Dx programvara, Security Edition loggar användare in med sitt Windows-användarnamn
och lösenord. Personen som installerade CFX Maestro Dx SE tilldelas automatiskt rollen som
administratör och kan skapa och hantera användarkonton och roller. Alla andra användare måste tilldelas
ett användarkonto för att kunna logga in och använda programvaran.

Viktigt! Varje användare måste ha ett Windows-konto och ett lösenord på CFX Maestro Dx SE-
datorn innan du kan tilldela ett användarkonto och roll. Användare kan vara medlemmar antingen i
gruppenWindows-användare eller Windows-administratörer. Medlemmar i gruppenWindows-
användare har endast tillgång till sina egna CFX Maestro Dx SE-filer och mappar. Medlemmar i
gruppenWindows-administratörer har åtkomst till alla användares filer och mappar på datorn.

Det här kapitlet förklarar hur du skapar Microsoft Windows-användare för att lägga till dessa användare i
CFX Maestro Dx SE. Det här avsnittet förklarar också hur du lägger till CFX Maestro Dx SE-användare
och hanterar användarroller och behörigheter.
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Kapitel 3 Hantera användarkonton i CFX Maestro Dx programvara, Security Edition

Starta CFX Maestro Dx programvara, Security Edition
Obs! Varje användare måste logga in med sitt Windows-användarnamn och -lösenord.

Så här startar du CFX Maestro Dx SE

1. På skrivbordet på CFX Maestro Dx SE-datorn, dubbelklicka på genvägsikonen för CFX Maestro Dx
SE för att starta programmet.

2. Skriv ditt Windows-lösenord i dialogrutan Login (Inloggning) och klicka på OK.

CFX Maestro Dx SE öppnas i hemfönstret. Titelfältet visar Windows-användarnamnet för den
inloggade användaren och menyraden visar ett blått märke som indikerar att programvaran är 21
CFR Part 11-kompatibel, till exempel:
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Starta CFX Maestro Dx programvara, Security Edition
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Kapitel 3 Hantera användarkonton i CFX Maestro Dx programvara, Security Edition

Lägga till Microsoft Windows-användare på datorn med CFX
Maestro Dx programvara, Security Edition

Alla användare måste logga in på CFX Maestro Dx SE-datorn med sitt Windows-användarnamn och -
lösenord. För korrekt revisionsloggning kanWindows-användarkonton inte läggas till via dialogrutan Start
> Inställningar > Konton. Windows-användarkontonmåste läggas till via konsolen Datorhantering.

Viktigt! OmWindows-användares egenskaper ändras (inklusive användarnamn och fullständigt
namn) efter att du har skapat den tillhörande CFX Maestro Dx SE-användaren, blir CFX Maestro Dx
SE-användaren ogiltig. Se till att informationen är korrekt innan du sparar Windows-användaren och
skapar motsvarande CFX Maestro Dx SE-användare.

Tips: Läs Microsofts dokumentation omWindows-administration och kontakta Windows-
systemadministratören för mer information innan du skapar Windows-konton.

Så här lägger du till Windows-användarkonton på CFX Maestro Dx SE-datorn

1. Logga in på CFX Maestro Dx SE-datorn sommedlem i gruppenWindows-administratör.

2. På skrivbordet högerklickar du på Den här datorn och väljer Hantera för att öppna konsolen
Datorhantering.

3. Expandera Lokala användare och grupper på datorhanteringskonsolen.

4. Högerklicka på mappen Användare och välj Ny användare för att öppna dialogrutan Ny användare.
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Lägga till Microsoft Windows-användare på datorn med CFX Maestro Dx programvara, Security Edition

5. I dialogrutan Ny användare måste du fylla i följande fält:

n Användarnamn

n Fullständigt namn

n Lösenord

n Bekräfta lösenord

6. Klicka på Skapa.
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Kapitel 3 Hantera användarkonton i CFX Maestro Dx programvara, Security Edition

Lägga till och ta bort användare i CFX Maestro Dx
programvara, Security Edition

Tips: Endast användare med rollen CFX Maestro Dx SE-administratör kan skapa och ta bort
CFX Maestro Dx SE-användarkonton. Den person som installerade CFX Maestro Dx SE tilldelas
automatiskt administratörsrollen. Den personen kan tilldela administratörsrollen till andra användare.

Obs! I CFX Maestro Dx SE måste minst en användare ha tilldelats administratörsrollen.

Så här lägger du till CFX Maestro Dx SE-användarkonton

1. Kontrollera att varje avsedd användare antingen är medlem i gruppenWindows-användare eller
Windows-administratörer och har ett Windows-lösenord på CFX Maestro Dx SE-datorn.

2. Starta CFX Maestro Dx SE och logga in som administratör.

3. Välj User > User Administration (Användare > Användarhantering) i hemfönstret.

Dialogrutan User Administration (Användarhantering) visas.
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4. I avsnittet Manage Users (Hantera användare) anger du följande information för varje användare:

n User name (Användarnamn) – i CFX Maestro Dx SEmåste det här vara användarens
Windows-användarnamn för inloggning.

n Full name (Fullständigt namn) – användarens fullständiga namn.

Det här namnet visas i fältet Full User (Fullständig användare) i revisionsloggen. Det här namnet
måste vara samma namn som angetts i fältet Fullständigt namn när Windows-användaren
skapades.

n Role (Roll) – den roll som användaren ska tilldelas.

Obs! Du kan bara välja en roll från listrutan. Se Hantera användarroller i CFX Maestro Dx
programvara, Security Edition för mer information.

n Domain (Domän) – Windows-domänen varifrån användaren använder programvaran.

Kontakta Windows-systemadministratören för mer information.

5. Klicka på OK och sedan på Yes (Ja) för att spara ändringar och stänga dialogrutan User
Administration (Användaradministration).

Så här tar du bort ett CFX Maestro Dx SE-användarkonto

1. Starta CFX Maestro Dx SE och logga in som administratör.

2. I hemfönstret väljer du User (Användare) > User Administration (Användaradministration) för att
öppna dialogrutan User Administration (Användaradministration).

3. Välj Remove (Ta bort) för varje användare som du vill ta bort i rutan Manage Users (Hantera
användare).

4. Klicka på OK och sedan på Yes (Ja) för att spara ändringar och stänga dialogrutan User
Administration (Användaradministration).

Hantera användarroller i CFX Maestro Dx programvara,
Security Edition

Viktigt! CFX Maestro Dx SE kräver att minst en användare tilldelas rollen Administratör. Du kan
tilldela den här rollen till mer än en användare.

CFX Maestro Dx SE har fyra användarroller. Varje användare måste tilldelas en roll för att få åtkomst till
programvaran. En användare kan bara tilldelas en roll, men du kan när som helst ändra en användares
roll.
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Förutom för rollen Administratör kan du ändra vilken behörighet som är tilldelad varje roll. Alla användare
som tilldelats en roll ärver bara behörigheterna för den rollen.

Som standard är rättigheterna för varje roll följande:

n Administrator (Administratör) – den här rollen har alla behörigheter, du kan inte ändra dessa
behörigheter.

n Principal (Huvudansvarig) – den här rollen har alla behörigheter utom att konfigurera e-post.

n Operator (Operatör) – den här rollen har alla behörigheter utom att hoppa över cykler och konfigurera
e-post.

n Guest (Gäst) – den här rollen kan endast läsa filer.

Fastställ noggrant kraven för varje användare när du tilldelar roller i CFX Maestro Dx SE. Utan behörighet
att spara kommer till exempel användare som tilldelats gästrollen inte att kunna signera en fil. Utan
behörighet att konfigurera ett e-postkonto får ingen av rollerna e-post när en körning är klar.

Så här ändrar du behörigheterna för en roll

1. Starta CFX Maestro Dx SE och logga in som administratör.

2. I hemfönstret väljer du User (Användare) > User Administration (Användaradministration) för att
öppna dialogrutan User Administration (Användaradministration).

3. I avsnittet Manage Rights (Hantera rättigheter) väljer du att för varje roll markera eller avmarkera
kryssrutan för specifika behörigheter, allt efter behov.

4. Klicka på OK och sedan på Yes (Ja) för att spara ändringar och stänga dialogrutan User
Administration (Användaradministration).

Visa din roll och behörighet
Tips: Användare som är tilldelade rollerna Principal (Huvudanvändare), Operator (Operatör) eller
Guest (Gäst) kan bara se sina egna användarinställningar, behörigheter och roller. Användare som
tilldelats rollen Administrator (Administratör) kan visa alla användarbehörigheter och roller.

Så här visar du din aktuella användarroll och behörighet

u Välj User > User Administration (Användare > Användarhantering) i hemfönstret.

Kontakta CFX Maestro Dx SE-administratören för att ändra användarinställningar, behörigheter och roller
som listas i fönstret User Administration (Användarhantering).
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Viktigt! CFXMaestro Dx programvara, Security Edition använder Microsoft Windows-
användarautentisering för att verifiera åtkomst till säkra CFX-datafiler. Kontakta Windows-
administratören för att skapa en miljö som uppfyller 21 CFR Part 11-krav.

Med CFX Maestro Dx SE kan användare

n signera data- och genstudiefiler

n lösenordsskydda datafiler

n visa och skriv ut revisionsloggar.

Det här avsnittet förklarar dessa funktioner i detalj.

Säkra filer
Som standard sparar CFX Maestro Dx SE säkra filer i den inloggade användarens personliga mapp, som
finns på

C:\Users\<användarnamn>\Documents\Bio-Rad\CFX_MDX\My qPCR

Du kan spara och redigera .pcrd-filer i den mappen. Den här mappen innehåller länkar till andra mappar
(till exempel mappen Sample Files) som innehåller filer som är skrivskyddade. En administratör kan dock
ta bort innehållet i den mappen.

Tips: Alternativt kan Windows-systemadministratören skapa en delad mapp och CFX Maestro Dx
SE-administratören kan programmera programvaran att spara alla filer i den mappen.

I CFX Maestro Dx SE markeras platt-, protokoll-, data- och genstudiefiler som säkra när de sparas. Du
kan skapa dessa filer i CFX Maestro-programvaran eller i CFX Maestro Dx SE. När de har sparats i
CFX Maestro Dx SE kan du bara öppna dessa filer i CFX Maestro Dx SE.

CFX Maestro Dx SE skapar en revisionslogg för alla säkra data- och genstudiefiler (.pcrd- och .mgxd-
filer). Programvaran registrerar all revideringsbar aktivitet i filens revisionslogg. Mer information finns i
Revisionsloggar på sidan 301.
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Signera säkra filer

När en fil har sparats i CFX Maestro Dx SE kan användare lägga till en elektronisk signatur. För att
signera en fil måste användarens roll ha behörighet att spara en fil. Till exempel har gästrollen som
standard inte behörighet att spara en fil och därför kan användare som tilldelats denna roll inte signera en
fil.

I CFX Maestro Dx SE är signerade filer inte inställda som skrivskyddade. De kan granskas, modifieras
och signeras flera gånger. Alla ändringar och signaturer spåras i filens revisionslogg. Du kan signera
följande filtyper:

n Datafiler (.pcrd)

n Genstudiefiler (.mgxd)

Obs! Filer måste sparas innan de kan signeras. Om du nyligen har genomfört en körning i
CFX Maestro Dx SE måste du först spara den resulterande datafilen.

Så här signerar du en fil

1. Logga in i CFX Maestro Dx SE med dina Windows-inloggningsuppgifter.

2. Öppna den säkra datafilen eller genstudiefilen för att signera den.

3. Välj File > Sign (Arkiv > Signera). Dialogrutan Electronic Signature (Elektronisk signatur) visas.
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4. Ange ditt Windows-användarnamn och -lösenord och anledningen till att signera filen.

Användarnamnet och anledningen till signering registreras i revisionsloggen (för mer information se
Revisionsloggar på sidan 301).

5. Klicka på OK för att skicka signaturen och stänga dialogrutan.

Modifiera säkra filer

I CFX Maestro Dx SE kan användare modifiera säkra filer, inklusive signerade och osignerade data- och
genstudiefiler. Programvaran uppmanar dig att ange en anledning till ändringen när du sparar en
modifierad, säker data- eller genstudiefil. Ändringarna spåras i filens revisionslogg.

Tips: Eftersom programvaran inte skapar revisionsloggar för platt- eller protokollfiler uppmanas du
inte att ange en anledning när du sparar ändringar i dessa filer.

Så här sparar du en modifierad data- eller genstudiefil

1. Logga in i CFX Maestro Dx SE med dina Windows-inloggningsuppgifter.

2. Öppna och modifiera en säker datafil eller genstudiefil.

Tips: För en lista över revideringsbara aktiviteter, se Revideringsbara händelser på sidan 303.

3. Välj File > Save (Arkiv > Spara). Dialogrutan Audit Trail Change Reason (Orsak till ändring i
revisionslogg) visas.
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Den här dialogrutan visar följande information, som registreras i filens revisionslogg för varje
ändringshändelse:

n Date (Datum) – datumet då ändringen inträffade.

n User (Användare) – Windows-domänen och användarnamnet för den inloggade användaren.

n Comment (Kommentar) – den senast sparade kommentaren.

n Signature (Signatur) – den elektroniska signaturen för den sista personen som signerade filen.

n Signature reason (Signaturskäl) – anledningen till signaturen.

n Application (Program) – CFX Maestro Dx SE (visas som BioRadCFXManager.exe, vilket är
korrekt).

n Application version (Programversion) – den aktuella versionen av CFX Maestro Dx SE.

n Full user (Fullständig användare) – den inloggade användarens fullständiga namn.

Obs! Det här namnet visas i revisionsloggen.

n Machine (Maskin) – den dator där programvaran är installerad.
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Ändringstabellen visar de revideringsbara ändringarna som inträffat till följd av modifieringen. En kort
beskrivning av orsaken till ändringen kan också visas.

Tips: Du kan lägga till eller redigera beskrivningar i kolumnen Reason for Change (Orsak till
ändring).

4. Granska listan över ändringar. Ange detaljerade skäl vid behov.

5. Gör något av följande:

n Klicka på Save Changes (Spara ändringar) för att spara ändringarna i filen och eventuella
ändringar du gjort i tabellen och stänga dialogrutan.

Ändringarna i filen och orsakerna till ändringarna visas i filens revisionslogg.

n Klicka på Cancel Changes (Avbryt ändringar) för att återställa filen till dess tidigare tillstånd och
stänga dialogrutan.

Ändringarna sparas inte i filen och revisionsloggen uppdateras inte.
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Lösenordsskydda filer

Som en extra säkerhetsnivå kan användare ange lösenord på alla säkra filer i CFX Maestro Dx SE. Tänk
på följande villkor när du ställer in lösenord på en säker fil:

Villkor Åtgärd

Inget lösenord krävs. Alla användare kan öppna, ändra och spara den säkra
filen, baserat på deras behörigheter.

Filen kräver lösenord för att
spara.

Alla användare kan öppna den säkra filen och
användare som känner till lösenordet för att spara kan
ändra och spara den säkra filen.

Filen kräver lösenord för att
öppnas.

Endast användare som känner till lösenordet för att
öppna kan öppna, ändra och spara den säkra filen.

Filen kräver både lösenord för att
öppna och spara.

Vissa användare kan öppna den säkra filen och en
delgrupp av dessa användare kan ändra och spara filen.

Beroende på användarens roll kan alla användare utföra Save As (Spara som) för att skapa en ny säker fil
med ett annat namn eller spara en fil med samma namn på en annan plats så länge något av följande är
sant:

n Den säkra filen är inte lösenordsskyddad.

n Användaren har lösenordet för att öppna filen.

Tips: Den nya filen sparas utan lösenordsskydd. Originalfilen behåller sina lösenord.

Beroende på roll kan en användare ändra och spara originalfilen så länge något av följande är sant:

n Filen är inte lösenordsskyddad.

n Användaren har lösenordet för att öppna filen och lösenordet för att spara filen.

Obs! Användarens roll måste omfatta behörighet att spara filer för att kunna ange lösenord.
Användare med rollen Gäst kan till exempel inte spara filer och kan därför inte ange lösenord för en
fil.

Viktigt! Endast CFX Maestro Dx SE-administratörer kan återställa eller ta bort lösenord.
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Så här lösenordsskyddar du en fil

1. Logga in i CFX Maestro Dx SE med dina Windows-användaruppgifter.

2. Öppna den säkra filen.

3. Välj File > File Passwords (Arkiv > Fillösenord). Dialogrutan File Passwords (Fillösenord) visas.

4. Ange lösenord i rutorna Save Password (Lösenord för att spara) och Open Password (Lösenord för
att öppna).

Tips: Som standard visas lösenord som asterisktecken när de skrivs. Välj Show Password (Visa
lösenord) för att visa lösenordet när du skriver det.

Viktigt! Lösenord är skiftlägeskänsliga. CFX Maestro Dx SE anger inga begränsningar för
lösenord. Kontakta din systemadministratör för lösenordskrav på din arbetsplats för information
om bästa praxis.

5. Klicka på Set Passwords (Ange lösenord) för att ange lösenorden och stänga dialogrutan.

6. Välj File > Save (Arkiv > Spara) för att spara ändringarna i filen.
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Så här tar du bort lösenord

Viktigt! Du måste vara CFX Maestro Dx SE-administratör för att ta bort lösenord.

1. Klicka på Remove Passwords (Ta bort lösenord) i dialogrutan Password Required (Lösenord krävs).

Dialogrutan CFX Maestro Dx SE Login (Inloggning i CFX Maestro Dx SE) visas.

2. AngeWindows-användarnamnet och lösenordet för CFX Maestro Dx SE-administratören och klicka
på OK.

Den ursprungliga datafilen visas.

Viktigt! Du måste spara filen för att ta bort lösenorden.

3. Välj File > Save (Arkiv > Spara) för att spara ändringarna i filen.
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Så här ändrar du lösenord

Viktigt! Endast CFX Maestro Dx SE-administratörer kan ändra lösenord.

1. Öppna den säkra filen.

2. Välj File > File Passwords (Arkiv > Fillösenord). Dialogrutan File Passwords (Fillösenord) visas.

Tips: Save Password (Lösenord för att spara), Open Password (Lösenord för att öppna) och
Show Password (Visa lösenord) är inaktiverade.

3. Klicka på Reset Passwords (Återställ lösenord).

Dialogrutan CFX Maestro Dx SE Login (Inloggning i CFX Maestro Dx SE) visas.
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4. AngeWindows-användarnamnet och lösenordet för CFX Maestro Dx SE-administratören och klicka
på OK.

Dialogrutan File Passwords (Fillösenord) visas.

5. Gör något av följande:

n Om du vill återställa lösenordsskyddet, skriv ett nytt lösenord i motsvarande lösenordsruta.

n Om du vill ta bort lösenordsskyddet, avmarkera rutorna för lösenorden.

6. Klicka på Set Passwords (Ange lösenord) för att spara lösenordsändringarna och stänga dialogrutan.
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Kapitel 5 Arbetsytan
CFXMaestro Dx programvara, Security Edition tillhandahåller ett gränssnitt för att ställa in plattor,
utveckla PCR-protokoll, köra dem på CFX Opus Dx Deepwell Dx-instrument och analysera data från
PCR-körningar.

CFX Maestro Dx SE har fem primära arbetsytor:

n Hemfönstret

n Startup Wizard (Startguide)

n Fönstret Protocol Editor (Protokollredigerare)

n Fönstret Plate Editor (Plattredigerare)

n Fönstret Data Analysis (Dataanalys)

I det här kapitlet visas och beskrivs alla dessa arbetsytor.
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Hemfönstret
CFX Maestro Dx SE öppnas i hemfönstret och visar Startup Wizard (Startguide) där du kan ställa in ett
experiment, utföra eller upprepa en körning eller analysera en befintlig körning. Från hemfönstret kan du
även visa program- och instrumentloggar, skapa och hantera användare och få åtkomst till flera
användbara verktyg. För mer information, se Kapitel 6, Hemfönstret.
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Startup Wizard (Startguide)

Startup Wizard (Startguide)
Med Startup Wizard (Startguide) konfigurerar och kör du snabbt användardefinierade experiment eller
väljer och kör ett PrimePCR-experiment. Med guiden kan du även upprepa en körning och analysera
kördata.
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Fönstret Protocol Editor (Protokollredigerare)
I Protocol Editor (Protokollredigerare) kan du skapa, öppna, granska och redigera ett protokoll. Du kan
också modifiera locktemperaturen för det öppna protokollet. Funktionerna för Protocol Editor
(Protokollredigerare) beskrivs i Kapitel 7, Skapa protokoll.
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Fönstret Plate Editor (Plattredigerare)

Fönstret Plate Editor (Plattredigerare)
Du kan skapa, öppna, granska och redigera plattor i Plate Editor (Plattredigerare). Plattredigerarens
funktioner beskrivs i Kapitel 8, Förbereda plattor.
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Fönstret Data Analysis (Dataanalys)
I fönstret Data Analysis (Dataanalys) kan du visa och jämföra körningsdata, göra statistiska analyser,
exportera data och skapa publiceringsfärdiga rapporter. Funktionen för dataanalys beskrivs i Kapitel 10,
Översikt över dataanalyser och Kapitel 11, Dataanalysinformation.
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Kapitel 6 Hemfönstret
CFXMaestro Dx programvara, Security Edition tillhandahåller ett gränssnitt för att utveckla PCR-
protokoll, köra dem på CFX Dx-system och analysera PCR-körningsdata.

I det här kapitlet presenteras CFX Maestro Dx SE och förklaras funktionerna som är tillgängliga i
hemfönstret.
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Hemfönstret
CFX Maestro Dx SE öppnas i hemfönstret och visar Startup Wizard (Startguide) där du kan konfigurera
en körning, utföra eller upprepa en körning eller analysera en befintlig körning. Från hemfönstret kan du
även visa program- och instrumentloggar, skapa och hantera användare och få åtkomst till flera
användbara verktyg.

1. Programvarans titelfält visar namnet på programvaran och inloggad användare.

2. Menyraden ger snabb åtkomst till menykommandon för File (Arkiv), View (Visa), Run (Körning),
Window (Fönster) och Help (Hjälp).

3. Kommandon på verktygsraden ger snabb åtkomst till menyalternativ.

4. Den vänstra rutan visar instrument som är anslutna till CFX Maestro Dx SE-datorn och har
knappar som du kan använda för att styra locket och visa instrumentens status.

5. Huvudrutan visar arbetsfönstret. Standardarbetsfönstret på startskärmen är Startup Wizard
(Startguide).

FÖRKLARING
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6. Statusfältet visar namnen på de anslutna instrumenten och den inloggade användaren.

Kommandon på menyn File (Arkiv)
New (Ny) – öppnar en dialogruta där du kan välja att skapa ett nytt protokoll, en ny platta eller en ny
genstudie.

Open (Öppna) – öppnar en dialogruta där du kan välja att gå till och öppna ett befintligt protokoll, en
befintlig platta, en befintlig datafil, en befintlig genstudie, en befintlig LIMS-fil, en befintlig körning på ett
fristående instrument (fristående körning) eller en befintlig PrimePCR-körningsfil.

Recent Data Files (Senaste datafiler) – visar en lista över nyligen öppnade PCR-filer.

Repeat a Run (Upprepa en körning) – öppnar Utforskaren på platsen för de sparade PCR-filerna där du
kan hitta en körning som ska upprepas.

Exit (Avsluta) – stänger CFX Maestro Dx SE.

Kommandon på menyn View (Visa)
Application Log (Applikationslogg) – visar en programanvändningslogg från installation till dagens
datum.

Run Reports (Körningsrapporter) – visar en lista med körningsrapporter.

Start Wizard (Startguide) – visar Start Wizard (Startguiden) i huvudrutan.

Run Setup (Körningsinställning) – visar fönstret Run Setup (Körningsinställning) i huvudrutan.

Instrument Summary (Instrumentsammanfattning) – visar fönstret Instrument Summary
(Instrumentsammanfattning) i huvudrutan.

Detected Instruments (Hittade instrument) – växlar mellan att visa och att inte visa anslutna instrument i
den vänstra rutan. Som standard visar programmet anslutna instrument i den vänstra rutan.

Toolbar (Verktygsrad) – växlar mellan att visa och att inte visa verktygsraden högst upp på skärmen.
Som standard visar programmet verktygsraden.

Status Bar (Statusfält) – växlar mellan att visa och att inte visa statusfältet längst ned på skärmen. Som
standard visar programmet statusfältet.

Show (Visa) – öppnar en dialogruta från vilken du kan göra följande:

n Visa eller blockera statusloggen.

n Öppna och visa CFX Maestro Dx SE-datamappen.

n Öppna och visa användarens datamapp.
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n Öppna och visa LIMS-filmappen.

n Öppna och visa PrimePCR-mappen.

n Visa körningshistoriken.

n Visa egenskaperna för alla anslutna instrument.

Kommandon på menyn User (Användare)
Select User (Välj användare) – öppnar inloggningsskärmen där du kan välja en användare i listrutan
User Name (Användarnamn) och logga in i programmet.

Change Password (Ändra lösenord) – öppnar dialogrutan Change Password (Ändra lösenord) där
användare kan ändra sitt lösenord för .

Obs! Det här alternativet är inaktiverat för CFX Maestro Dx SE. Användare måste ändra sitt
Windows-lösenord för att kunna ändra sitt CFX Maestro Dx SE-lösenord.

User Preferences (Användarinställningar) – öppnar dialogrutan User Preferences
(Användarinställningar) där användare kan ändra standardinställningarna för

n sändning och mottagande av e-postaviseringar vid avslutad körning

n lagring av datafiler

n generering av protokoll med Protocol Editor (Protokollredigerare) eller Protocol AutoWriter
(Protokollförslag)

n generering av plattor

n dataanalys

n genuttrycksanalys

n fastställande av datakvalitet

n export av CFX-instrumentdata.

User Administration (Användarhantering) – öppnar dialogrutan (Användarhantering) där
administratörer kan skapa användare, modifiera rollbehörigheter och tilldela roller till användare.

Bio-Rad Service Login (Bio-Rad-serviceinloggning) – endast Bio-Rad teknisk servicepersonal. Välj inte
det här kommandot.

Kommandon på menyn Run (Körning)
User-defined Run (Användardefinierad körning) – öppnar fönstret Run Setup (Körningsinställning) där
du kan konfigurera användardefinierade protokoll och plattor och sedan köra ett PCR-experiment på
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valda instrument.

PrimePCR Run (PrimePCR-körning) – öppnar fliken Start Run (Starta körning) i fönstret Run Setup
(Körningsinställning), och PrimePCR-standardprotokollet och plattlayouten som blir inläst beror på vilket
instrument som väljs.

End-Point Only Run (Körning endast med slutpunkt) – öppnar fliken Start Run (Starta körning) i fönstret
Run Setup (Körningsinställning), och standardslutpunktsprotokollet och plattlayouten som blir inläst beror
på vilket instrument som väljs.

Qualification Run (Körning med kvalificering) – öppnar fliken Start Run (Starta körning) i fönstret Run
Setup (Körningsinställning), med Bio-Rad-standardprotokollet för kvalificering och plattlayouten läses in
för det valda instrumentet.

Kommandon på menyn Tools (Verktyg)
Master Mix Calculator (Master Mix-kalkylator) – öppnar mastermixkalkylatorn där du kan skapa en
reaktionsblandning och skriva ut beräkningarna.

Protocol AutoWriter (Protokollförslag) – öppnar dialogrutan Protocol AutoWriter (Protokollförslag) där
du enkelt kan skapa ett nytt protokoll.

Ta Calculator (Ta-kalkylator) – öppnar Ta-kalkylatorn där du enkelt kan beräkna
hybridiseringstemperaturen för primrar.

Dye Calibration Wizard (Fluoroforkalibrering) – öppnar guiden Dye Calibration (Fluoroforkalibrering) där
du kan kalibrera ett instrument för en ny fluorofor.

Reinstall Instrument Drivers (Ominstallera instrumentdrivrutiner) – ominstallerar drivrutinerna som styr
kommunikation med Bio-Rads realtids-PCR-system.

Zip Data and Log Files (Zip-data och loggfiler) – öppnar en dialogruta där du kan välja filer som ska
komprimeras och sparas i en zip-fil för lagring eller för att skickas med e-post.

Batch Analysis (Batch-analys) – öppnar dialogrutan Batch Analysis (Batch-analys) där du kan ställa in
parametrar för analys av fler än en datafil åt gången.

Options (Alternativ) – öppnar en dialogruta där du kan göra följande:

n Konfigurera inställningarna för din e-postserver.

n Konfigurera exportinställningar för LIMS, Seegene och andra datafiler.

Tips: Du kan också välja alternativet att automatiskt starta Seegene Viewer vid export om
du väljer att exportera dina data i Seegene-format.

n Ändra språket som användargränssnittet visar (engelska, kinesiska, ryska)

Viktigt! Du måste starta om CFX Maestro Dx SE för att visa det valda språket.
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Viktigt! Ditt operativsystems språk måste motsvara det språk du vill visa i CFX Maestro Dx
SE-gränssnittet.

Kommandon på menyn Help (Hjälp)
Tips: Hjälpmenyn är tillgänglig i menyraden i alla CFX Maestro Dx SE-fönster.

Contents (Innehåll) – visar fliken Contents (Innehåll) i hjälpsystemet i CFX Maestro Dx SE.

Index – visar fliken Index i hjälpsystemet i CFX Maestro Dx SE.

Search (Sök) – visar fliken Search (Innehåll) i hjälpsystemet i CFX Maestro Dx SE.

Open User Guide (Öppna användarhandbok) – öppnar en PDF av den här guiden.

Additional Documentation (Ytterligare dokumentation) – ger åtkomst till bruksanvisningen för CFX
Opus Dx realtids-PCR-system.

Release Notes (Versionsinformation) – öppnar dokumentet Release Notes (Versionsinformation) för den
installerade version av CFX Maestro Dx SE.

Video Resources (Videoresurser) – öppnar en webbplats med Bio-Rads videoresurser, t.ex.
instruktionsvideor.

qPCR Applications and Technologies Web Site (Webbplats för qPCR-användning och teknik) –
öppnar Bio-Rads webbplats qPCR Applications & Technologies, där du kan få mer information om
realtids-PCR (qPCR).

PCR Reagents Web Site (Webbplats för PCR-reagenser) – öppnar Bio-Rads webbplats för PCR och
qPCR -reagenser, där du kan beställa PCR-reagenser, supermixer, färger och kit.

PCR Plastic Consumables Web Site (Webbplats för PCR-förbrukningsartiklar av plast) – öppnar Bio-
Rads webbplats för PCR-plast- och förbrukningsartiklar, där du kan beställa PCR-plattor,
plattförseglingar, rör och lock, och andra tillbehör av plast.

Software Web Site (Webbplats för program) – öppnar Bio-Rads webbplats för PCR-analysprogram, där
du kan beställa uppdaterade versioner av Bio-Rads CFX Maestro Dx SE.

About (Om) – visar CFX Maestro Dx SE copyright- och versionsinformation.

Kommandon i verktygsraden

– öppnar Utforskaren i Windows där du kan navigera till och öppna en datafil eller en genstudiefil.

– öppnar Master Mix Calculator (Master Mix-kalkylator).
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– öppnar fönstret Run Setup (Körningsinställning).

– öppnar fönstret Run Setup (Körningsinställning), och PrimePCR-standardprotokollet och
plattlayouten som blir inläst beror på vilket instrument som väljs.

– öppnar startguiden.
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Startup Wizard (Startguide)
När CFX Maestro Dx SE startar visas arbetsytan Startup Wizard (Startguide). Från Startup Wizard
(Startguide) kan du göra följande:

n Välja ett instrument från de hittade instrumenten och konfigurera en användardefinierad körning eller
en PrimePCR-körning.

n Öppna och upprepa en körning.

n Öppna en datafil för att analysera resultat från en enskild körning eller en genstudiefil för resultat från
flera genuttryckskörningar.

Dessa moment förklaras utförligt i kapitlen nedan.

Statusfält
På den vänstra sidan av statusfältet längst ned i huvudfönstret i programmet visas aktuell status för de
hittade instrumenten. På den högra sidan av statusfältet visas namnet på aktuell användare samt datum
och tid.
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Rutan Detected Instruments (Hittade instrument)
I rutan Detected Instruments (Hittade instrument) visas alla instrument som är anslutna till CFX Maestro Dx SE-
datorn. Som standard visas varje instrument som en ikon med serienumret som namn.

Från den här rutan kan du göra följande:

n Visa det valda instrumentets egenskaper och kalibrerade fluoroforer.

För information om instrumentegenskaper, se Visa egenskaper för ett instrument på sidan 72.

n Visa ett anslutet instruments status.

n Öppna det valda instrumentets motoriserade lock.

n Stänga det valda instrumentets motoriserade lock.

n Se statusen för alla anslutna instrument.

Så här visar du ett anslutet instruments status

u I rutan Detected Instruments (Hittade instrument) väljer du målinstrumentet och gör något av
följande:

n Klicka på View Status (Visa status) i avsnittet Selected Instrument (Valt instrument).

n Högerklicka och välj View Status (Visa status) på menyn som öppnas.

Dialogrutan Run Details (Körningsdetaljer) visas med fliken Run Status (Körningsstatus). Det valda
instrumentets status visas under körningsstatusrutan, till exempel:

Så här öppnar och stänger du locket på ett instrument

u I rutan Detected Instruments (Hittade instrument) väljer du målinstrumentet och gör något av
följande:
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n Klicka på Open Lid (Öppna lock) eller Close Lid (Stäng lock) i avsnittet Selected Instrument (Valt
instrument).

n Högerklicka och välj lämplig åtgärd på menyn som öppnas.

n Öppna dialogrutan Run Details (Körningsdetaljer), välj fliken Run Status (Körningsstatus) och
klicka på Open Lid (Öppna lock) eller Close Lid (Stäng lock).

Så här visar du statusen för alla hittade instrument

u Gör något av följande:

n I avsnittet All Instruments (Alla instrument) i rutan Detected Instruments (Hittade instrument)
klickar du på View Summary (Visa sammanfattning).

n På menyraden väljer du View > Instrument Summary (Visa > Instrumentsammanfattning).

Dialogrutan Instrument Summary (Instrumentsammanfattning) öppnas.

Tips: Om systemet endast hittar ett instrument visas inte avsnittet All Instruments (Alla
instrument) i rutan Detected Instruments (Hittade instrument). Du visar
instrumentsammanfattningen för ett enstaka instrument genom att välja View > Instrument
Summary (Visa > Instrumentsammanfattning).
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Reglage i verktygsraden Instrument Summary (Instrumentsammanfattning)

I Tabell 5 listas reglagen och funktionerna i verktygsraden Instrument Summary
(Instrumentsammanfattning).

Knapp Knappnamn Funktion

Create a new Run (Skapa
en ny körning)

Skapar en körning på valt block genom att
öppna fönstret Run Setup
(Körningsinställning).

Stop (Stoppa) Stoppar den aktuella körningen på valda
block.

Pause (Pausa) Pausar den aktuella körningen på valda
block.

Resume (Återuppta) Återupptar körningen på valda block.

Flash Block Indicator
(Blockets indikatorlampa)

Gör att indikatorlampan på locket till valda
block börjar blinka.

Open Lid (Öppna lock) Öppnar det valda blockets motoriserade
lock.

Close Lid (Stäng lock) Stänger det valda blockets motoriserade
lock.

Hide Selected Blocks (Dölj
valda block)

Döljer de valda blocken i listan Instrument
Summary (Instrumentsammanfattning)

Show All Blocks (Visa alla
block)

Visar de valda blocken i listan Instrument
Summary (Instrumentsammanfattning)

Show (Visa) Välj vilka block som ska visas i listan. Välj
ett av alternativen för att visa alla
detekterade block, alla inaktiva block, alla
block som körs med den aktuella
användaren eller alla block som körs.

Tabell 5. Reglage i verktygsraden Instrument Summary (Instrumentsammanfattning)
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Visa egenskaper för ett instrument
I rutan Detected Instruments (Hittade instrument) kan du visa information om ett valt instrument, inklusive
dess egenskaper, status för låsskruven (endast CFX Connect- och CFX Touch-instrumenten) och en lista
med kalibrerade färger (fluoroforer).

Så här visar du instrumentegenskaper

u I rutan Detected Instruments (Hittade instrument) högerklickar du på målinstrumentet och väljer
Properties (Egenskaper) på menyn som visas.

Fliken Properties (Egenskaper)

Fliken Properties (Egenskaper) visar teknisk information om det valda instrumentet, inklusive modell,
komponenternas serienummer och versioner av fast programvara. Instrumentets standardnamn (dess
serienummer) visas på flera platser, inklusive rutan Detected Instruments (Hittade instrument) och i
rubrikfältet för dialogrutan Instrument Properties (Instrumentegenskaper). Du kan ändra namn på ett
instrument så att det blir enklare att identifiera.

Obs! Du kan inte ändra namnet på CFX Opus-instrumentet med CFX Maestro.

Fliken Calibrated Dyes (Kalibrerade fluoroforer)

Fliken Calibrated Dyes (Kalibrerade fluoroforer) visar kalibrerade fluoroforer och plattor för det valda
instrumentet.

För att se detaljerad information om en kalibrering klickar du på motsvarande Info-knapp i kolumnen
Detail (Information).
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Innan du börjar
Det här avsnittet förklarar uppgifter som du kan behöva utföra innan du använder CFX Maestro Dx SE.
Detta omfattar att

n skapa en reaktionsmasterblandning

n kalibrera nya färger.

Skapa en reaktionsmasterblandning
Med CFX Maestro Dx SEs Master Mix Calculator (Master Mix-kalkylator) kan du enkelt beräkna den
nödvändiga volymen av varje komponent i huvudblandningen. Du kan skriva ut tabellen för
masterblandningsberäkningar på standardskrivaren och spara beräkningarna för varje mål för senare
användning.

Så här skapar du en reaktionsmasterblandning i Master Mix Calculator (Master Mix-
kalkylator)

1. Gör något av följande för att öppna Master Mix Calculator (Master Mix-kalkylator):

n Välj Tools > Master Mix Calculator (Verktyg > Master Mix-kalkylator).

n Klicka på Master Mix Calculator (Master Mix-kalkylator) i verktygsraden.

Master Mix Calculator (Master Mix-kalkylator) öppnas.
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2. Välj en detektionsmetod i avsnittet Reaction (Reaktion):

n SYBR®Green/EvaGreen®

n Probes (Prober)

3. Klicka på Create New (Skapa ny) i avsnittet Target (Mål) för att välja ett nytt mål. Ett nytt målnamn
visas i mållistrutan.

4. (Valfritt:) Så här ändrar du standardmålnamnet:

a. Markera målets namn i mållistrutan.

b. Skriv in ett nytt målnamn i rutan Target (Mål).

c. Tryck på Retur-tangenten.

5. Justera start- och slutkoncentrationerna för de framåtriktade och bakåtriktade primrarna samt
eventuella prober.
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6. I avsnittet Master Mix Setup (Huvudblandningsinställning) justerar du värdena för

n Number of reactions (Antal reaktioner) som ska köras

n Reaction volume (Reaktionsvolym) per brunn

n Template volume (Mallvolym) per brunn

n Supermix concentration (Supermix-koncentration) per brunn

n Excess reaction volume (Reaktionsvolymsöverskott) per brunn

7. (Valfritt:) Utför stegen 2–6 för så många mål som behövs.

8. I avsnittet Choose Target to Calculate (Välj mål som ska kalibreras) väljer du målet som ska
kalibreras.

Tips: Du kan beräkna ett eller flera eller alla mål samtidigt.

De beräknade volymerna av komponenterna som krävs för varje valt mål visas i tabellen för
masterblandning.

9. Klicka på Set as Default (Ställ in som standard) för att ställa in de inmatade kvantiteterna i avsnitten
Target (Mål) och Master Mix Setup (Masterblandningsinställning) som nya standardvärden.

10. Klicka på OK för att spara innehållet i dialogrutan Master Mix Calculator (Master Mix-kalkylator).

Så här skriver du ut tabellen för masterblandningsberäkningar

u Du skriver ut en tabell för masterblandningsberäkningar genom att klicka på Print (Skriv ut).

Tabellen med beräkningar skrivs ut på standardskrivaren.

Så här sparar du tabellen för masterblandningsberäkningar som en PDF-fil

u Ändra standardskrivaren till en PDF-drivrutin och klicka på Print (Skriv ut) i Master Mix Calculator
(Master Mix-kalkylator).

Så här tar du bort mål

u Välj målet i mållistrutan och klicka på Remove (Ta bort).

Viktigt! När du tar bort ett mål från mållistan tas det även bort från
masterblandningsberäkningar som det används i. Var försiktig när du tar bort ett mål.

Kalibrera nya färger
CFX Opus 96 Dx- och CFX Opus Deepwell Dx-systemen är fabrikskalibrerade för vanliga fluoroforer i
plattor med vita brunnar och klara brunnar. CFX Opus 384 Dx-systemen är fabrikskalibrerade för vanliga
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fluoroforer i plattor med endast vita brunnar. I Tabell 6 listas fluoroforerna och kanalen för vilka varje
instrument kalibreras.

Obs! CFX Opus 96 Dx-, CFX Opus 384 Dx- och CFX Opus Deepwell Dx- systemen inkluderar också
en kanal dedikerad till FRET-kemi. Den här kanalen kräver inte kalibrering för specifika färgämnen.

Viktigt! Om du utför en användardefinierad kalibrering av en fluorofor som fabrikskalibrerats
använder instrumentet den användardefinierade kalibreringen i stället för fabrikskalibreringen.

Fluoroforer Kanal Excitation, nm Detektion, nm Instrument

FAM, SYBR®
Green I

1 450–490 515–530 CFX Opus 96
Dx-, CFX Opus
384 Dx- och CFX
Opus Deepwell
Dx-system

VIC, HEX, CAL
Fluor Gold 540, Cal
Fluor Orange 560

2 515–535 560–580 CFX Opus 96
Dx-, CFX Opus
384 Dx- och CFX
Opus Deepwell
Dx-system

ROX, Texas Red,
CAL Fluor Red 610,
TEX 615

3 560–590 610–650 CFX Opus 96
Dx-, CFX Opus
384 Dx- och CFX
Opus Deepwell
Dx-system

CY5, Quasar 670 4 620–650 675–690 CFX Opus 96
Dx-, CFX Opus
384 Dx- och CFX
Opus Deepwell
Dx-system

Quasar 705, Cy5.5 5 672–684 705–730 Endast CFX
Opus 96 Dx

FRET Chemistry (ej fabrikskalibrerad)

Tabell 6. Fabrikskalibrerade fluoroforer, kanaler och instrument
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Fluoroforer Kanal Excitation, nm Detektion, nm Instrument

Icke
fabrikskalibrerad
färg

FRET 450–490 560–580 CFX Opus 96
Dx-, CFX Opus
384 Dx- och CFX
Opus Deepwell
Dx-system

Så här kalibrerar du nya fluoroforer för CFX-system

1. Välj målinstrumentet i rutan Detected Instruments (Hittade instrument) i hemfönstret.

2. Välj Tools > Calibration Wizard (Verktyg > Kalibreringsguide) för att öppna guiden Dye Calibration
(Fluoroforkalibrering).

Fluoroforer som redan har kalibrerats för målinstrumentet visas i tabellen Calibrated Fluorophores
(Kalibrerade fluoroforer).

3. Välj fluoroforen som ska kalibreras i listrutan i avsnittet Calibrate New or Existing Fluorophores
(Kalibrera nya eller befintliga fluoroforer).

Om inte fluoroforen finns i listan skriver du in dess namn i textrutan för att lägga till det i listan.
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Viktigt! Var försiktig när du namnger anpassade kalibrerade fluoroforer. Om du skapar en
anpassad färgkalibrering för en fluorofor med samma namn som en fabrikskalibrerad fluorofor,
är det den anpassade fluoroforen (inte den fabrikskalibrerade fluoroforen) som används av
instrumentet under körningarna.

4. Välj plattyp för fluoroforen.

Om inte plattypen finns i listan skriver du in dess namn i textrutan för att lägga till det i listan.

5. Välj en kanal för fluoroforen.

6. Välj en plattkolumn för fluoroforen.

7. (Valfritt:) Ange en färg som ska associeras med fluoroforen.

8. Klicka på Add to Plate (Lägg till i platta) för att lägga till fluoroforen.

9. (Valfritt:) Upprepa stegen 3–8 och lägg till alla fluoroforer som du planerar att kalibrera för plattan.

10. När du har lagt till alla fluoroforer klickar du på View Plate (Visa platta) för att öppna fönstret Pure Dye
Plate Display (Visning av rena plattfluoroforer).

Använd det här fönstret som vägledning för att ladda fluoroforer i plattan.

11. Bered en 96-, 384- eller djupbrunnsplatta för fluoroforkalibreringen:

a. Pipettera fluoroforlösning i varje brunn enligt mönstret som visas i Pure Dye Plate Display
(Visning av rena plattfluoroforer).

b. För varje fluorofor fyller du fyra brunnar med 50 µl (96-brunns- eller djupbrunnsplatta) eller 30 µl
(384-brunnsplatta) av 300 nM färgämneslösning. Observera att minst hälften av plattan
innehåller tomma brunnar.

c. Försegla plattan med förseglingsmetoden som ska användas i experimentet.

12. Placera kalibreringsplattan i blocket och stäng locket.

13. I guiden Dye Calibration (Fluoroforkalibrering) klickar du på Calibrate (Kalibrera) följt av OK för att
bekräfta att plattan är i blocket.

14. När CFX Maestro Dx programvara, Security Edition slutför kalibreringskörningen öppnas en
dialogruta. Klicka på Yes (Ja) för att slutföra kalibreringen och öppna Dye Calibration Viewer
(Visningsprogram för fluoroforkalibrering).

15. Klicka på OK för att stänga fönstret.

Ställa in User Preferences (Användarinställningar)
Tips: Det är inte nödvändigt att utföra dessa åtgärder för att kunna använda CFX Maestro Dx SE. Du
kan utan risk hoppa över detta avsnitt eller utföra dessa åtgärder när som helst.
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I CFX Maestro Dx SE kan varje användare anpassa sin arbetsmiljö. På menyn Users > User Preferences
(Användare > Användarinställningar) kan du till exempel göra följande:

n Ställa in e-postavisering om avslutad körning.

Obs! Den här funktionen är endast tillgänglig för användare vars roll har tilldelats denna
behörighet. Se Hantera användarroller i CFX Maestro Dx programvara, Security Edition på
sidan 43 för mer information.

n Ändra standardinställningarna för

o platsen för att spara filer

o filerna för körningsinställning

o filnamnsprefix.

n Ställa in standardparametrar som ska användas vid skapandet av ett nytt protokoll och en ny platta.

n Ställa in standardparametrar för dataanalys och genuttryck.

n Anpassa standardparametrarna för kvalitetskontroll.

n Anpassa dataexportparametrar.

På menyn Tools (Verktyg) kan du göra följande:

n Skapa en masterblandning.

n Kalibrera färger för ett specifikt instrument.

Obs! Masterblandningen och färgkalibreringen är tillgängliga för alla som loggar in i programvaran.

I det här avsnittet förklaras hur dessa åtgärder utförs.

Ställa in e-postaviseringar

Du kan ansluta CFX Maestro Dx SE till den utgående e-postservern och skicka e-postaviseringar om
slutförda körningar till en lista av användare. Du kan också välja att bifoga en datafil och en analysrapport
till användarlistan. Information om hur du konfigurerar anslutningen mellan CFX Maestro Dx SE och
SMTP-servern finns i Ansluta Security Edition till en SMTP-server på sidan 81.

Obs! En användares möjlighet att få tillgång till konfigurationsfunktioner för e-post beror på
användarens roll och behörigheter som tilldelats av administratören. Mer information om hur du
hanterar användare och deras roller finns i Hantera användarroller i CFX Maestro Dx programvara,
Security Edition på sidan 43.
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Så här ställer du in e-postaviseringar

1. Välj User > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan User
Preferences (Användarinställningar).

Dialogrutan User Preferences (Användarinställningar) öppnas med fliken Email (E-post).

Obs! Du meddelas ifall systemet detekterar att du inte ställt in en giltig SMTP-server för
CFX Maestro Dx SE. Klicka på Configure Outgoing Email (Konfigurera utgående e-post) för att
öppna dialogrutan Options (Alternativ) och konfigurera e-postens SMTP-server. Mer information
finns i Ansluta Security Edition till en SMTP-server på sidan 81.

2. Skriv in e-postadresserna till alla personer som du planerar att informera om slutförda körningar i
rutan To (Till). Alla mottagare får ett e-postmeddelande när körningen har slutförts.

Obs! Du måste ange varje e-postadress på en separat rad. Tryck på Enter eller Retur efter varje
adress.

3. (Valfritt:) Ange e-postadressen till mottagare som du planerar att skicka en kopia av varje e-
postavisering till i cc-textrutan.

4. (Valfritt:) Som standard får alla mottagare en kopia av datafilen som bilaga. Avmarkera den här
kryssrutan om du inte vill bifoga en kopia av datafilen.

5. (Valfritt:) Välj Attach Analysis Report (Bifoga analysrapport) för att bifoga en PDF-fil med
analysrapporten i e-postmeddelandet.

6. Klicka på OK för att spara ändringarna och stänga dialogrutan User Preferences
(Användarinställningar).

Obs! Du kanske kan konfigurera systemet för att skicka ett e-postmeddelande till din mobiltelefon,
beroende på din tjänsteleverantör. Kontakta din mobiltelefonleverantör för specifik information om e-
postadressen till din mobiltelefon. Ange telefonens e-postadress (till exempel 5552221234@din_
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tjänsteleverantör_EmailDomain.net) i textrutan To (Till) på skärmen User Preferences
(Användarinställningar).

Så här redigerar du en mottagares e-postadress

u Ändra e-postadressen efter behov och klicka på OK.

Så här tar du bort en e-postmottagare

1. Välj e-postmottagaren och tryck på Delete-tangenten.

2. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.

Ansluta Security Edition till en SMTP-server

Viktigt! Vissa kommersiella leverantörer av webbmejlstjänster har höjt e-postsäkerheten. Om du
använder dessa konton måste du aktivera inställningen Tillåt mindre säkra appar i deras
kontoinställningar för att CFX Maestro Dx SE ska kunna skicka e-post. Se säkerhetsinformationen för
din leverantör av webbmejlstjänster för mer information.

Om du använder Google Gmail eller Microsoft Office 365 SMTP-server för att skicka e-post måste du
aktivera tvåfaktorsautentisering och skapa ett applösenord i dina Gmail- eller Office 365-
kontoinställningar. För autentisering i Maestro-dialogrutan Email Setup (E-postkonfiguration) kopierar du
och klistrar in applösenordet i fältet Password (Lösenord) istället för ett vanligt e-postlösenord.

Du måste etablera en anslutning från CFX Maestro Dx SE till din e-post innan programmet kan skicka e-
postmeddelanden.

Så här ansluter du CFX Maestro Dx SE till en e-postserver

1. Gör något av följande:

n Välj User > User Preferences (Användare > Användarinställningar) och klicka på Configure
Outgoing Email (Konfigurera utgående e-post) på fliken Email (E-post).

n Välj Tools > Options (Verktyg > Alternativ).

Dialogrutan Options (Alternativ) visas med fliken Email (E-post).
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2. Ange följande information för ditt företag:

n SMTP Server Name (Namn på SMPT-server) – namnet på den utgående e-postservern för ditt
företag.

n Port – portnumret för SMTP-servern. Detta är vanligtvis 25.

n Use SSL (Använd SSL) – alternativet Secure Sockets Layer (SSL). Vissa SMTP-servrar kräver
denna inställning. Om det inte krävs på ditt företag kan du avmarkera den här kryssrutan.

n Use Default “From” Address (Använd standardadress för avsändare) – namnet på e-
postservern på ditt företag. Vissa SMTP-servrar kräver att all skickad e-post ska ha en
avsändaradress som kommer från en viss domän, t.ex. namn@DittFöretag.com. Om så är fallet
avmarkerar du denna kryssruta och anger en giltig e-postadress.

n Authentication Required (Autentisering krävs) – om din plats kräver kontoautentisering ska du
verifiera att denna kryssruta är ifylld.

n User Name (Användarnamn) – namnet på det autentiserade kontot. Detta krävs endast om
Authentication Required (Autentisering krävs) har valts.
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n Password (Lösenord) – lösenordet för det autentiserade kontot. Detta krävs endast om
Authentication Required (Autentisering krävs) har valts.

Viktigt! Om du använder Google Gmail eller Microsoft Office 365 SMTP-server för att skicka e-
post måste du aktivera tvåfaktorsautentisering och sedan skapa ett applösenord i dina Gmail-
eller Office 365-kontoinställningar. För autentisering i Maestro-dialogrutan Email Setup
(E-postkonfiguration) kopierar du och klistrar in applösenordet i fältet Password (Lösenord) i
CFX Maestro Dx SE istället för ett vanligt e-postlösenord.

För att verifiera att SMTP-serverinställningarna är korrekta anger du en giltig e-postadress i textrutan
Test Email Address (Testa e-postadress) och klickar på Test Email (Testa e-post).

Obs! Vissa SMTP-servrar tillåter inte bilagor och andra tillåter bilagor endast upp till en viss
storlek. Om du planerar att skicka datafiler och/eller rapporter via e-post med CFX Maestro Dx
SE, välj Test Attachment (Testa bilaga) och ställ in Attachment Size in MB (Bilagans storlek i
MB) på 5 megabyte (MB) eller mer.

3. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Ändra standardfilinställningarna

På fliken Files (Filer) i dialogrutan User Preference (Användarpreferens) kan du ändra följande:

n standardplatsen för att spara CFX Maestro Dx SE-filer

n standardfilerna för körningsinställning

n standardparametrar för filnamn.

Så här ändrar du standardfilinställningarna

1. Välj User > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan User
Preferences (Användarinställningar).

2. I dialogrutan User Preferences (Användarinställningar) väljer du fliken Files (Filer).
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3. I sektionen Default Folder for File Creation (Standardmapp för nya filer) går du till och väljer en
standardmapp där du vill spara nya filer. Du kan välja olika platser för varje filtyp:

n Protocol (Protokoll)

n Plate (Platta)

n Data File (Datafil)

n Gene Study (Genstudie)

4. I sektionen File Selection for Run Setup (Filval för körningsinställning) går du till och väljer
målprotokollet och plattfilerna som ska visas när du öppnar fönstret Experiment Setup
(Experimentinställning).

5. I sektionen Data File (Datafil) definierar du prefix och/eller suffix för datafiler. För varje del väljer du ett
nytt värde från motsvarande listruta. Du kan även ange anpassade prefix- och suffixvärden i
textrutorna Prefix och Suffix.

CFX Maestro Dx SE förhandsvisar filnamnet nedanför valrutorna.

6. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.
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Ställa in standardprotokollparametrar

Så här ställer du in standardprotokollparametrar för Protocol Editor (Protokollredigerare)
och Protocol AutoWriter (Automatisk protokollskrivare)

1. Välj User > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan User
Preferences (Användarinställningar).

2. Välj fliken Protocol (Protokoll) i dialogrutan User Preferences (Användarinställningar).

3. I avsnittet Protocol Editor (Protokollredigerare) anger du värden för följande inställningar som visas i
Protocol Editor (Protokollredigerare):

n Sample volume (Provvolym) – volymen av varje prov i brunnarna (i µl).

n Lid Shutoff temperature (Lockavstängningstemperatur) – den temperatur i ºC vid vilken
lockvärmaren stängs av under en körning.

4. I avsnittet Protocol AutoWriter (Automatisk protokollskrivare) anger du värdena för följande
inställningar som visas i Protocol AutoWriter (Automatisk protokollskrivare):

n Annealing temperature (Hybridiseringstemperatur) – temperatur i ºC för experiment som
använder iProof DNA-polymeras, iTaq DNA-polymeras eller andra polymeraser.

n Amplicon length (Amplikonlängd) – längden på amplikonen i bp.

5. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.
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Ställa in standardplattparametrar

Ändringar som görs på fliken Plate (Platta) är tillgängliga för alla användare av programvaran. Ändringar
som görs under plattinställningen är tillgängliga för användare när du har sparat och stängt plattfilen.

I dialogrutan User Preferences (Användarinställningar) kan du göra följande:

n Ställa in standardplattparametrarna.

n Lägga till nya namn på mål, prover och biologiska grupper i respektive bibliotek.

n Ta bort namn på mål, prover och biologiska grupper i respektive bibliotek.

Så här ställer du in standardplattparametrar

1. Välj User > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan User
Preferences (Användarinställningar).

2. Välj fliken Plate (Platta) i dialogrutan User Preferences (Användarinställningar).
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3. Ange värdena för följande inställningar för en ny plattfil. Följande värden visas i fönstret Plate Editor
(Plattredigerare):

n Plate type (Plattyp)

n Plate Size (Plattstorlek)

n Units (Enheter) – koncentrationen av startmallen för brunnar som innehåller standarder.

CFX Maestro Dx SE använder dessa enheter för att skapa en standardkurva på fliken Data
Analysis Quantification (Dataanalyskvantifiering).

n Scientific notation (Grundpotensform) – när detta väljs visar CFX Maestro Dx SE
koncentrationsenheterna i grundpotensform.

n Scan mode (Skanningsläge) – antalet eller typen av kanaler som ska skannas under en
körning.

n Fluorophores (Fluoroforer) – standardfluoroforerna som visas i reglagen för brunnsladdning i
Plate Editor (Plattredigerare).

n Libraries (Bibliotek) – namn på mål, prover och biologiska grupper som du normalt använder i
experiment:

o Target names (Målnamn) – namnen på målgener och -sekvenser.

o Sample names (Provnamn) – namnen på experimentprover eller en identifierande
egenskap för proverna (t.ex. Mouse1, Mouse2, Mouse3 (Mus 1, 2, 3)).

o Biological group names (Namn på biologiska grupper) – namnen på grupper av liknande
prover som har samma behandlingsstatus eller villkor (t.ex. 0Hr, 1Hr, 2Hr (0, 1, 2 timmar)).

4. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Så här lägger du till ett nytt namn på mål, prov eller biologisk grupp

u I tillämplig biblioteksruta anger du namnet på målet, provet eller den biologiska gruppen och klickar
på OK.

Så här raderar du ett namn på mål, prov eller biologisk grupp

u Välj namnet i tillämplig biblioteksruta, tryck på Delete-tangenten och klicka på OK.

Viktigt! Namn som du tar bort från biblioteket tas bort från programvaran och är inte längre
tillgängliga för användare. Klicka på Restore Defaults (Återställ standardinställningar) för att
återställa CFX Maestro Dx SE-standardnamnen. Om du klickar på Restore Defaults (Återställ
standardinställningar) i dialogrutan User Preferences (Användarinställningar) återställs alla
inställningar på alla flikar till de ursprungliga fabriksinställningarna. Var försiktig när du tar bort
CFX Maestro Dx SE-standardnamn och klickar på den här knappen.
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Ställa in standardparametrar för dataanalys

Så här ställer du in standardparametrar för dataanalys

1. Välj User > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan User
Preferences (Användarinställningar).

2. I dialogrutan User Preferences (Användarinställningar) väljer du fliken Data Analysis (Dataanalys).

3. I avsnittet Analysis Mode (Analysläge) väljer du läget som data ska analyseras i (Fluorophore
(Fluorofor) eller Target (Mål)).

4. I avsnittet PCR Quantitation (PCR-kvantifiering) ställer du in standardparametrarna för följande
alternativ:

n Baseline Setting (Baslinjeinställning) – baslinjemetoden för analysläget.

n Cq Determination Mode (Cq-bestämningsläge) – läget i vilket Cq-värdena beräknas för varje
fluorescenskurva (antingen regression eller enkelt tröskelvärde).

n Threshold Calc. Mode (Läge för tröskelvärdesberäkning) – slutpunktsmålmängden.

Standard är Auto. Med andra ord beräknar programvaran slutpunktsmålet automatiskt. För att
ställa in ett specifikt tröskelvärde avmarkerar du kryssrutan Auto och anger ett slutpunktsvärde
beräknat i RFU (Relative Fluorescence Units). Det högsta värdet är 65 000,00 RFU. Datafiler för
efterföljande körningar använder denna tröskelvärdesinställning.
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n Baseline Calc. Mode (Läge för baslinjeberäkning) – baslinjevärdet för alla kurvor.

Standard är Auto. Med andra ord beräknar programvaran baslinjen för alla kurvor automatiskt.
Du ställer in ett specifikt baslinjevärde genom att avmarkera kryssrutan Auto och ange minimi-
och maximivärden för cykelintervallet (1 till 9 999). Datafiler för efterföljande körningar använder
detta cykelintervall.

n Log View (Logaritmisk visning) – avgör hur programvaran visar amplifieringsdata:

o On (På) – amplifieringsdata visas i ett semilogaritmiskt diagram.

o Off (Av) – (standard) amplifieringsdata visas i ett linjärt diagram.

5. I avsnittet End Point (Slutpunkt) väljer du antalet slutcykler som ska beräknas medeltalet av när
slutpunktsberäkningar utförs:

n PCR – antalet slutcykler för vilka ska beräknas medeltalet för kvantifieringsdata (standard är 5).

n End Point Only run (Körning av endast slutpunkter) – antalet slutcykler som ska beräknas
medeltalet av för slutpunktsdata (standard är 2).

6. I avsnittet Melt Curve (Smältkurva) väljer du topptypen som ska detekteras (positiv eller negativ).

7. I avsnittet Well Selector (Brunnsväljare) väljer du hur brunnsetiketter ska visas (efter provtyp,
målnamn eller provnamn).

8. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.
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Ställa in standardparametrar för genuttrycksdatafil

Så här ställer du in standardparametrar för en ny genuttrycksdatafil

1. Välj User > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan User
Preferences (Användarinställningar).

2. Välj fliken Gene Expression (Genuttryck) i dialogrutan User Preferences (Användarinställningar).

3. Specificera värdena för följande inställningar:

n Relative to (I relation till) – graf för genuttrycksdata i relation till antingen en kontroll (med början
vid 1) eller till noll:

o Zero (Noll) – programmet ignorerar kontrollen. Detta är standarden när inget kontrollprov är
tilldelat i fönstret Experiment Settings (Experimentinställning).

o Control (Kontroll) – programmet beräknar data i relation till kontrollprovet som är tilldelat i
fönstret Experiment Setup (Experimentinställning).

n X-axis (X-axel) – graf för provet eller målet på x-axeln.

n Y-axis (Y-axel) – graf för linjär, log2 eller log10-skala på y-axeln.

n Scaling (Skalning) – skalningsalternativet för grafen (standardalternativet är utan skalning):

o Highest (Högst) – programmet skalar grafen enligt den högsta datapunkten.

o Lowest (Lägst) – programmet skalar grafen enligt den lägsta datapunkten.

o Unscaled (Utan skalning) – programmet visar data utan skalning i grafen.

n Mode (Läge) – analysläget, antingen relativ kvantitet (∆Cq) eller normaliserat uttryck (∆∆Cq).

n Error Bar (Felstapel) – datavariationen visas som antingen standardavvikelse (Std. Dev.) (SD)
eller medelvärdets standardfel (Std. Error Mean) (SEM).

n Error Bar Multiplier (Felstapelmultiplikator) – standardavvikelsemultiplikator som används för
att rita en graf av felstaplarna (standarden är 1).

Du kan öka multiplikatorn till antingen 2 eller 3.

n Sample Types to Exclude (Provtyper att exkludera) – provtyper som ska exkluderas från
analysen.

Du kan välja ett eller flera prover som ska exkluderas från analysen. För att exkludera alla
provtyper rensar du kryssrutorna för valda provtyper.

4. Klicka på OK för att spara ändringarna och stänga dialogrutan.
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Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.

Anpassa kvalitetskontrollregler

I CFX Maestro Dx SE kan du ange kvalitetskontrollregler som tillämpas på data i fönstret Data Analysis
(Dataanalys). Programvaran validerar data i förhållande till reglerna som du anger.

Obs! Alla kvalitetskontrollregler är aktiverade som standard.

Tips: Du kan enkelt utesluta brunnar som inte klarar en kvalitetskontrollparameter från analys i
kvalitetskontrollmodulen för fönstret Data Analysis (Dataanalys).

Så här anpassar du kvalitetskontrollregler

1. Välj User > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan User
Preferences (Användarinställningar).

2. I dialogrutan User Preferences (Användarinställningar) väljer du fliken QC (Kvalitetskontroll).

Där:

n NTC – ingen templatkontroll
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n NRT – inget omvänt transkriptas

n Efficiency (Effektivitet) – reaktionseffektivitet

n Std Curve R^2 – R-kvadratvärde för standardkurva

n Replicate group Cq Std Dev (Beräkning av standardavvikelse för replikatgrupp) –
standardavvikelse beräknad för varje replikatgrupp

3. Gör något av följande för varje kvalitetskontrollsregel:

n Om du vill använda standardvärdet gör du ingenting.

n För att ändra värdet klickar du på textrutan Value (Värde) och trycker på Retur.

n Avmarkera relevant kryssruta för Use (Använd) för att inaktivera regeln.

4. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.

Anpassa parametrarna för dataexport

Det går att exportera CFX Maestro Dx SE-data i följande format:

n Text (.txt)

n CSV (.csv)

n Excel (.xls, .xlsx)

n XML (.xml)

n HTML (.html)

Viktigt! Din dator måste ha Microsoft Excel installerat för att du ska kunna exportera data till ett
Microsoft Excel-kalkylblad.

Du kan ange typen av data som ska exporteras och anpassa utmatningen av exporterade data.

Så här anpassar du dataexportparametrar

1. Välj User > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan User
Preferences (Användarinställningar).

2. Välj fliken Custom Export (Anpassad export) i dialogrutan User Preferences (Användarinställningar).
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3. I listrutan Export Format (Exportformat) väljer du formatet som data ska exporteras i.

4. I avsnittet Data to Export (Data som ska exporteras) markerar eller avmarkerar du kryssrutorna för
typen av data som ska exporteras. De valda objekten visas i listrutan Exported Columns
(Exporterade kolumner).

Obs! Som standard ingår körningsinformation i rubriken. Avmarkera den här kryssrutan om du
inte vill att körningsinformation ingår.

5. Du kan ändra den utmatade visningsordningen för de valda objekten.

I listrutan Exported Columns (Exporterade kolumner) markerar du objektet och klickar på
pilknapparna till vänster om listan för att flytta det uppåt eller nedåt.

6. Det går att ändra de utmatade kolumnnamnen för de valda objekten:

a. Klicka på Customize Column Names (Anpassa kolumnnamn).

Dialogrutan Column Name Customizer (Anpassare av kolumnnamn) öppnas.

b. För varje standardkolumnnamn som du vill ändra skriver du in det nya namnet i dess fält Custom
Name (Anpassat namn).
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c. Gör något av följande:

n Klicka på OK för att spara ändringarna och återgå till fliken Custom Export (Anpassad
export). Det nya namnet visas i parentes bredvid standardkolumnnamnet i listrutan
Exported Columns (Exporterade kolumner).

n Klicka på Cancel (Avbryt) för att rensa ändringarna och återgå till fliken Custom Export
(Anpassad export).

7. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.
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Ett protokoll är en uppsättning steg som exekveras i en specifik sekvens. I CFX Maestro Dx programvara,
Security Edition är alla steg associerade med alternativ på instrumentet. Till exempel instruerar stegen
instrumentet att styra block- och locktemperaturen, använda en temperaturskillnad i hela blocket, göra en
plattavläsning eller utföra en smältkurvsanalys. Varje alternativ specificeras för olika platt- och
körningstyper.

CFX Maestro Dx SE erbjuder två alternativ för att skapa protokoll: Protocol Editor (Protokollredigerare)
och Protocol AutoWriter (Protokollförslag).

I Protocol Editor (Protokollredigerare) finns följande funktioner:

n standardprotokollsreglage för att snabbt skapa protokoll

n möjlighet att snabbt beräkna en gradient för det valda antalet rader

n möjlighet att snabbt beräkna körtiden för den valda plattypen

n möjlighet att redigera protokollsteg

n möjlighet att spara protokoll för återanvändning

n möjlighet att skriva ut protokollet på en standardskrivare.

Protocol AutoWriter (Protokollförslag) genererar automatiskt ett anpassat PCR-protokoll med stegen ”hot
start”, initial denaturering, hybridisering och extension utifrån dina angivna parametrar. Du kan sedan visa
en grafisk representation av det föreslagna protokollet och redigera, köra eller spara protokollet.
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Parametrar och intervall för protokollsteg
Använd informationen i Tabell 7 för att ändra standardinställningarna för stegen i ditt protokoll.

Temperatursteg

Måltemperaturen är ett värde mellan 4,0 och 100,0 °C, angett i tiondelar av en grad. Systemet går upp till
denna temperatur och håller värdet under en viss tid (hålltiden).

Gradientsteg

Gradientintervallet är skillnaden mellan den lägsta och den högsta temperaturen i ett gradientsteg.
Största tillåtna intervall är 24 °C. Den lägre temperaturen är ett värde mellan 30,0 och 99,0 °C, angett i
tiondelar av en grad. Den högsta övre temperaturen är 100 °C. Instrumentet går upp till den önskade
temperaturgradienten över blocket och håller den temperaturen under en viss hålltid.

Viktigt! Instrumentet beräknar gradientvärdet. När du anger ett värde i gradientkalkylatorns övre och
nedre fält beräknar och tilldelar programvaran automatiskt temperaturerna för de återstående fälten.
När du anger en temperatur i något fält mellan det övre och det nedre fältet beräknar instrumentet
automatiskt de återstående fälten. Du kan inte ange temperaturvärden manuellt i alla fält.

Parameter Intervall Beskrivning

Ramp rate
(Ramphastighet)

n För systemen CFX Opus 96 Dx:
0,1–5 °C per sekund

n För systemen CFX Opus 384
Dx:
0,1–2,5 °C per sekund

n För systemen CFX Opus
Deepwell Dx:
0,1–2,5 °C per sekund

Instruerar instrumentet att rampa till
måltemperaturen vid den angivna
hastigheten i det steget.

Endast tillgängligt för temperatursteg.

Increment
(Temperatursteg)

Ett tal från -10,0 till 10,0 °C per
cykel i tiondels grad

Instruerar instrumentet att ändra
måltemperaturen för ett steg i varje cykel,
där ett positivt tal ökar temperaturen och
ett negativt tal minskar temperaturen.

Endast tillgängligt för temperatursteg.

Tabell 7. Parametrar och intervall för protokollsteg
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Parametrar och intervall för protokollsteg

Parameter Intervall Beskrivning

Extend (Förläng) En tid från -60 till 60 sekunder per
cykel

Instruerar instrumentet att förlänga
hålltiden i varje cykel. Ett positivt tal ökar
hålltiden och ett negativt tal minskar
hålltiden.

Tillgängligt för både temperatur- och
gradientsteg.

Beep (Pip) (Inga parametrar) Instruerar instrumentet att pipa för att
signalera att instrumentet har nått
måltemperaturen för det steget.

Endast tillgängligt för temperatursteg.

Plate read
(Plattläsning)

(Inga parametrar) Instruerar instrumentet att lägga till en
plattläsning i det valda steget.

Tillgängligt för både temperatur- och
gradientsteg.

Tabell 7. Parametrar och intervall för protokollsteg, forts.
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Fönstret Protocol Editor (Protokollredigerare)
Använd Protocol Editor (Protokollredigerare) för att skapa, öppna, granska och redigera ett protokoll. Som
standard öppnas Protocol Editor (Protokollredigerare) och visar ett realtidsprotokoll med två steg för en
platta med 96 brunnar.

1. Menyraden ger snabb åtkomst till kommandon på menyerna File (Arkiv), Settings
(Inställningar) och Tools (Verktyg).

2. Med verktygsraden kan du snabbt spara och skriva ut protokollet, fastställa var ett steg ska
infogas, ange provvolym samt visa beräknad protokollkörningstid.

3. Huvudrutan visar en grafisk representation av protokollet.

4. Den nedre rutan visar protokollskissen.

5. Den vänstra rutan visar protokollkontroller som du kan lägga till för att anpassa protokollet.

FÖRKLARING

Kommandon på menyn File (Arkiv)
Save (Spara) – sparar det aktuella protokollet.
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Save As (Spara som) – sparar det aktuella protokollet med ett nytt namn eller på en ny plats.

File Passwords (Fillösenord) – gör det möjligt för användare att ställa in lösenord för att spara och öppna
filer.

Tips: För mer information, se Lösenordsskydda filer på sidan 50.

Close (Stäng) – stänger Protocol Editor (Protokollredigerare).

Kommando på menyn Settings (Inställningar)
Lid Settings (Lockinställningar) – öppnar dialogrutan Lid Setting (Lockinställning) i vilken du kan ändra
eller ställa in locktemperaturen.

Kommandon på menyn Tools (Verktyg)
Gradient Calculator (Gradientkalkylator) – öppnar en dialogruta där du kan välja blocktyp för ett
gradientsteg. Standard är 96 brunnar.

Run time Calculator (Kalkylator för körningstid) – öppnar en dialogruta där du kan välja plattyp och
skanningsläge för att beräkna uppskattad körningstid i fönstret Run Setup (Körningsinställning). Standard
är 96 brunnar, alla kanaler.

Kommandon i verktygsraden

– sparar den aktuella protokollfilen.

– skriver ut det valda fönstret.

– använd det här kommandot för att välja var steg ska infogas i relation till det
aktuella valda steget.

– använd det här kommandot för att ange en provvolym i µl. Provvolymer skiljer
sig åt beroende på typen av block:

n För ett block med 96 brunnar är intervallet 0–50 µl.

n För ett block med 384 brunnar är intervallet 0–30 µl.

n För ett block med 96 djupa brunnar är intervallet 0–125 µl.
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– visar beräknad körningstid baserat på protokollsteg, stigningshastighet och
den valda typen av block.

– visar hjälpinformation om protokoll.

Protokollredigeringskontroller
Den vänstra rutan i fönstret Protocol Editor (Protokollredigerare) har kontroller med vilka du kan skapa
protokoll.

Varje kontroll består av en uppsättning parametrar som representerar ett steg i protokollet. Du kan ändra
varje parameter och lägga till eller ta bort dem för att anpassa protokollet. Den här sektionen beskriver
alternativen i varje kontroll.

n Insert Step (Infoga steg) – infogar ett steg före eller efter det valda
steget. Du kan redigera temperatur- och hålltidsvärden i protokollets
grafiska visning eller i protokollöversikten.

n Insert Gradient (Infoga gradient) – infogar ett gradientsteg baserat på
typ av brunnsblock som har valts i gradientkalkylatorn. Du kan redigera
gradientintervallet i rutan Gradient som visas när ett gradientsteg
infogas.

n Insert GOTO (Infoga GOTO) – infogar ett cykliskt (loop)steg som
instruerar programvaran att upprepa specifika steg i sekvens för ett visst
antal cykler. Repetitionerna inleds när den första cykeln är avslutad. Du
kan till exempel instruera programvaran att utföra 39 repetitioner av steg

2–4. Efter den slutliga repetitionen kommer programvaran att ha utfört steg 2–4 totalt 40 gånger. Du
kan redigera återgå-till-steget (GOTO) och antalet cykler antingen i den grafiska visningen eller i
protokollöversikten.

n Insert Melt Curve (Infoga smältkurva) – infogar ett avläsningssteg för smältkurvan.

n Insert Plate Read to Step (Infoga plattavläsning i steg) – lägger till ett plattavläsningskommando i
det valda steget. En plattavläsning mäter fluorescensmängden i slutet av en cykel.
Plattavläsningsteget är vanligen det sista steget i en GOTO-loop.

Tips: När du har lagt till ett plattavläsningskommando i ett steg ändras knappen till Remove
Plate Read (Ta bort plattavläsning) när du väljer ett steg.
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n Remove Plate Read (Ta bort plattavläsning) – tar bort ett plattavläsningskommando från det valda
steget.

Tips: När du har tagit bort ett plattavläsningskommando från ett steg ändras knappen till Add
Plate Read to Step (Lägg till plattavläsning till steg) när du väljer steget.

n Step Options (Stegalternativ) – öppnar dialogrutan Step Options (Stegalternativ) och visar
tillgängliga alternativ för det valda steget. Se Step Options (Stegalternativ) på sidan 102 för ingående
information om stegalternativen.

Tips: Du kan också använda Step Options (Stegalternativ) genom att högerklicka på steget i
den grafiska visningen.

n Delete Step (Ta bort steg) – tar bort det valda steget från protokollet.
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Step Options (Stegalternativ)

Öppna dialogrutan Step Options (Stegalternativ) för att visa alternativ som du kan lägga till, ändra eller ta
bort från ett steg.

n Plate Read (Plattläsning) – genom att välja det här alternativet lägger du till en plattläsning i steget.

n Temperature (Temperatur) – anger måltemperaturen för det valda steget.

n Gradient – anger gradientintervallet för steget. Intervallet är 1–24 °C.

Obs! En gradient körs med den lägsta temperaturen framtill i blocket (rad H i den här bilden) och
den högsta temperaturen baktill på blocket (rad A i den här bilden).

n Increment (Temperatursteg) – storleken på ökningen (eller minskningen) av temperaturen för det
valda steget. Det här värdet adderas till måltemperaturen med varje cykel. Området är ± 0,1–10 °C.

Obs! För att minska temperaturen skriver du ett minustecken (–) före det numeriska värdet (till
exempel –5 °C).

n Ramp Rate (Ramphastighet) – ramphastigheten för det valda steget. Intervallet beror på
blockstorleken.

n Time (Tid) – hålltiden för det valda steget.
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n Extend (Förläng) – den tid (i sekunder) med vilken du vill förlänga eller förkorta det valda steget. Det
här alternativet läggs till hålltiden i varje cykel. Intervallet är ±1–60 sekunder.

n Beep (Pip) – när alternativet är valt hörs ett pip under steget.

Tips: När du anger ett nummer utanför alternativintervallet ändrar programvaran numret till det
närmaste värdet inom intervallet.
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Skapa ett protokoll i Protocol Editor (Protokollredigerare)
I Protocol Editor (Protokollredigerare) kan du skapa anpassade protokollfiler. Det går även att redigera
och spara tidigare sparade protokollfiler eller provprotokollfiler som levererats med CFX Maestro Dx SE.

Gör följande för att skapa en ny protokollfil:

n Öppna en protokollfil i Protocol Editor (Protokollredigerare).

Tips: Du kan öppna ett nytt eller befintligt protokoll i Protocol Editor (Protokollredigerare).

n Ställ in det nya protokollet.

n Lägg till protokollsteg i protokollkontrollsrutan.

n Redigera stegens egenskaper.

n Spara protokollet.

Tips: Information om hur du skapar ett nytt protokoll av en tidigare sparad eller provprotokollfil finns i
Öppna ett befintligt protokoll i Protocol Editor (Protokollredigerare) på sidan 105.

Öppna en ny protokollfil i Protocol Editor (Protokollredigerare)
CFX Maestro Dx SE har flera alternativ för att öppna en ny protokollfil:

n Från menyn File (Arkiv) i hemfönstret

n Från dialogrutan Run Setup (Körningsinställning) i hemfönstret

n Från dialogrutan Startup Wizard (Startguide) i hemfönstret

Så här öppnar du en ny protokollfil från menyn File (Arkiv)

u Välj File > New > Protocol (Arkiv > Nytt > Protokoll) i hemfönstret.

Fönstret Protocol Editor (Protokollredigerare) öppnas och visar standardprotokollfilen.

Tips: Information om hur du ställer in standardprotokollet finns i Ändra standardfilinställningarna
på sidan 83.

Så här öppnar du ett nytt protokoll i dialogrutan Run Setup (Körningsinställning)

1. Gör något av följande i hemfönstret för att öppna dialogrutan Run Setup (Körningsinställning):

n Välj Run > User-defined Run (Körning > Användardefinierad körning).

n Klicka på User-defined Run Setup (Användardefinierad körningsinställning) på verktygsraden.
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Dialogrutan Run Setup (Körningsinställning) öppnas med fliken Protocol (Protokoll) och visar
standardprotokollfilen.

2. Klicka på Create New (Skapa ny).

Fönstret Protocol Editor (Protokollredigerare) öppnas och visar standardrealtidsprotokollet.

Så här öppnar du en ny protokollfil i Startup Wizard (Startguide)

1. Gör något av följande i hemfönstret för att öppna Startup Wizard (Startguide) om den inte är i vyn:

n Välj View > Startup Wizard (Visa > Startguide).

n Klicka på Startup Wizard (Startguide) i verktygsraden.

2. Välj vid behov instrumenttyp från listrutan.

3. Klicka på User-defined (Användardefinierad) som Run type (Körningstyp).

Dialogrutan Run Setup (Körningsinställning) öppnas med fliken Protocol (Protokoll) och visar
standardprotokollfilen.

4. Klicka på Create New (Skapa ny).

Fönstret Protocol Editor (Protokollredigerare) öppnas och visar standardrealtidsprotokollet.

Så här öppnar du ett nytt protokoll från menyn Run (Körning)

1. Gör något av följande i hemfönstret för att öppna dialogrutan Run Setup (Körningsinställning):

n Välj Run > User-defined Run (Körning > Användardefinierad körning).

n Klicka på User-defined Run Setup (Användardefinierad körningsinställning) på verktygsraden.

Dialogrutan Run Setup (Körningsinställning) öppnas med fliken Protocol (Protokoll) och visar
standardprotokollfilen.

2. Klicka på Create New (Skapa ny).

Fönstret Protocol Editor (Protokollredigerare) öppnas och visar standardrealtidsprotokollet.

Öppna ett befintligt protokoll i Protocol Editor
(Protokollredigerare)
CFX Maestro Dx SE tillhandahåller provprotokollfiler som du kan redigera och spara som anpassade nya
protokoll. Du kan också skapa ett nytt protokoll utifrån ett befintligt anpassat protokoll.
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Så här öppnar du en provprotokollfil

1. Välj File > Open (Arkiv > Öppna) i hemfönstret.

Utforskaren i Windows öppnas som standard på platsen för mappen Sample Files (Provfiler) för
CFX Maestro Dx SE.

2. Öppna mappen Sample files (Provfiler). Följande mappar visas:

n ConventionalProtocols (Konventionella protokoll) – innehåller exempelprotokollfiler för
traditionell PCR-analys.

n DataFiles (Datafiler) – innehåller exempeldatafiler som du kan använda för att utforska
funktionerna i CFX Maestro Dx SE.

n MeltCalibration (Smältkalibrering) – innehåller exempelprotokollfiler för användning med
Bio-Rads programvara för precisionssmältanalys.

n Plates (Plattor) – innehåller exempelplattfiler.

n RealTimeProtocols (Realtidsprotokoll) – innehåller exempelprotokollfiler för PCR-analys i
realtid.

3. Öppna protokollmappen för typen av körning som du vill genomföra, antingen ConventionalProtocols
(Konventionella protokoll) eller RealTimeProtocols (Realtidsprotokoll).

4. Välj önskat protokoll och klicka på Open (Öppna).

Protokollet öppnas i fönstret Protocol Editor (Protokollredigerare).

5. Välj File > Save As (Arkiv > Spara som) och spara protokollet med ett nytt namn eller i en ny mapp.

Så här öppnar du ett befintligt protokoll

1. Gör något av följande i fönstret Home (Hem):

n Välj File > Open > Protocol (Arkiv > Öppna > Protokoll). Gå till och välj målprotokoll och klicka på
Open (Öppna).

n Öppna Startup Wizard (Startguide) och gör något av följande:

o Klicka på Edit Selected (Redigera valt) för att redigera protokollet som visas.

o Klicka på Select Existing (Välj befintligt) och gå till målfilen för att redigera ett annat befintligt
protokoll.

Protokollet öppnas i fönstret Protocol Editor (Protokollredigerare).

2. Välj File > Save As (Arkiv > Spara som) och spara protokollet med ett nytt namn eller i en ny mapp.
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Konfigurera ett nytt protokoll
Tips: Om protokollfilen innehåller de nödvändiga parametrarna (t.ex. om du redigerar en befintlig
plattfil) kan du hoppa över det här avsnittet. Gå till Lägga till steg till ett protokoll på sidan 109.

Följande parametrar krävs för nya protokollfiler:

n Block type (Blocktyp)

n Scan mode (Skanningsläge) för vald blocktyp

n Lid temperature (Locktemperatur)

n Sample volume (Provvolym)
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Ställa in blocktypen

CFX Maestro Dx SE beräknar automatiskt temperatursteg för gradientsteg baserat på blocktypen.

Obs! Plattypen som är inställd i Protocol Editor (Protokollredigerare) måste vara densamma som
plattan i reaktionsmodulen.

Så här ställer du in blocktypen

u I fönstret Protocol Editor (Protokollredigerare) väljer du Tools > Gradient Calculator (Verktyg >
Gradientkalkylator) och väljer lämplig plattyp i listrutan som visas.

Välja Scan Mode (Skanningsläge) för vald Block Type (Blocktyp)

Välj målets blocktyp och skanningsläge för att bestämma protokollets körtid.

Så här väljer du blocktyp och skanningsläge

u I fönstret Protocol Editor (Protokollredigerare) väljer du Tools > Run time Calculator (Verktyg >
Körtidskalkylator) och väljer lämplig plattyp och skanningsläge i listrutan som visas.

Justera locktemperaturen

CFX Maestro Dx SE ställer in standardlocktemperaturer enligt följande:

n Instrument med 96 brunnar och djupa brunnar – 105,0 °C

n Instrument med 384 brunnar – 95,0 °C

Du kan ändra standardinställningarna eller stänga av lockvärmaren enligt vad som krävs för protokollet.

Så här justerar du locktemperaturen

1. I fönstret Plate Editor (Plattredigerare) väljer du Settings > Lid Settings (Inställningar >
Lockinställningar).

Dialogrutan Lid Settings (Lockinställningar) visas.

2. Gör något av följande:

n Välj User Defined (Användardefinierad) och skriv in ett temperaturvärde i textrutan.

n Välj Turn Off Lid Heater (Stäng av lockvärmare).

3. Klicka på OK för att acceptera ändringarna och stänga dialogrutan
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Ställa in provvolymen

Som standard ställer CFX Maestro Dx SE in provvolymen för varje brunn på 25 µl. Provvolymer skiljer sig
åt beroende på typen av block, till exempel:

n 0–50 µl för ett block med 96 brunnar

n 0–30 µl för ett block med 384 brunnar

Instrumentet använder ett av två kontrollägen för att bestämma när provet når måltemperaturen i ett
protokoll:

n Calculated mode (Beräknat läge) – när provvolymen är inställd på en volym som inte är noll och
som är lämplig för blocket, beräknar instrumentet provtemperaturen baserat på provvolymen. Detta
är standardläget.

n Block mode (Blockläge) – när provvolymen är inställd på noll (0) µl, registrerar instrumentet
provtemperaturen som identisk med den uppmätta blocktemperaturen.

Så här ställer du in provvolymen för ett specifikt block

u I fönstret Plate Editor (Plattredigerare) ställer du in rätt värde i textrutan Sample Volume (Provvolym) i
verktygsraden.

Tips: Du kan ändra standardprovvolymen i dialogrutan User Preferences (Användarinställningar).
Se Ändra standardfilinställningarna på sidan 83.

Lägga till steg till ett protokoll
För att lägga till ett steg till ett protokoll

1. Öppna protokollet i fönstret Protocol Editor (Protokollredigerare).

2. Bestäm var det nya steget ska infogas. I verktygsraden väljer du Before (Före) eller After (Efter) i
listrutan Step (Steg).

3. I diagrammet väljer du steget före eller efter vilket du tänker infoga det nya steget.

4. Klicka på Insert Step (Infoga steg) i den vänstra rutan.

5. För att ändra temperaturen eller hålltiden klickar du på standardvärdet i diagrammet eller på
protokollramen och skriver ett nytt värde.

6. (Valfritt) Klicka på Step Options (Stegalternativ) i den vänstra rutan för att visa dialogrutan Step
Options (Stegalternativ) och ändra de tillgängliga alternativen för det valda steget.

Tips: Du kan öppna dialogrutan Step Options (Stegalternativ) från högerklicksmenyn antingen i
diagramrutan eller protokollramsrutan.

7. Klicka på OK och sedan på Yes (Ja) för att spara ändringar i protokollet.
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Dialogrutan Save As (Spara som) visas.

8. Skriv in ett nytt namn för den nya protokollfilen i dialogrutan Save As (Spara som) och klicka på Save
(Spara).

Infoga ett gradientsteg
Så här infogar du ett gradientsteg

1. Kontrollera att plattstorleken för gradienten är densamma som blocktypen för instrumentet,
96 brunnar, 384 brunnar eller djupa brunnar.

2. Om inte det har gjorts väljer du plattstorlek för gradienten:

Välj Tools > Gradient Calculator (Verktyg > Gradientkalkylator) och välj lämplig brunnstyp i listrutan.

3. Välj Before (Före) eller After (Efter) i listrutan Insert Step (Infoga steg) i verktygsraden.

4. Välj steget före eller efter vilket du planerar att infoga gradientsteget i diagram- eller
dispositionsfönstret.

5. Klicka på Insert Gradient (Infoga gradient) i den vänstra rutan. Det nya gradientsteget markeras i
diagram- eller dispositionsfönstret, exempelvis:

Temperaturen för varje rad i gradienten visas i tabellen Gradient i den högra rutan.
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6. Du redigerar gradienttemperatursintervallet genom att göra något av följande:

n Klicka på standardtemperaturen i diagram- eller dispositionsfönstret och ange en ny temperatur.

n Klicka på Step Options (Stegalternativ) för att komma till gradientintervallet i fönstret Step
Options (Stegalternativ).

n Ändra värdet Range (Område) i tabellen Gradient.

7. Du redigerar hålltiden genom att klicka på standardtiden i grafik- eller textvyn och ange en ny tid.

8. Klicka på OK och sedan på Yes (Ja) för att spara ändringarna.

Infoga ett GOTO-steg
Obs! Du kan inte infoga ett GOTO-steg inom en GOTO-uppsättning. Du kan inte skapa inbäddade
GOTO-loopar.

Så här infogar du ett GOTO-steg

1. I verktygsraden väljer du Before (Före) eller After (Efter) i listrutan Insert Step (Infoga steg).

2. I diagrammet väljer du steget före eller efter vilket du tänker infoga det nya GOTO-steget.

3. Klicka på Insert GOTO (Infoga GOTO) i den vänstra rutan.

4. För att redigera GOTO-stegnumret eller antalet GOTO-upprepningar väljer du standardnumret i
grafen eller översiktsrutan och anger ett nytt värde.

5. Klicka på OK och sedan på Yes (Ja) för att spara ändringarna.

Infoga ett smältkurvsteg
Tips: Du kan inte infoga ett smältkurvsteg i en GOTO-loop.

Obs! Smältkurvsteget inkluderar ett uppehåll på 30 sek. i början av steget som inte visas i
protokollet.

Så här infogar du ett smältkurvsteg

1. I verktygsraden väljer du Before (Före) eller After (Efter) i listrutan Insert Step (Infoga steg).

2. Välj steget före eller efter där du vill infoga smältkurvsteget i diagrammet.
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3. Klicka på Insert Melt Curve (Infoga smältkurva) i den vänstra rutan. Det nya smältkurvsteget
markeras i grafen och översiktsrutan, till exempel:

4. För att ändra smälttemperaturområdet eller ökningstiden väljer du standardnumret i grafen eller
översiktsrutan och anger ett nytt värde.

5. Klicka på OK och sedan på Yes (Ja) för att spara ändringarna.
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Lägga till eller ta bort ett plattavläsningssteg
Tips: När du har lagt till ett plattavläsningskommando i ett steg ändras knappen till Remove Plate
Read (Ta bort plattavläsning) när du väljer ett steg.

Så här lägger du till en plattavläsning i ett steg

1. I verktygsraden väljer du Before (Före) eller After (Efter) i listrutan Insert Step (Infoga steg).

2. I diagrammet väljer du steget före eller efter vilket du tänker infoga plattläsningssteget.

3. Klicka på Add Plate Read to Step (Lägg till plattavläsning till steg) i den vänstra rutan för att lägga till
en plattavläsning för det valda steget.

4. Klicka på OK och sedan på Yes (Ja) för att spara ändringarna.

Så här tar du bort en plattavläsning från ett steg

u I diagrammet, välj det steg som innehåller plattavläsningen och klicka på Remove Plate Read (Ta
bort plattavläsning) i den vänstra rutan.

Ändra stegalternativ
Så här ändrar du stegalternativen för ett valt steg

1. Välj målsteget i diagram- eller dispositionsfönstret.

2. Klicka på Step Options (Stegalternativ) i den vänstra rutan för att öppna dialogrutan Step Options
(Stegalternativ).

Eller högerklicka på målsteget i endera ruta och välj Step Options (Stegalternativ) på menyn som
öppnas.

3. Så här lägger du till, ändrar och tar bort alternativ:

n Ange ett värde i lämplig textruta.

n Redigera ett värde i den specifika textrutan.

n Markera eller avmarkera en kryssruta.

4. Klicka på OK för att spara ändringarna och stänga dialogrutan Step Options (Stegalternativ).

5. Klicka på OK och sedan på Yes (Ja) för att spara protokollet.
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Ta bort ett steg
Viktigt! Du kan inte ångra den här funktionen. Var försiktig när du tar bort steg.

Så här tar du bort ett steg i protokollet

1. Välj steget i grafen eller översiktsrutan.

2. Klicka på Delete Step (Ta bort steg) i den vänstra rutan för att ta bort det valda steget.

3. Klicka på OK och sedan på Yes (Ja) för att spara protokollet.

Kopiera, exportera eller skriva ut ett protokoll
Så här kopierar du ett protokoll

u Högerklicka på protokolldispositionen och välj Copy Protocol (Kopiera protokoll).

Du kan klistra in dispositionen i en .txt-, .xls-, .doc- eller .ppt-fil.

Så här exporterar du ett protokoll

1. Högerklicka på protokolldispositionen och välj Export Protocol (Exportera protokoll).

Dialogrutan Save As (Spara som) visas.

2. (Valfritt:) Gå till mappen i Utforskaren där du vill spara protokollfilen.

3. I File name (Filnamn) skriver du ett namn på den exporterade protokollfilen.

4. Klicka på Save (Spara).

Så här skriver du ut ett protokoll

u Högerklicka på protokolldispositionen och välj Print (Skriv ut).

Du kan skriva ut protokolldispositionen på din standardskrivare.
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Skapa ett protokoll med Protocol AutoWriter (Protokollförslag)
Viktigt! Bio-Rad garanterar inte att körning av ett protokoll som skapats med Protocol AutoWriter
(Protokollförslag) alltid resulterar i en PCR-produkt.

Protocol AutoWriter (Protokollförslag) i CFX Maestro Dx SE skapar automatiskt cykelprotokoll baserat på
följande inmatningsparametrar:

n Amplicon length (Amplikonlängd) – förväntad längd på PCR-produkten

n Annealing temperature (Hybridiseringstemperatur) – reaktions-Ta för de primrar som används

Om Ta är okänd, kan du använda Ta-kalkylatorn för att beräkna den automatiskt baserat på dina
primersekvenser.

Obs! Ta justeras från informationen om primerns smälttemperatur (Tm) som baseras på det
valda enzymet och protokollhastigheten.

n Enzyme type (Enzymtyp) – DNA-polymerasenzymet (iTaq™, iProof™ DNA-polymeras eller annat)

Om du använder ett annat enzym än iTaq eller iProof DNA-polymeras, kan du ange ytterligare
information, inklusive gradientintervall, aktiveringstid för hot start (i sek) och slutlig förlängningstid (i
sek).

n Run speed (Körningshastighet) – reaktionshastigheten (standard, snabb eller ultrasnabb)

Protocol AutoWriter (Protokollförslag) optimerar protokollet beroende på den valda
hastighetsinställningen. Den totala körningstiden bestäms av antalet steg och cykler, inkubationstid
vid varje steg, och tiden det tar att nå enhetlighet vid måltemperaturen.

Med användning av parametrar som du anger och standardriktlinjer för PCR, skapar Protocol AutoWriter
(Protokollförslag) automatiskt ett anpassat PCR-protokoll med steg för hot start, initial denaturering,
hybridisering och förlängning. Du kan sedan visa en grafisk representation av det föreslagna protokollet
och redigera, köra eller spara protokollet.
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Så här skapar du ett nytt protokoll med Protocol AutoWriter (Protokollförslag) i
CFX Maestro Dx SE

1. I hemfönstret väljer du Tools > Protocol AutoWriter (Verktyg > Protokollförslag).

Dialogrutan Protocol AutoWriter (Protokollförslag) visas.

2. Gör följande i sektionen Enter Target Values/Enzyme (Ange målvärden/enzym):

n Ange Annealing Temperature (Ta) (hybridiseringstemperatur) för primrar, om den är känd.

Tips: Se Använda Ta-kalkylatorn på sidan 117 för mer information.

Obs! För information om beräkningarna som används i Ta Calculator (Ta-kalkylator), se
Breslauer et al. 1986.

n Ange amplicon length (amplikonlängd) i baspar (bp).

n Välj en enzymtyp från listan med alternativ (iTaq DNA polymerase (DNA-polymeras), iProof
DNA polymerase (DNA-polymeras), eller Other (Annan)).

Tips: Om du väljer Other (Annan) som enzymtypen, blir parametrarna i sektionen
Additional Parameters (Optional) (Ytterligare parametrar) (valfritt) aktiva.
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3. Om du valde Other (Annan) som enzymtypen kan du lägga till en eller alla av följande parametrar till
protokollet:

n Gradient range (Gradientintervall)

n Hot start activation temperature (Aktiveringstemperatur för hot start)

n Final extension time (Slutlig förlängningstid)

4. I sektionen Type (Typ), flytta glidreglaget för att välja protokollhastighet (Standard, Fast (Snabb) eller
Ultrafast (Ultrasnabb)). CFX Maestro Dx SE justerar den totala körningstiden.

5. Välj vilken typ av PCR som ska utföras (standard är Real-time PCR (Realtids-PCR)).

Vid real-time PCR (realtids-PCR) lägger CFX Maestro Dx SE till ett plattavläsningssteg för att samla
in fluorescensdata.

6. Granska protokollet i sektionen Preview (Förhandsgranskning). Du kan göra ändringar om det
behövs.

7. Gör något av följande:

n Klicka på OK för att spara det nya protokollet. När protokollet är sparat öppnas det i Startup
Wizard (Startguide). Klicka på Edit Selected (Redigera valt) för att göra eventuella ändringar i
protokollet. Du kan till exempel behöva ändra locktemperaturen och provvolymen.

n Klicka på Cancel (Avbryt) för att stänga fönstret utan att spara protokollet.

Använda Ta-kalkylatorn
Om hybridiseringstemperaturen för primern är okänd kan du beräkna värdet med hjälp av Ta-kalkylatorn.
Med det värdet kan du skapa protokollet i Protocol AutoWriter (Protokollförslag) eller Protocol Editor
(Protokollredigerare).

Om Ta Calculator (Ta-kalkylatorn)
Ta-kalkylatorn beräknar Tm-värdet för varje primer och Ta-värdet för protokollet i standardhastighet.

Ta för protokollet baseras på de genomsnittliga Tm-primervärdena med följande regler tillämpade:

n Om skillnaden mellan Tm-primervärdena är > 4 °C gäller att Ta = (det lägre av Tm-primervärdena + 2)
– 4 °C

n Om skillnaden mellan Tm-värdena är ≤ 4 °C gäller att Ta = (genomsnittet av Tm-primervärdena) –
4 °C
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Räkningsmetod för baspar

För varje primer använder Ta-kalkylatorn räkningsmetoden för baspar för sekvenser av 14 baspar (bp)
eller färre.

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

där w, x, y och z är numren för baserna A, T, G respektive C i sekvensen.

Metoden Nearest Neighbor

För sekvenser som är längre än 14 bp används metoden nearest neighbor (närmsta granne). I metoden
nearest neighbor (närmsta granne), baseras beräkningarna av smälttemperatur på det termodynamiska
förhållandet mellan entropi (ordning eller ett mått på oligonukleotidens slumpmässighet), entalpi (värme
som frigörs eller absorberas av oligonukleotiden), fri energi och temperatur.

∆H = ∆G + T* ∆S

där:

n ∆H = Entalpivärde, kal/mol*K

n T = temperatur, Kelvin

n ∆S = Entropivärde, kal/mol*K

n ∆G = Gibbs fria energi i kal/mol*K

Förändringen av entropi och entalpi beräknas direkt genom summering av värdena för nukleotidparen
som visas i Tabell 8 (Breslauer et al. 1986).

Förhållandet mellan den fria energin och koncentrationen av reaktanter och produkter vid ekvilibrium
räknas ut med:

∆G = R*T*ln ((DNA * Primer)/(DNA + Primer))

där R är gaskonstanten (1,986 kal/mol*K).

Om du ersätter G i de två ekvationerna och lösningen med T får du

T = ∆H/(∆S + R*Ln((DNA * Primer)/(DNA + Primer)))

förutsatt att koncentrationen av DNA och DNA-primerkomplex är likvärdig.

Det har fastställts empiriskt att det sker en förändring på 5 kcal fri energi (3,4 kcal) (Sugimoto et al. 1996)
under övergången från ensträngat DNA till B-forms-DNA. Detta är förmodligen spiralens initieringsenergi.
Slutligen, om du lägger till en justering för salt får du ekvationen som används av TTa -kalkylatorn:

T = (∆H – 5(kcal/K*mol))/(∆S + (R * ln(1/(primer)))) + 16,6 log10 (SaltMolaritet)
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Det behövs ingen justeringskonstant för saltkoncentration, eftersom de olika parametrarna bestämdes vid
1 M NaCl, och log10 för 1 är noll.

De termodynamiska beräkningarna förutsätter att hybridisering sker vid pH 7,0. Tm-beräkningarna
förutsätter att sekvenserna inte är symmetriska och innehåller minst ett G eller C.

Oligonukleotidsekvensen ska vara minst 14 baser lång för att ge rimliga Tm-värden. Mindre än 14 baser
använder basparsräkningsmetoden (se Tabell 8 nedan).

Interaktion ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

Tabell 8. Breslauers interaktionskonstanter
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Använda Ta-kalkylatorn

Så här använder du Ta-kalkylatorn

1. Gör något av följande för att öppna Ta Calculator (Ta-kalkylatorn):

n Klicka på Ta Calculator (Ta-kalkylatorn) om du befinner dig i Protocol AutoWriter
(Protokollförslag).

n Välj Tools > Ta Calculator (Verktyg > Ta-kalkylator) i hemfönstret.

Dialogrutan Ta Calculator (Ta-kalkylator) öppnas.

2. Skriv eller klistra in framåtprimersekvensen i textrutan Forward Primer (Framåtprimer).

Tips: Du kan också använda knapparna A, T, G, C till vänster i dialogrutan för att ange
sekvensen.

3. Skriv eller klistra in den omvända primersekvensen i textrutan Reverse Primer (Omvänd primer)

4. Klicka på Calculate (Beräkna).
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Ta Calculator (Ta-kalkylatorn) beräknar och visar Tm för varje primer samt genomsnittliga värden för
Tm och Ta, till exempel:

Om det skiljer mer än 4 °C mellan primer-Tm-värden använder Protocol AutoWriter det lägre primer-
Tm-värdet + 2 °C som bas för beräkning av Ta-värdet, som du kan modifiera ytterligare genom att
ändra enzym- och reaktionshastigheten.

Ta Calculator (Ta-kalkylatorn) genererar en hybridiseringstemperatur för standardhastighet med iTaq
DNA-polymeras. När du använder en annan enzym justerar hastighetsinställningarna automatiskt
Ta.

5. Gör något av följande:

n Klicka på OK om du öppnade Ta Calculator (Ta-kalkylatorn) från Protocol AutoWriter
(Protokollförslag). Du återgår till Protocol AutoWriter (Protokollförslag).
Hybridiseringstemperaturen ändras automatiskt.

n Om du öppnade Ta Calculator (Ta-kalkylatorn) från menyn Tools (Verktyg), registrera
beräkningarna och klicka på Cancel (Avbryt) för att stänga kalkylatorn.
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Kapitel 8 Förbereda plattor
En plattfil innehåller information om körningsparametrar, t.ex. skanningsläge, fluoroforer och
brunnsinnehåll. Efter körningen länkar CFX Maestro Dx programvara, Security Edition brunnsinnehållet
till de fluorescensdata som samlats in under körningen och tillämpar lämplig analys i fönstret Data
Analysis (Dataanalys). Exempelvis används brunnar som är laddade med standardprovtyp för att
generera en standardkurva.

CFX Maestro Dx SE erbjuder två alternativ för att skapa plattor: Plate Editor (Plattredigeraren) för realtids-
PCR-körningar och Setup Wizard (Inställningsguiden) för normaliserad genuttrycksanalys.

I Plate Editor (Plattredigerare) ingår följande funktioner:

n standardfluoroforer och provtyper att tilldela till plattbrunnar

n möjlighet att ställa in referensmål och kontrollprov för genuttrycksanalys

n möjlighet att redigera plattinställning före, under eller efter en körning

n möjlighet att spara plattfiler för återanvändning

n möjlighet att skriva ut plattfilen på en standardskrivare.

Setup Wizard (Inställningsguide) vägleder dig genom skapandet av en plattlayout för analys av
normaliserat genuttryck. Setup Wizard (Inställningsguide) kan användas före, under och efter en körning.
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Fönstret Plate Editor (Plattredigerare)
Du använder Plate Editor (Plattredigerare) för att skapa anpassade plattor eller ändra befintliga plattor.

1. Menyraden ger snabb åtkomst till kommandona i File (Arkiv) och Settings (Inställningar) liksom
alternativ för plattredigeringsverktyg.

2. Verktygsraden ger snabb åtkomst till viktiga plattladdningsfunktioner.

3. I huvudrutan visas plattans kontur och plattalternativen efterhand som du lägger till dem.

4. I den högra rutan visas alternativ som du använder för att anpassa din platta.

5. I den nedre rutan visas plattypen och du får snabb åtkomst till visningsalternativ.

FÖRKLARING

Kommandon på menyn File (Arkiv)
Save (Spara) – sparar plattdatafilen i den plats som anges på fliken File (Arkiv) i dialogrutan User
Preferences (Användarinställningar) Se Ändra standardfilinställningarna på sidan 83 för mer information.
Det här menyalternativet är endast tillgängligt när en ny plattfil skapas.

Save As (Spara som) – sparar den öppna plattdatafilen med valfritt nytt namn. Det här menyalternativet
är endast tillgängligt när en ny plattfil skapas.

124 | CFX Maestro Dx SE programvara



Fönstret Plate Editor (Plattredigerare)

File Passwords (Fillösenord) – gör det möjligt för användare att ställa in lösenord för att spara och öppna
filer.

Extract Plate (Extrahera platta) – öppnar en dialogruta där du kan extrahera eller spara plattfilen (.pltd).
Det här menyalternativet är endast tillgängligt när du visar eller redigerar en befintlig plattfil.

Print (Skriv ut) – skriver ut den öppna plattdatafilen.

Close (Stäng) – stänger Plate Editor (Plattredigerare).

Kommandon på menyn Edit (Redigera)
Undo (Ångra) – återställer en ändring av en plattfil tills plattfilen sparas.

Redo (Gör om) – återför den senaste Undo-åtgärden (Ångra) såvida inte plattfilen har sparats.

Kommandon på menyn Settings (Inställningar)
Plate Size (Plattstorlek) – öppnar en dialogruta där du kan välja plattstorlek för körningen.

Obs! Plattstorleken måste vara samma som blockstorleken på det instrument där körningen
utförs.

Välj 96 brunnar för:

n CFX Opus 96 Dx

n CFX Opus Deepwell Dx

Välj 384 brunnar för:

n CFX Opus 384Dx

Plate Type (Plattyp) – låter dig välja typ av brunn i plattan som håller proverna – antingen BRWhite eller
BR Clear. För korrekt dataanalys måste plattypen som väljs överensstämmamed plattypen som används
i körningen.

Obs! Du måste kalibrera nya plattyper. Se Kalibrera nya färger på sidan 75 för mer information.

Number Convention (Nummerkonvention) – låter dig markera eller avmarkera alternativet att visa
enheter i vetenskaplig notation. Enheter visas som standard med vetenskaplig notation.

Units (Enheter) – låter dig välja enheter att visa i kalkylbladen när du utför kvantifiering av okända värden
kontra en standardkurva.
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Kommandon på menyn Editing Tools (Redigeringsverktyg)
Setup Wizard (Inställningsguide) – öppnar inställningsguiden där du kan definiera layout- och
analysparametrar för den aktuella plattan. Du kan använda Setup Wizard (Inställningsguide) före, under
eller efter en körning.

Spreadsheet View/Importer (Kalkylbladsvy/Importerare) – öppnar dialogrutan View (Visa) där
plattlayouten visas sommall i kalkylbladsformat. I den här dialogrutan kan du exportera och importera
plattmallsdata i .csv-format.

Flip Plate (Vända platta) – vänder plattans innehåll 180o.

Kommandon i verktygsraden

Återställer en ändring av en platta. I CFX Maestro Dx SE kan upp till tio
åtgärder ångras.

Ångrar den senaste Ångra-åtgärden. I CFX Maestro Dx SE kan upp till tio
åtgärder göras om efter att ha ångrats.

Sparar den aktuella plattfilen.

Visar en listruta i vilken du kan öka och minska förstoringen av plattvyn.

Visar en listruta i vilken du kan välja ett skanningsläge som instruerar
instrumentet från vilka kanaler det ska samla in fluorescensdata under en
körning.

Öppnar Well Groups Manager (Brunnsgruppshanterare) där du kan
skapa brunnsgrupper för den aktuella plattan.

Öppnar en dialogruta där du kan välja alla färger och symboler för
amplifieringskurvorna.

Öppnar dialogrutan View (Visa) som visar plattlayouten som en mall i
kalkylbladsformat. I den här dialogrutan kan du exportera och importera
plattmallsdata i .csv-format.

Öppnar Setup Wizard (Inställningsguide) där du kan ange den aktuella
plattans layout- och analysparametrar. Setup Wizard (Inställningsguide)
kan användas före, under och efter en körning.
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Öppnar fliken Plate (Platta) i dialogrutan User Preferences
(Användarinställningar) där du kan ange plattans layoutparametrar och
skapa samt ta bort namn på mål, prover och biologiska grupper.
Ändringar som görs på fliken Plate (Platta) är tillgängliga nästa gång
Plate Editor (Plattredigerare) öppnas.

Visar de nödvändiga stegen för att konfigurera en platta och ladda
brunnarna.
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Skapa en plattfil med Plate Editor (Plattredigerare)
Du kan skapa anpassade plattfiler i Plate Editor (Plattredigerare). Du kan även redigera och spara tidigare
sparade plattfiler eller provplattfiler som levererats med CFX Opus Dx-system.

Gör följande för att skapa en ny plattfil:

n Öppna en plattfil i Plate Editor (Plattredigerare).

n Välj plattyp.

Obs! Plattfilens plattyp måste vara densamma som plattan i reaktionsmodulen.

n Välj skanningsläget som ska användas i protokollet.

n Välj fluoroforerna som ska användas i plattan.

n Välj provtyp, mål och prover.

n Välj om lämpligt tekniska replikat.

n Spara plattlayouten.

Tips: Information om hur du skapar en ny platta av tidigare sparade eller provplattfiler finns i Öppna
en befintlig plattfil i Plate Editor (Plattredigerare) på sidan 130.

Öppna en ny plattfil i Plate Editor (Plattredigerare)
CFX Maestro Dx SE erbjuder olika alternativ för att öppna en ny plattfil:

n från hemfönstret

n från dialogrutan Startup Wizard (Startguide)

n från dialogrutan Run Setup (Körningsinställning).

Så här öppnar du en ny plattfil från hemfönstret

u Välj File > New > Plate (Arkiv > Ny >Platta).

Fönstret Plate Editor (Plattredigerare) öppnas och visar standardplattfil för det valda instrumentet.

Tips: Se Ändra standardfilinställningarna på sidan 83 för mer information om hur du ställer in
standardfil för platta.
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Så här öppnar du en ny plattfil från Startup Wizard (Startguide)

1. Gör något av följande i hemfönstret för att öppna Startup Wizard (Startguide) om den inte är i vyn:

n Välj View > Startup Wizard (Visa > Startguide).

n Klicka på Startup Wizard (Startguide) i verktygsraden.

2. Välj vid behov instrumenttyp från listrutan.

3. Klicka på User-defined (Användardefinierad) som körningstyp för att skapa en ny platta.

Dialogrutan Run Setup (Inställning av körning) öppnas och visar fliken Protocol (Protokoll).

4. Klicka på fliken Plate (Platta) och sedan på Create New (Skapa ny).

Fönstret Plate Editor (Plattredigerare) öppnas och visar standardplattlayout för det valda
instrumentet.

Så här öppnar du en ny plattfil från dialogrutan Run Setup (Inställning av körning)

1. Gör något av följande i hemfönstret för att öppna dialogrutan Run Setup (Körningsinställning):

n Välj Run > User-defined Run (Körning > Användardefinierad körning).

n Klicka på User-defined Run Setup (Användardefinierad körningsinställning) på verktygsraden.

Dialogrutan Run Setup (Inställning av körning) öppnas och visar fliken Protocol (Protokoll).

2. Klicka på fliken Plate (Platta) och sedan på Create New (Skapa ny) för att skapa en ny platta.

Fönstret Plate Editor (Plattredigerare) öppnas och visar standardplattlayout för det valda
instrumentet.
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Öppna en befintlig plattfil i Plate Editor (Plattredigerare)
CFX Maestro Dx SE tillhandahåller provplattfiler som du kan redigera och spara som en ny platta. Du kan
även skapa en ny plattfil från en tidigare sparad plattfil.

Så här öppnar du en provplattfil

1. Välj File > Open > Plate (Arkiv > Öppna > Platta) i hemfönstret.

Utforskaren öppnas på platsen för mappen Sample Files (Provfiler) i CFX Opus Dx-system.

2. Öppna mappen Sample files (Provfiler) och öppna sedan mappen Plates (Plattor).

3. Välj en plattfil och klicka på Open (Öppna).

Provplattfilen öppnas i fönstret Plate Editor (Plattredigerare).

4. Välj File > Save As (Arkiv > Spara som) och spara plattfilen med ett nytt namn eller i en ny mapp.

Så här öppnar du en tidigare sparad plattfil

1. Gör något av följande i fönstret Home (Hem):

n Välj File > Open > Plate (Arkiv > Öppna > Platta), gå till och välj målplattan och klicka på Open
(Öppna).

n Öppna Startup Wizard (Startguide) och gör något av följande:

o För att redigera en befintlig plattfil, klicka på Select Existing (Välj befintlig) och gå till
målfilen.

o För att redigera den visade plattfilen, klicka på Edit Selected (Redigera vald).

Målplattan öppnas i fönstret Plate Editor (Plattredigerare).

2. Välj File > Save As (Fil > Spara som) och spara plattfilen med ett nytt namn eller i en ny mapp.
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Ställa in en ny plattfil
Tips: Om plattfilen innehåller de nödvändiga parametrarna (t.ex. om du redigerar ett prov eller en
befintlig plattfil) kan du hoppa över det här avsnittet. Gå till Tilldela valfria parametrar till plattfilen på
sidan 138.

Följande parametrar krävs för nya plattfiler:

n Plate Size (Plattstorlek)

n Plate type (Plattyp)

n Scan mode (Skanningsläge)

n En Fluorophore (fluorofor)

n En Sample type (Provtyp)

Välja typ och storlek för platta

Viktigt! Du måste välja en plattstorlek under plattinställning. Du kan inte ändra plattstorlek under
eller efter en körning.

Programvaran tillämpar plattstorleken och -typen på alla brunnar under körningen. Kontrollera att den
valda plattstorleken överensstämmer med plattan som du kommer att använda i körningen.

Bio-Rads CFX Opus Dx-systemen är fabrikskalibrerade för många kombinationer av fluorescerande
färgämnen och plattor. Kalibreringen är specifik för instrumentet, färg, och typ av platta. Säkerställ att
fluoroforen som du vill använda är kalibrerad för den plattyp du väljer.

Tips: Välj Tools > Dye Calibration Wizard (Verktyg > Färgkalibreringsguide) för att kalibrera en ny
kombination av färg och plattyp. Se Kalibrera nya färger på sidan 75 för information om hur du
kalibrerar färger och typer av plattor.

Välja skanningsläge

CFX Opus 96 Dx- och CFX Opus Deepwell Dx-systemen exciterar och detekterar fluoroforer i fem kanaler
(plus FRET). CFX Opus 384 Dx-systemet exciterar och detekterar fluoroforer i fyra kanaler (plus FRET).
Alla system använder flera skanningslägen för datainsamling för att samla in fluorescensdata under en
körning.

CFX Maestro Dx SE har tre skanningslägen:

n All Channels (Alla kanaler)

o Skannar kanal 1 till 5 på CFX Opus 96 Dx- och CFX Opus Deepwell Dx-systemen

o Skannar kanal 1 till 4 på CFX Opus 384 Dx-system
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n SYBR®/FAM

o Skannar endast kanal 1

o Ger snabb skanning

n FRET

o Skannar endast FRET-kanalen

o Ger snabb skanning

Välja fluoroforer

Viktigt! Innan körningen startas verifierar CFX-systemen att fluoroforerna som du har angett i plattan
är kalibrerade på det instrumentet. Det går inte att köra en platta om den innehåller fluoroforer som
inte har kalibrerats på det instrumentet.

Du måste ladda minst en fluorofor i plattlayouten före körningen. Du kan lägga till så många fluoroforer
som behövs vid denna tidpunkt, men plattan måste innehålla minst en fluorofor. De valda fluoroforerna
visas som alternativ för mål i Target Names (Målnamn).

I dialogrutan Select Fluorophores (Välj fluoroforer) kan du ladda fluoroforer till reglagen för
brunnsladdning i Plate Editor (Plattredigerare). Fluoroforerna som visas i dialogrutan Select Fluorophores
(Välj fluoroforer) beror på vilket skanningsläge som väljs:

n All Channels (Alla kanaler)

Alla tillgängliga fluoroforer visas.

Tips: Du kan lägga till så många fluoroforer som behövs, men det går bara att ladda en fluorofor
per kanal i varje brunn.

n SYBR®/FAM

Endast kanal 1-fluoroforer visas.

n FRET

Endast kanal 6-fluoroforen visas.

Tips: Kanal 6 FRET-fluoroforen visas bara när FRET är det valda skanningsläget. Den är inte
tillgänglig för skanningsläget All Channels (Alla kanaler).

Obs! Det går inte att lägga till eller ta bort fluoroforer direkt i dialogrutan Select Fluorophore (Välj
fluorofor). Du måste kalibrera nya fluoroforer på ett instrument med hjälp av Calibration Wizard
(Kalibreringsguide). Efter kalibreringen läggs den nya fluoroforen automatiskt till i listan. Mer
information finns i Kalibrera nya färger på sidan 75.
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Välja provtyper

Viktigt! Du måste välja minst en provtyp att tilldela till plattbrunnarna före körningen.

I CFX Maestro Dx SE finns fem provtyper:

n Unknown (Okänd)

n Standard

n NTC (no template control, ingen templatkontroll)

n Positive Control (Positiv kontroll)

n Negative Control (Negativ kontroll)

n NRT (no reverse transcriptase, inget omvänt transkriptas)

Du tilldelar provtyperna till plattbrunnarna.

Konfigurera en ny platta

Så här ställer du in en ny platta

1. Öppna en ny platta i fönstret Plate Editor (Plattredigerare).

2. Du ställer in plattstorlek genom att välja Settings > Plate Size (Inställningar > Plattstorlek) och välja
lämplig plattstorlek på den nedrullningsbara menyn.

3. Du ställer in plattyp genom att välja Settings > Plate Type (Inställningar > Plattyp) och välja BRWhite
(BR vit) eller BR Clear (BR transparent) på den nedrullningsbara menyn.

4. På menyn Settings (Inställningar) kan du ändra siffersystem och visningsenheter:

n Du ändrar siffersystem genom att välja Settings > Number Convention (Inställningar >
Siffersystem) och välja Scientific Notation (Grundpotensform).

Tips: Scientific Notation (Grundpotensform) är valt som standard. Om du väljer Scientific
Notation (Grundpotensform) i det här fallet rensas standardvärdet och siffersystemet ställs
in på standardformen.

n Du ändrar visningsenheter genom att välja Settings > Units (Inställningar > Enheter) och välja ett
nytt enhetsvärde.

5. Du ställer in skanningsläget genom att välja lämpligt skanningsläge i listrutan Scan Mode
(Skanningsläge) i verktygsraden i fönstret Plate Editor (Plattredigerare).
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6. Välj nödvändiga fluoroforer för plattan:

a. Klicka på Select Fluorophores (Välj fluoroforer) i den högra rutan.

Dialogrutan Select Fluorophores (Välj fluroforer) öppnas. Du ser fluoroforerna som är tillgängliga
för typen av skanningsläge som du har valt i Steg 5, till exempel:

b. Du väljer en fluorofor genom att markera dess kryssruta Selected (Vald).

Tips: Avmarkera kryssrutan Selected (Vald) för en fluorofor som du vill ta bort från listan.

c. Du ändrar visningsfärgen för fluoroforen genom att klicka i dess ruta Color (Färg).

Obs! Färgen som du väljer representerar fluoroforen i fönstret Plate Editor (Plattredigerare)
och i diagram av typen Data Analysis (Dataanalys).

d. I dialogrutan Color (Färg) väljer du önskad färg eller klickar på Define Custom Colors (Definiera
anpassade färger) och skapar en ny färg som ska representera fluoroforen.

e. Klicka på OK för att spara ändringarna och stänga dialogrutan Select Fluorophores (Välj
fluoroforer).
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7. Du måste välja minst en brunn i vilken en provtyp ska laddas. Som standard är brunnen A1 vald.

Gör följande i plattrutan:

n Ladda flera närliggande brunnar genom att klicka på en brunn och dra den till målbrunnen.

n Ladda flera brunnar som inte ligger intill varandra genom att hålla ned Ctrl-tangenten och klicka
på varje brunn.

n Ladda en hel kolumn med samma provtyp genom att klicka på kolumnnumret.

n Ladda en hel rad genom att klicka på radens nummer.

n Ladda hela plattan genom att klicka i det övre vänstra hörnet av plattan.

Exempel:

8. Tilldela en provtyp till vald brunn eller valda brunnar i den nedrullningsbara menyn Sample Type
(Provtyp).
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9. Tilldela minst en fluorofor till alla brunnar som innehåller en provtyp. Det går att tilldela fler än en
fluorofor till en brunn eller grupp av brunnar.

Obs! Det går bara att tilldela en fluorofor per kanal. Det går inte att tilldela fler än en fluorofor från
samma kanal till samma brunn.

Tips: Du kan associera ett mål med fluoroforen eller tilldela endast fluoroforen till brunnen vid
denna tidpunkt och associera ett mål till fluoroforen efter att du har kört experimentet.

n Om du vill tilldela endast en fluorofor till valda brunnar markerar du kryssrutan Load (Ladda) för
den specifika fluoroforen i avsnittet Target Names (Målnamn) i den högra rutan.

n Du associerar ett mål med en fluorofor genom att välja ett målnamn i listrutan för den specifika
fluoroforen i avsnittet Target Names (Målnamn). Programvaran väljer automatiskt dess
kryssruta Load (Ladda).

10. För brunnar som innehåller provtypen Standard måste du ladda en koncentration. Alla brunnar kan
ha olika koncentrationsvärden. Som standard laddar CFX Maestro Dx SE en koncentration på
1,00 E + 06 i alla brunnar med provtypen Standard. Du kan ändra värdet vid behov.

a. Välj en Standard-brunn eller -grupp av brunnar i plattrutan.

b. Klicka på Load (Ladda) i avsnittet Concentration (Koncentration) för att ladda värdet i vald brunn
eller valda brunnar.

c. (Valfritt:) Ladda en annan koncentration genom att ange det nya värdet i textrutan Concentration
(Koncentration) och trycka på Retur-tangenten.

d. Utför det här steget för alla brunnar med provtypen Standard.

Tips: Du laddar samma koncentration i alla Standard-brunnar genom att se till att <All>
(Alla) visas i listrutan under värdet för Concentration (Koncentration). Du laddar samma
koncentrationsvärde i alla brunnar med en viss fluorofor genom att klicka på listrutan och
välja fluoroforen.

11. Klicka på OK för att spara den nya plattan.
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Alternativ på högerklicksmenyn för verktyget Plate Editor (Plattredigerare)

I Tabell 9 listas menyalternativen som är tillgängliga i verktyget Plate Editor (Plattredigerare) när du
högerklickar på en brunn i verktyget. Den här menyn visas också i Spreadsheet View/Importer
(Kalkylbladsvy/importerare).

Alternativ Funktion

Copy (Kopiera) Hela kalkylbladet kopieras.

Copy as Image
(Kopiera som bild)

Kalkylbladet kopieras som en bildfil.

Print (Skriv ut) Kalkylbladet skrivs ut.

Print Selection (Skriv ut
markering)

Endast valda celler skrivs ut.

Export to Excel
(Exportera till Excel)

Filen exporteras till ett Excel-kalkylblad.

Export to CSV
(Exportera till CSV)

Filen exporteras som en .csv-fil.

Export to Xml
(Exportera till Xml)

Filen exporteras som en .xml-fil.

Export to Html
(Exportera till Html)

Filen exporteras som en .html-fil.

Find (Sök) Den specifika texten söks.

Sort (Sortera) Kalkylbladet sorteras genom att du väljer upp till tre kolumner i
fönstret Sort (Sortera).

Tabell 9. Alternativ på högerklicksmenyn för verktyget Spreadsheet View/Importer
(Kalkylbladsvy/Importerare) för plattor
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Tilldela valfria parametrar till plattfilen
En plattfil innehåller information om innehållet i varje brunn som är laddad med prov för en körning. Efter
körningen länkar CFX Maestro Dx SE brunnsinnehållet till de fluorescensdata som samlats in under
protokollet och tillämpar lämplig analys i fönstret Data Analysis (Dataanalys).

I CFX Maestro Dx SE kan du tilldela parametrar till varje brunn i din platta före, under eller till och med
efter det att du kör experiment. Du kan tilldela parametrarna till en befintlig plattfil eller till en ny plattfil.
Dessa parametrar omfattar:

n Target names (Målnamn) – målet eller målen som är av intresse (gener eller sekvenser) i varje
laddad brunn.

n Sample names (Provnamn) – identifieraren eller villkoret sommotsvarar provet i varje laddad brunn,
till exempel mouse1, mouse2 eller mouse3.

n Biological groups (Biologiska grupper) – identifieraren eller villkoret sommotsvarar en grupp
brunnar, till exempel 0Hr, 1Hr eller 2Hr.

Tips: Namn på mål, provnamn och biologiska grupper måste vara desammamellan brunnar för
att man ska kunna jämföra data på fliken Gene Expression (Genuttryck) i fönstret Data Analysis
(Dataanalys). Varje namn måste överensstämma när det gäller inledande stor bokstav,
interpunktion och mellanslag. Exempelvis är ”Actin” inte samma som ”actin”, ”2Hr” är inte
detsamma som ”2 hr” och ”Mouse 1” är inte samma sak som ”mouse1”. För att säkerställa
överensstämmelse mellan namnen, ange dem i avsnittet Libraries (Bibliotek) i User > User
Preferences > Plate (Användare > Användarinställningar > Platta), tillgängligt i hemfönstret.

n Technical replicates (Tekniska replikat) – varje brunn som används för att analysera samma
kombination av prov och mål; dvs. replikera qPCR-reaktioner.

n Dilution series (Spädningsserie) – mängden som krävs för att ändra koncentrationen av provtypen
Standard inom en replikatgrupp för att skapa standardkurvdata att analysera.

Tilldela ett mål till brunnar
Tips: Du kan tilldela sammamålnamn till en eller flera brunnar. Du kan även tilldela flera mål till
samma brunn.

Viktigt! Om du klickar på OK när du har tilldelat ett mål sparas ändringarna och Undo (Ångra)
avaktiveras i verktygsraden i Plate Editor (Plattredigerare). Var försiktig när du klickar på OK.

Så här tilldelar du ett mål till en brunn eller en grupp av brunnar

1. I Plate Editor (Plattredigerare), se till att brunnen eller gruppen av brunnar har tilldelats en provtyp.

Se Välja provtyper på sidan 133 för information om tilldelning av provtyper till brunnar.
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2. I plattrutan, välj brunnen eller gruppen av brunnar:

n För att välja en enstaka brunn, klicka på brunnen.

n För att välja flera angränsande brunnar, klicka på en brunn och dra till målbrunnen.

n För att välja flera ej angränsande brunnar, håll tangenten Ctrl nedtryckt och klicka på respektive
brunn.

n För att välja en hel kolumn med samma provtyp, klicka på kolumnnumret.

n Klicka på radnumret för att välja en hel rad.

3. I den högra rutan, välj ett namn i listrutan Target Name (Målnamn) för varje vald fluorofor.

4. Upprepa Steg 3 för varje brunn eller grupp av brunnar som du måste tilldela ett mål.

Tips: Du kan tilldela samma eller ett annat målnamn för varje vald fluorofor.

5. Klicka på OK för att acceptera ändringarna och spara plattan.

Obs! Om du ändrade plattan av misstag klickar du på Undo (Ångra) på verktygsraden i Plate
Editor (Plattredigerare) innan du klickar på OK för att acceptera ändringarna.

Så här tar du bort ett målnamn

u För att ta bort ett målnamn från den valda brunnen eller gruppen av brunnar, avmarkerar du dess
kryssruta Load (Ladda).

Viktigt! Om du tar bort ett målnamn från en brunn tas även den associerade fluoroforen bort.
Var försiktig när du tar bort ett målnamn från en brunn.

Så här lägger du till ett målnamn i listan

u För att lägga till ett målnamn i listrutan gör du något av följande:

n Skriv in ett namn i listrutan Target Name (Målnamn) och tryck på Retur.

Tips: Målnamn som du lägger till i en lista visas i alla andra mållistor.

n Klicka på den gröna symbolen + till höger om listrutan, skriv in ett namn för målet och tryck på
Retur.
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n Klicka på User Preferences (Användarinställningar) i verktygsraden och lägg till namnet i
biblioteket Target Names (Målnamn) på fliken Plate (Platta).

Viktigt! Målnamn som du lägger till i listrutan är endast tillgängliga för den aktuella plattan, och
endast om du tilldelar namnet till en brunn och sparar plattlayouten. Om du inte tilldelar namnet
till en brunn och sparar plattlayouten kommer namnet inte att sparas och det är inte tillgängligt
för framtida användning. För att lägga till ett målnamn permanent ska du även lägga till det i
biblioteket Target Names (Målnamn) med hjälp av dialogrutan User Preferences
(Användarinställningar). Namn som du lägger till i biblioteket är tillgängliga när du har öppnat
Plate Editor (Plattredigerare) igen. Se Ställa in standardplattparametrar på sidan 86 för mer
information.

Så här tar du bort ett målnamn från listan

1. Klicka på User Preferences (Användarinställningar) i verktygsraden.

Dialogrutan User Preferences (Användarinställningar) öppnas och visar fliken Plate (Platta).

2. Välj namnet du vill ta bort i biblioteket Target Names (Målnamn) på fliken Plate (Platta) och tryck på
tangenten Delete.

3. Klicka på OK för att spara ändringarna och stänga dialogrutan User Preferences
(Användarinställningar).

Viktigt! Du kan inte ta bort målnamn som du har sparat med en plattfil. Anpassade namn som
du lägger till i listrutan Target Names (Målnamn) och inte använder och sparar med plattan tas
automatiskt bort från listan. Namn som du tar bort från biblioteket Target Names (Målnamn) tas
bort permanent från programmet och är inte längre tillgängliga för användare. Var försiktig när
du tar bort målnamn.

Tilldela ett provnamn till brunnar
Obs! För att tilldela ett provnamn måste du tilldela de valda brunnarna minst en fluorofor. Om de
valda brunnarna inte tilldelats någon fluorofor, avaktiveras listrutan Sample Names (Provnamn). Se
Tilldela ett mål till brunnar på sidan 138 för information om tilldelning av fluoroforer.

Tips: Du kan endast tilldela ett provnamn till varje brunn eller grupp av brunnar.

Så här tilldelar du ett provnamn till en brunn eller en grupp av brunnar

1. I Plate Editor (Plattredigerare) säkerställer du att brunnen eller gruppen av brunnar har tilldelats en
fluorofor.

2. I plattrutan väljer du brunnen eller gruppen av brunnar.

3. I den högra rutan, välj ett namn i listrutan Sample Names (Provnamn).

Programvaran markerar automatiskt dess kryssruta Load (Ladda).
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4. Upprepa Steg 3 för varje brunn eller grupp av brunnar som du måste tilldela ett provnamn.

5. Klicka på OK för att acceptera ändringarna och spara plattan.

Obs! Om du ändrade plattan av misstag klickar du på Undo (Ångra) på verktygsraden i Plate
Editor (Plattredigerare) innan du klickar på OK för att acceptera ändringarna.

Så här tar du bort ett provnamn

u För att ta bort ett provnamn från en vald brunn eller grupp av brunnar avmarkerar du dess kryssruta
Load (Ladda).

Så här lägger du till ett provnamn i listan

u För att lägga till ett provnamn i listrutan gör du något av följande:

n Skriv in ett namn i listrutan Sample Names (Provnamn) och tryck på Retur.

n Klicka på den gröna symbolen + till höger om listrutan och skriv in ett namn för provet.

n Klicka på User Preferences (Användarinställningar) i verktygsraden och lägg till namnet i
biblioteket Sample Names (Provnamn) på fliken Plate (Platta).

Viktigt! Provnamn som du lägger till i listrutan är endast tillgängliga för den aktuella plattan, och
endast om du tilldelar namnet till en brunn och sparar plattlayouten. Om du inte tilldelar namnet
till en brunn och sparar plattlayouten kommer namnet inte att sparas och det är inte tillgängligt
för framtida användning. För att lägga till ett provnamn permanent ska du även lägga till det i
biblioteket Sample Names (Provnamn) med hjälp av dialogrutan User Preferences
(Användarinställningar). Namn som du lägger till i biblioteket är tillgängliga när du har öppnat
Plate Editor (Plattredigerare) igen. Se Ställa in standardplattparametrar på sidan 86 för mer
information.

Så här tar du bort ett provnamn från listan

1. Klicka på User Preferences (Användarinställningar) i verktygsraden.

Dialogrutan User Preferences (Användarinställningar) öppnas och visar fliken Plate (Platta)

2. Välj namnet du vill ta bort i biblioteket Sample Names (Provnamn) på fliken Plate (Platta) och tryck på
tangenten Delete.
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3. Klicka på OK för att spara ändringarna och stänga dialogrutan User Preferences
(Användarinställningar).

Viktigt! Du kan inte ta bort provnamn som du har sparat med en plattfil. Anpassade namn som
du lägger till i listan Sample Names (Provnamn) och inte använder och sparar med plattan tas
automatiskt bort från listrutan. Namn som du tar bort från biblioteket Sample Names (Provnamn)
tas bort från programmet och är inte längre tillgängliga för användare. Var försiktig när du tar bort
provnamn.

Tilldela biologiska grupper till brunnar
Obs! För att tilldela en biologisk grupp måste du tilldela minst en fluorofor till de valda brunnarna. När
du tilldelar en fluorofor aktiveras listrutan Biological Groups (Biologiska grupper). Se Tilldela ett mål
till brunnar på sidan 138 för information om tilldelning av fluoroforer.

Tips: Du kan tilldela en biologisk grupp till varje brunn eller grupp av brunnar.

Så här tilldelar du en biologisk grupp till en brunn eller grupp av brunnar

1. I Plate Editor (Plattredigerare) säkerställer du att brunnen eller gruppen av brunnar har tilldelats en
fluorofor.

2. I plattrutan väljer du brunnen eller gruppen av brunnar.

3. I den högra rutan gör du ett val i listrutan Biological Group (Biologisk grupp).

CFX Maestro Dx SE markerar automatiskt kryssrutan Load (Ladda).

4. Upprepa Steg 3 för varje brunn eller grupp av brunnar till vilken du måste tilldela en biologisk grupp.

5. Klicka på OK för att acceptera ändringarna och spara plattan.

Obs! Om du ändrade plattan av misstag klickar du på Undo (Ångra) på verktygsraden i Plate
Editor (Plattredigerare) innan du klickar på OK för att acceptera ändringarna.

Så här tar du bort en biologisk grupp

u Du tar bort en biologisk grupp från den valda brunnen eller gruppen av brunnar genom att avmarkera
dess kryssruta Load (Ladda).
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Så här lägger du till en biologisk grupp i listan

u Gör något av följande om du vill lägga till en biologisk grupp i listrutan:

n Skriv in ett namn i den nedrullningsbara listrutan Biological Group (Biologisk grupp) och tryck på
Retur.

n Klicka på den gröna +-symbolen till höger om listrutan och skriv in ett namn på den biologiska
gruppen.

n Klicka på User Preferences (Användarinställningar) i verktygsraden och lägg till namnet i
biblioteket för Biological Group Names (Namn på biologiska grupper) på fliken Plate (Platta).

Viktigt! Namn på biologiska grupper som läggs till i listrutan är endast tillgängliga för den
aktuella plattan, och endast om du tilldelar namnet till en brunn och sparar plattlayouten. Om du
inte tilldelar namnet till en brunn och sparar plattlayouten kommer namnet inte att sparas och det
är inte tillgängligt för framtida användning. För att lägga till namnet på en biologisk grupp
permanent ska det även läggas till i biblioteket för Biological Group Names (Namn på biologiska
grupper) via dialogrutan User Preferences (Användarinställningar). Namn som du lägger till i
biblioteket är tillgängliga när du har öppnat Plate Editor (Plattredigerare) igen. Se Ställa in
standardplattparametrar på sidan 86 för mer information.

Så här tar du bort namnet på en biologisk grupp från listan

1. Klicka på User Preferences (Användarinställningar) i verktygsraden.

Dialogrutan User Preferences (Användarinställningar) öppnas och visar fliken Plate (Platta)

2. I biblioteket för Biological Group Names (Namn på biologiska grupper) på fliken Plate (Platta) väljer
du namnet som ska tas bort och trycker på Delete-tangenten.

3. Klicka på OK för att spara ändringarna och stänga dialogrutan User Preferences
(Användarinställningar).

Viktigt! Det går inte att ta bort namnen på biologiska grupper som du har sparat med en plattfil.
Anpassade namn som läggs till i listrutan Biological Group Names (Namn på biologiska
grupper), men som inte används och sparas med plattan tas automatiskt bort från listan. Namn
som tas bort från biblioteket för Biological Group Names (Namn på biologiska grupper) tas bort
permanent från programvaran och är inte längre tillgängliga för användare. Var försiktig när du
tar bort biologiska namn.

Så här visar du alla biologiska grupper på plattan

u Klicka på Show Biological Groups (Visa biologiska grupper) för att visa alla biologiska grupper på
plattan.
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Alla grupper identifieras av en specifik färg och knappen Show Biological Groups (Visa biologiska
grupper) ändras till Hide Biological Groups (Dölj biologiska grupper).

Klicka på Hide Biological Groups (Dölj biologiska grupper) för att rensa färgen i brunnarna. Eller
klicka på valfri brunn i plattan för att dölja de biologiska grupperna.

Tilldela tekniska replikatnummer till brunnar
Viktigt! För att tilldela tekniska replikatnummer måste de valda brunnarna ha ett identiskt innehåll.
Det vill säga att de valda brunnarna måste ha samma provtyp och fluorofor. Om det är tillämpligt
måste de även vara tilldelade sammamål- och provnamn och samma biologiska grupp. Om de inte
är identiska aktiverar inte CFX Maestro Dx SE detta alternativ.

Så här tilldelar du tekniska replikatnummer till en grupp brunnar

1. I Plate Editor (Plattredigerare), se till att innehållet i gruppen av brunnar är identiskt.

2. Välj målgruppen av brunnar i plattrutan.

3. För att tilldela samma replikatnummer till alla valda brunnar skriver du in replikatnumret i rutan i
sektionen Replicate # (Replikatnummer) till höger och väljer Load (Ladda).

4. (Valfritt) Så här tillämpar du en replikatserie på en uppsättning valda brunnar:
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a. Klicka på Technical Replicates (Tekniska repliker). Sektionen Replicate # (Replikatnummer)
ändras så att den visar följande alternativ:

n Replicate size (Replikatstorlek) – ett nummer som representerar antalet brunnar i varje
grupp av replikat

n Starting replicate # (Startreplikatnummer) – det första numret i replikatserien för den valda
gruppen av replikat

Obs! Som standard visar CFX Maestro Dx SE startreplikatnumret som ett nummer större
än det sista tekniska replikatnumret som tilldelats i plattan. Om till exempel det sista
tekniska replikatnumret i plattan är fem, så är nästa startnummer sex. Du kan ändra
startnumret till vilket nummer som helst som inte redan är tilldelat.

n Laddningsriktning (Horizontal (Horisontell) eller Vertical (Vertikal))

b. Klicka på Apply (Använd) för att tillämpa parametrarna på serien och återgå till visningen av
Replicate # (Replikatnummer).

5. Klicka på OK för att acceptera ändringarna och spara plattan.

Obs! Om du ändrade plattan av misstag klickar du på Undo (Ångra) på verktygsraden i Plate
Editor (Plattredigerare) innan du klickar på OK för att acceptera ändringarna.

Så här tar du bort en brunn från en replikatserie

u Välj brunnen eller gruppen av brunnar som ska tas bort och avmarkera kryssrutan Replicate # Load
(Replikatnummerladdning).

Alternativt kan du klicka på Clear Replicate # (Rensa replikatnummer) för att rensa replikatnumret
från en vald brunn eller grupp av brunnar.

Så här visar du alla tekniska replikat på plattan

u Klicka på Show Technical Replicates (Visa tekniska replikat) för att visa alla tekniska replikat på
plattan.

Varje grupp identifieras med en specifik färg och knappen Show Technical Replicates (Visa tekniska
replikat) ändras till Hide Technical Replicates (Dölj tekniska replikat).
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Klicka på Hide Technical Replicates (Dölj tekniska replikat) för att rensa färgen i brunnarna.
Alternativt kan du klicka på valfri brunn i plattan för att dölja tekniska replikat.

Tilldela en spädningsserie till standardprovtyper
Som tidigare nämnts måste alla brunnar med provtypen Standard tilldelas ett koncentrationsvärde. Du
kan tilldela en spädningsserie till flera brunnar med provtypen Standard.

Obs! För att tilldela en spädningsserie till en grupp av brunnar måste brunnarna vara inkluderade i en
teknisk replikatserie. Se Tilldela tekniska replikatnummer till brunnar på sidan 144 för information om
tilldelning av brunnar i replikatserier.

Så här tilldelar du en spädningsserie till en grupp provbrunnar av typen Standard

1. Kontrollera att följande villkor är uppfyllda i Plate Editor (Plattredigerare):

n Provtypen för brunnsgruppen är Standard.

n Alla brunnar i gruppen tilldelas minst en fluorofor och alla brunnar innehåller samma fluoroforer.

n Alla brunnar i gruppen inkluderas i samma tekniska replikatserie.

Obs! CFX Maestro Dx SE aktiverar alternativet Dilution Series (Spädningsserie) först när
alla valda brunnar uppfyller dessa kriterier.

2. Välj målgruppen av brunnar i plattrutan.

3. Klicka på Dilution Series i sektionen Concentration (Koncentration) i den högra rutan. Sektionen
Concentration (Koncentration) ändras så att den visar följande alternativ:

n Starting concentration (Startkoncentration) – koncentrationsvärdet från vilket serien utgår

n Replicates from and to (Replikat från och till) – replikat i serien på vilka spädningsfaktorn
kommer att tillämpas

n Dilution factor (Spädningsfaktor) – mängden för ändring av koncentrationen inom varje
replikatgrupp
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4. Ange värden för alternativen eller använd standardvärden.

5. Spädningsserien minskar som standard med spädningsfaktorn. Välj Increasing (Ökande) för att öka
spädningsserien.

6. (Tillval) Spädningsfaktorn tillämpas som standard på alla fluoroforer i replikatserien. Om serien
innehåller fler än en fluorofor och du vill använda spädningen på en enskild fluorofor väljer du den i
listrutan.

7. Klicka på Apply (Använd) för att tillämpa spädningsserien på brunnsgruppen och återgå till vyn
Concentration (Koncentration).

8. Klicka på OK för att acceptera ändringarna och spara plattan.

Kopiera innehåll i en brunn till en annan brunn
Du kan kopiera innehållet i en brunn och klistra in det i en eller flera brunnar. Du kan dock kopiera
innehållet i endast en brunn. Du kan inte välja flera brunnar och kopiera deras innehåll.

Så här kopierar du innehåll i en brunn till en annan brunn

1. Välj brunnen som ska kopieras i plattrutan.

2. Högerklicka på brunnen och välj Copy Well (Kopiera brunn).

3. Välj brunnen eller brunnarna där innehållet ska klistras in:

n För att välja en enstaka brunn, klicka på brunnen.

n För att välja flera angränsande brunnar, klicka på en brunn och dra till målbrunnen.

n För att välja flera ej angränsande brunnar, håll tangenten Ctrl nedtryckt och klicka på respektive
brunn.

4. Se till att målbrunnarna är markerade, högerklicka och välj Paste Well (Klistra in brunn).

CFX Maestro Dx SE klistrar in den första brunnens innehåll i de markerade brunnarna.

Lägga till en kommentar till en brunn
Du kan lägga till en beskrivande kommentar till en brunn. Du kan se anteckningarna för brunnar på fliken
Quantification (Kvantifiering) i fönstret Data Analysis (Dataanalys).

Så här lägger du till en kommentar till en brunn

1. Gå till plattrutan och välj brunnen eller brunnarna där en kommentar ska läggas till.

2. Välj Well Note (Brunnskommentar) i sektionen View (Visa) i den undre rutan.

Området Well Note (Brunnskommentar) visas i den högra rutan.
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3. Skriv in innehållet för kommentar i textrutan och tryck på Retur.

Texten visas längst ned i de valda brunnarna.

Tips: Om du tidigare skapade en kommentar för en brunn kan du välja den i listrutan och
använda den för valda brunnar.

Rensa brunnar på allt innehåll
Du kan rensa en enskild brunn, en grupp av brunnar eller allt innehåll från en platta. Rensning av brunnar
innebär inte att fluorecensdata som har samlats in under plattläsningen tas bort.

Viktigt! Om du rensar en brunn försvinner dess innehåll permanent. Om du klickar på OK och sparar
plattan efter att ha rensat en brunn kan du inte ångra rensningen. Var försiktig när du rensar brunnar.

Så här rensar du alla brunnsinställningar

1. I Plate Editor (Plattredigerare) väljer du brunnen eller gruppen av brunnar i plattrutan:

n För att välja en enstaka brunn, klicka på brunnen.

n För att välja flera angränsande brunnar, klicka på en brunn och dra till målbrunnen.

n För att välja flera ej angränsande brunnar, håll tangenten Ctrl nedtryckt och klicka på respektive
brunn.

n För att välja en hel kolumn med samma provtyp, klicka på kolumnnumret.

n Klicka på radnumret för att välja en hel rad.

2. Klicka på Clear Wells (Rensa brunnar) i den högra rutan.

CFX Maestro Dx SE rensar alla inställningar för valda brunnar.

3. Gör något av följande:

n Om du tog bort brunnarna av misstag klickar du på Undo (Ångra) på verktygsraden i Plate Editor
(Plattredigerare) innan du klickar på OK för att acceptera ändringarna.

Viktigt! Om du klickar på OK innan du klickar på Undo (Ångra) sparas ändringarna och
Undo (Ångra) avaktiveras i verktygsraden i Plate Editor (Plattredigerare).

n Klicka på OK för att acceptera ändringarna och spara plattan.
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Ändra Experiment Settings (Experimentinställningar)
Använd dialogrutan Experiment Settings (Experimentinställningar) för att visa eller ändra listan över mål,
prover eller biologiska grupper, eller för att ange provgrupp för genuttrycksanalys att analysera om du har
tilldelat biologiska grupper till brunnar i plattan.

I dialogrutan Experiment Settings (Experimentinställningar) visar fliken Targets (Mål) en lista med
målnamn för varje PCR-reaktion, till exempel målgenen eller gensekvenser av intresse.

På fliken Samples and Biological Groups (Prover och biologiska grupper) visas en lista med namn på
prover och biologiska grupper som anger målets källa, till exempel ett prov som tagits efter en timme (1Hr)
eller från en specifik individ (mouse1).

Så här ändrar du plattinställningar med dialogrutan Experiment Settings
(Experimentinställningar)

1. Gör något av följande för att öppna dialogrutan Experiment Settings (Experimentinställningar):

n Klicka på Experiment Settings (Experimentinställningar) i den högra rutan i Plate Editor
(Plattredigerare).

n Klicka på Experiment Settings (Experimentinställningar) på fliken Gene Expression (Genuttryck)
i fönstret Data Analysis (Dataanalys).

Dialogrutan Experiment Settings (Experimentinställningar) visas med fliken Targets (Mål).

2. För att lägga till ett nytt mål, prov eller en biologisk grupp går du till respektive flik och skriver ett namn
i textrutan New (Ny) och klickar på Add (Lägg till).
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3. För att ta bort ett eller flera namn för mål, prov eller biologisk grupp från listan går du till respektive flik
och markerar objektets kryssruta i kolumnen Select to Remove (Markera för att ta bort) och klickar på
Remove checked
item(s) (Ta bort markerade objekt).

4. CFX Maestro Dx SE exkluderar provtypen NTC (no template control, ingen templatkontroll) från
analys av genuttryck.

För att inkludera NTC-provtyper avmarkerar du motsvarande kryssruta i sektionen Exclude the
following sample types (Uteslut följande provtyper). Du kan utesluta följande provtyper genom att
markera motsvarande kryssruta:

n NRT (no reverse transcriptase, inget omvänt transkriptas)

n Negative Control (Negativ kontroll)

n Positive Control (Positiv kontroll)

n Standard

5. På fliken Targets (Mål):

a. För att välja ett mål som referens för dataanalys av genuttryck väljer du det i kolumnen
Reference (Referens).

b. Rensa Show Analysis Settings (Visa analysinställningar) om du vill dölja analysinställningar som
ska tillämpas på fliken Gene Expression (Genuttryck) i fönstret Analysis Settings
(Analysinställningar).

Programvaran döljer följande kolumner:

n Color (Färg)

n Show Chart (Visa tabell)

n Auto Efficiency (Automatisk effektivitet)

n Effektivitet (%)

c. För att ändra färgen på målet så som det visas i diagrammet Gene Expression (Genuttryck)
väljer du en ny färg i dialogrutan Color (Färg) som visas och klickar på OK.

d. För att visa målet i vald färg i diagrammet Gene Expression (Genuttryck) markerar du
motsvarande kryssruta i kolumnen Show Chart (Visa diagram).

e. Som standard beräknar CFX Maestro Dx SE automatiskt den relativa effektiviteten för ett mål
om dess data inkluderar en standardkurva.

För att använda ett tidigare fastställt effektivitetsvärde skriver du in värdet i motsvarande cell i
kolumnen Efficiency (%) (Effektivitet) och trycker på Retur. CFX Maestro Dx SE avmarkerar
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kryssrutan Auto Efficiency (Automatisk effektivitet).

6. På fliken Samples and Biological Groups (Prover och biologiska grupper):

a. För att välja ett prov eller en biologisk grupp som kontrollprov för dataanalys av genuttryck
markerar du motsvarande kryssruta i kolumnen Control (Kontroll).

b. För att tilldela kontrollvillkoret till ett prov eller en biologisk grupp för en körning markerar du
motsvarande kryssruta i kolumnen Control (Kontroll).

c. Om det här alternativet inte redan är valt klickar du på Show Analysis Settings (Visa
analysinställningar) för att visa eller ändra analysparametrar som ska tillämpas på fliken Gene
Expression (Genuttryck). Programvaran döljer kolumnerna Color (Färg) och Show Chart (Visa
diagram).

7. Klicka på OK för att spara parametrarna i dialogrutan Experiment Settings (Experimentinställningar)
och återgå till fönstret Plate Editor (Plattredigerare).
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Skapa brunnsgrupper
Brunnsgrupper delar upp en enskild platta i undergrupper av brunnar som kan analyseras separat i
fönstret Data Analysis (Dataanalys). När du har konfigurerat brunnsgrupper, välj en av dem i fönstret Data
Analysis (Dataanalys) för att analysera uppgifterna som fristående grupp. Du kan till exempel konfigurera
brunnsgrupper för att analysera flera experimentkörningar i en platta eller analysera varje brunnsgrupp
med en egen standardkurva.

Obs! Standardbrunnsgruppen är All Wells (Alla brunnar).

Så här skapar du brunnsgrupper

1. Gör något av följande för att öppnaWell Groups Manager (Brunnsgruppshanterare):

n Klicka påWell Groups (Brunnsgrupper) i verktygsraden Plate Editor (Plattredigerare).

n Klicka på ManageWell Groups (Hantera brunnsgrupper) i fönstret Data Analysis (Dataanalys).

Dialogrutan Well Groups Manager (Brunnsgruppshanterare) visas.

2. Klicka på Add (Lägg till) för att skapa en ny grupp. Den nedrullningsbara menyn visar gruppnamnet
som Group 1 (Grupp 1) för den första gruppen.

3. Välj brunnar för brunnsgruppen i plattvyn genom att klicka dra över brunnsgruppen. Valda brunnar
visas i blått i Hanteraren.

152 | CFX Maestro Dx SE programvara



Skapa brunnsgrupper

4. (Valfritt) För att ändra namnet på gruppen väljer du dess namn i den nedrullningsbara menyn och
skriver in ett nytt namn.

5. (Valfritt) För att ta bort en brunnsgrupp väljer du dess namn i listrutan och klickar på Delete (Ta bort).

6. Klicka på OK för att avsluta och stänga fönstret, eller klicka på Cancel (Avbryt) för att stänga fönstret
utan ändringar.

Alternativ på högerklicksmenyn i dialogrutan Well Groups Manager
(Brunnsgruppshanterare)

I Tabell 10 listas menyalternativen som är tillgängliga i dialogrutan Well Groups Manager
(Brunnsgruppshanterare) när du högerklickar på en brunn.

Alternativ Funktion

Copy (Kopiera) Brunnsinnehållen kopieras och sedan kan de klistras in i
en annan brunn eller brunnar.

Copy as Image (Kopiera som
bild)

Kopierar vyn för brunnsväljare som en bild.

Print (Skriv ut) Skriver ut vyn för brunnsväljare.

Print Selection (Skriv ut
markering)

Endast valda celler skrivs ut.

Export to Excel (Exportera till
Excel)

Exporterar data till ett Excel-kalkylblad.

Export to CSV (Exportera till
CSV)

Exporterar data som ett kommaseparerat dokument.

Export to Xml (Exportera till
Xml)

Exporterar data som ett .xml-dokument.

Export to Html (Exportera till
Html)

Exporterar datan som ett .html-dokument.

Tabell 10. Alternativ på högerklicksmenyn i dialogrutan Plate Editor Well Groups
Manager (Brunnsgruppshanterare för plattredigerare)
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Ändra kurvutseenden
Du kan ändra färg och utseende på amplifieringskurvorna under plattinställning och under en körning. Du
kan sedan enkelt se kurvorna i realtidsstatusfönstret när data hämtas in.

Så här ändrar du kurvutseenden

1. Klicka på Trace Styles (Kurvutseenden) i verktygsraden Plate Editor (Plattredigerare).

Dialogrutan Trace Styles (Kurvutseenden) för den öppna plattan visas, till exempel:

2. För att visa kurvutseenden per specifik fluorofor väljer du den i listrutan Fluorophores (Fluoroforer).

3. Så här ändrar du kurvvisningen:

a. Välj kurvtyp i listrutan Wells (Brunnar).

b. Klicka på dess färg i kolumnen Color (Färg).

c. Välj en annan färg för kurvan i dialogrutan Color (Färg) som visas och klicka på OK.

CFX Maestro Dx SE visar färgförändringen för brunnstypen i rutnätet.

d. (Valfritt) Välj en symbol för kurvan i listrutan Symbols (Symboler).

4. För att snabbt ändra färguppsättning klickar du på önskat alternativ i sektionen Color Quick Set
(Snabbfärginställning).

5. Välj önskad etikettyp i sektionen Well Labels (Brunnsetiketter) för att visa brunnsetiketter i rutnätet.

6. Klicka på OK för att spara ändringarna eller på Cancel (Avbryt) om du inte vill spara ändringarna.
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Visa, exportera och importera plattan i kalkylbladsformat
Verktyget Spreadsheet View/Importer (Kalkylbladsvy/Importerare) visar innehållet i en platta i
kalkylbladsformat. Visningsverktyget ger möjlighet att visa, importera och exportera brunnsdata enligt
beskrivningen nedan.

Använda kalkylbladsvyn för att exportera och importera plattdata

Från kalkylbladsvyn kan du exportera Target Name (målnamn), Sample Name (provnamn), Biological
Group Name (namn på biologisk grupp) och Well Notes (anteckningar om brunnar) som en mall i ett
tabbavgränsat format till ett program somMicrosoft Excel. Du kan också importera dessa data från en
tabbavgränsad applikation till en fördefinierad platta från en experimentinformationsfil.

Så här använder du verktyget Spreadsheet View/Importer (Kalkylbladsvy/Importerare)

1. Skapa och spara en plattfil (se Skapa en plattfil med Plate Editor (Plattredigerare) ).

2. I verktygsfältet i Plate Editor (Plattredigerare) klickar du på Spreadsheet View/Importer
(Kalkylbladsvy/Importerare) för att öppna dialogrutan Plate Spreadsheet View (Kalkylbladsvy för
platta).

3. (Valfritt) Klicka på rutorna Show Biological Set Name (Visa namn på biologisk uppsättning) och Show
Well Note (Visa brunnsanteckning) för att visa dessa kolumner i kalkylbladsvyn och i den exporterade
filen.

4. Klicka på knappen Export Template (Exportera mall) för att skapa en tommall i en Excel-fil (.csv-
format). Den exporterade filen visar samma layout som din platta.

Tips: Använd plattfilens namn när du sparar dina plattfiler för att enkelt identifiera filen.
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5. Fyll Excel-filens celler med ditt brunnsinnehåll.

Obs! Du kan bara redigera innehållet i en cell i en kolumn som har en asterisk (*) bredvid
kolumnnamnet (*Target Name (Målnamn), *Sample Name (Provnamn), *Biological Group Name
(Namn på biologisk grupp), *Well Note (Brunnsanteckning).

Obs! Du kan inte lägga till värden i kolumnerna Standard Curve (Standardkurva) och Quantity
Curve (Kvantitetskurva) i den exporterade Excel-filen. För att ändra dessa data kan du gå
tillbaka till Plate Editor (Plattredigeraren) och välja Settings > Units (Inställningar > Enheter) i
menyraden. När plattkörningen är klar visas data från dessa standarder i diagrammet Standard
Curve (Standardkurva) på fliken Quantification (Kvantifiering) i fönstret Data Analysis
(Dataanalys) med enheterna du väljer.

6. Importera den ifyllda Excel-filen till Plate Editor (Plattredigeraren) genom att klicka på knappen
Import (Importera). Importerade plattdata visas i fönstret Plate Spreadsheet View (Kalkylbladsvy över
platta).

Viktigt! Om du har flera fluoroforer måste du utföra steg 3–5 för varje fluorofor med hjälp av
rullgardinsmenyn Flours List (Fluoroforlista) i Plate Spreadsheet View (Kalkylbladsvy över
platta).

7. Klicka på OK. De nya plattdata visas nu i fönstret Plate Editor (Plattredigerare).

Tips: Du ser de tillgängliga menyalternativen i verktyget Spreadsheet View/Importer
(Kalkylbladsvy/Importerare) när du högerklickar på en brunn i verktyget eller på något tabellhuvud i
kalkylbladsvyn över plattan.
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Skapa en plattlayout med användning av Setup Wizard
(Inställningsguide) för plattor

Du kan använda Setup Wizard (Inställningsguide) för att ange plattlayoutinformationen som behövs för
analys av normaliserat genuttryck, inklusive:

n Målnamn

n Provnamn

n Placering av mål och prover på plattan

n Referensgen(er)

n Kontrollprov

Setup Wizard (Inställningsguide) kan användas före, under och efter en körning.

Använda Setup Wizard (Inställningsguide) för plattor
I det här avsnittet beskrivs hur du skapar en plattlayout i Setup Wizard (Inställningsguide). För att lättare
se innehållet i varje brunn i plattan klickar du på Zoom plate (Zooma in platta) högst upp i Setup Wizard
(Inställningsguide).

Viktigt! Om du återgår till fliken Auto layout (Automatisk layout) från en annan flik i Setup Wizard
(Inställningsguide) återställs plattlayouten. Var försiktig när du väljer den fliken.

Tips: Du återställer layouten genom att välja Tools > Clear Plate (Verktyg > Rensa platta) i Setup
Wizard (Inställningsguide).

Så här använder du Setup Wizard (Inställningsguide) för plattor

1. Öppna Plate Editor (Plattredigerare).

2. Gör något av följande för att öppna inställningsguiden:

n Välj Editing Tools > Setup Wizard (Redigeringsverktyg > Inställningsguide).

n Klicka på Setup Wizard (Inställningsguide) i verktygsraden för Plate Editor (Plattredigerare).

Setup Wizard (Inställningsguide) visas med fliken Auto layout (Automatisk layout).
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3. Gör följande på fliken Auto layout (Automatisk layout):

a. Klicka på en brunn i rutnätet och dra den över och ned för att ange området på plattan där du
planerar att ladda provet.

b. Ange antalet mål och prover som ska laddas.

Tips: Antalet mål och prover måste motsvara antalet valda celler. Om inte de angivna
antalen passar i det valda området ändrar du antalen eller plattvalsområdet. Orienteringen
av objekten på plattan och deras gruppering kan specificeras.

c. (Valfritt:) Ändra plattorienteringen. Du kan till exempel ställa in mål i kolumner och prover i rader,
eller gruppera efter prover.

d. Klicka på Next (Nästa) för att gå vidare till fliken Target names (Målnamn).

Obs! Om inte plattlayouten har ett vanligt mönster placerar du målen manuellt på fliken Target
names (Målnamn) eller placerar proverna manuellt på fliken Sample names (Provnamn) på
plattan. Klicka och dra för att välja flera brunnar.

4. På fliken Target names (Målnamn) anger du namnen på målgrupperna:

a. Gör något av följande:

n Ställ in Select by (Välj efter) på Target (Mål) för att byta namn på målen efter grupp.

n Ställ in Select by (Välj efter) på Well (Brunn) för att byta namn på målen efter brunn.

b. Välj en målgrupp eller -brunn i rutnätet och ange ett namn i listrutan Target name (Målnamn).
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Tips: Tryck på Tabb för att välja nästa grupp eller brunn till höger, eller på Retur för att välja
nästa grupp eller brunn nedanför. Eller håll ned Ctrl-tangenten (på flikarna Target name
(Målnamn) och Sample name (Provnamn)) och klicka på en brunn i taget för att välja flera
brunnar som inte ligger intill varandra.

c. Klicka på Next (Nästa) för att gå vidare till fliken Sample names (Provnamn).

5. Definiera provnamnen för provgrupperna på fliken Sample names (Provnamn).

6. Klicka på Next (Nästa) för att gå vidare till fliken Reference targets (Referensmål).

7. På fliken Reference targets (Referensmål) väljer du ett eller flera mål som ska användas som
referenser för normaliserat genuttryck och klickar på Next (Nästa) för att gå vidare till fliken Control
sample (Kontrollprov).

8. På fliken Control sample (Kontrollprov) väljer du ett prov som ska användas som en kontroll för
beräkningar av relativa genuttryck.

9. Klicka på OK för att spara plattlayouten och återgå till Plate Editor (Plattredigerare) där du kan
definiera plattparametrarna ytterligare. Mer information finns i Tilldela valfria parametrar till plattfilen
på sidan 138.

Eller klicka på Previous (Föregående) för att återgå till en föregående flik och göra ändringar.

Obs! Om du återgår till fliken Auto layout (Automatisk layout) återställs plattlayouten
automatiskt. Var försiktig när du klickar på Previous (Föregående).
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Kapitel 9 Köra experiment
Det här kapitlet förklarar hur du kör anpassade (användardefinierade) eller PrimePCR-analysexperiment
med CFX Maestro Dx programvara, Security Edition.

En körningsdatafil innehåller protokoll- och plattinformation för körningen. Filen innehåller också data från
analyserna som CFX Maestro Dx SE utför efter avslutad körning.

Med CFX Maestro Dx SE är det enkelt att konfigurera och köra användardefinierade eller PrimePCR-
baserade experiment. Fönstret Run Setup (Inställning av körning) vägleder dig genom gemensamma
steg för konfiguration av experiment och vidarebefordrar dig till dialogrutan Start Run (Starta körning) där
du påbörjar körningen.
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Fönstret Run Setup (Körningsinställning)
Fönstret Run Setup (Körningsinställning) ger snabb åtkomst till filerna och inställningarna som behövs för
att konfigurera och köra ett experiment. När du väljer att köra ett användardefinierat experiment öppnas
fönstret Run Setup (Körningsinställning) med fliken Protocol (Protokoll). När du väljer att köra ett
PrimePCR-experiment öppnas fönstret Run Setup (Körningsinställning) med fliken Start run (Starta
körning).

Tips: Information om PrimePCR finns i Utföra PrimePCR-experiment på sidan 179 och information
om fliken Start Run (Starta körning) finns i Fliken Start Run (Starta körning) på sidan 169.
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1. Följande flikar vägleder dig genom konfigurationen och körningen av ett experiment:

n Fliken Protocol (Protokoll) – välj ett befintligt protokoll att köra eller redigera, eller
skapa ett nytt protokoll i Protocol Editor (Protokollredigerare).

n Fliken Plate (Platta) – välj en befintlig platta att köra eller redigera, eller skapa en
ny platta i Plate Editor (Plattredigerare).

n Fliken Start Run (Starta körning) – visa experimentinställningarna, välj ett eller fler
instrumentblock och starta körningen.

2. Huvudfönstret visar alternativen för varje flik när du använder dem.

3. Navigeringsknappar som leder till fliken Start Run (Starta körning).

FÖRKLARING

Öppna fönstret Run Setup (Körningsinställning)
Så här öppnar du fönstret Run Setup (Körningsinställning)

u Gör något av följande:

n På fliken Run Setup (Körningsinställning) i Startup Wizard (Startguide) klickar du antingen på
User-defined (Användardefinierad) eller PrimePCR.

n I hemfönstret klickar du antingen på User-defined Run Setup (Användardefinierad
körningsinställning) eller PrimePCR Run Setup (PrimePCR-körningsinställning) i verktygsraden.

n I hemfönstret väljer du antingen Run > User-defined Run (Körning > Användardefinierad
körning) eller Run > PrimePCR Run (Körning > PrimePCR-körning).
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Fliken Protocol (Protokoll)
På fliken Protocol (Protokoll) visas en förhandsgranskning av protokollfilen som du planerar att köra. En
protokollfil innehåller instruktioner för instrumentets temperatursteg och instrumentalternativ som styr
ramphastigheten, provvolymen och lockets temperatur.

Som standard visar programvaran det protokoll som har definierats i avsnittet File Selection for Run Setup
(Filval för körningsinställningar) på fliken Files i dialogrutan User > User Preferences (Användare >
Användarinställningar). Du ändrar standardprotokollet i dialogrutan User Preferences
(Användarinställningar). Se Ändra standardfilinställningarna på sidan 83 för mer information.

På fliken Protocol (Protokoll) kan du

n skapa ett nytt protokoll att köra

n välja ett befintligt protokoll att köra eller redigera.

Mer information om att skapa och ändra protokoll finns i Kapitel 7, Skapa protokoll.

Så här skapar du ett nytt protokoll

1. Klicka på Create New (Skapa ny) på fliken Protocol (Protokoll).

Protocol Editor (Protokollredigerare) öppnas.

2. Skapa ett nytt protokoll i Protocol Editor (Protokollredigerare).
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3. Klicka på OK för att spara protokollet och återgå till fliken Protocol (Protokoll) i Run Setup
(Körningsinställning).

4. Visa information om protokollet och gör något av följande:

n Om informationen är korrekt klickar du på Next (Nästa) för att gå vidare till fliken Plate (Platta).

n Om informationen är felaktig klickar du på Edit Selected (Redigera valda) för att återgå till
fönstret Protocol Editor (Protokollredigerare). Revidera protokollet, spara ändringarna och klicka
på Next (Nästa) på fliken Protocol (Protokoll) för att gå vidare till fliken Plate (Platta).

Så här väljer du ett befintligt protokoll

1. Gör något av följande på fliken Protocol (Protokoll):

n Klicka på Select Existing (Välj befintlig) och gå till ett befintligt protokoll.

n Klicka på Express Load (Expressladdning) och välj ett protokoll i listrutan för protokoll.

Tips: Du kan lägga till protokoll i och ta bort dem från listrutan Express Load
(Expressladdning). Mer information finns i Lägga till och ta bort protokoll för
expressladdning som följer.

2. Visa information om protokollet och gör något av följande:

n Om informationen är korrekt klickar du på Next (Nästa) för att gå vidare till fliken Plate (Platta).

n Om informationen är felaktig klickar du på Edit Selected (Redigera valda) för att öppna Protocol
Editor (Protokollredigerare). Revidera protokollet, spara ändringarna och klicka på Next (Nästa)
på fliken Protocol (Protokoll) för att gå vidare till fliken Plate (Platta).

Lägga till och ta bort protokoll för expressladdning

Du kan ändra innehållet i listrutan Express Load (Expressladdning) som finns i Protocol Editor
(Protokollredigerare). Protokollen i den här listan sparas i följande mapp:

c:\Users\Public\Public Documents\Bio-Rad\CFX_MDx\Users\<användarnamn>\ExpressLoad\

Så här ändrar du listan Express Load (Expressladdning) med protokoll

1. Gå till och öppna mappen Express Load (Expressladdning).

2. Granska protokollfilerna (.pcrl) i mappen.

3. Gör något av följande:

n Radera protokoll från mappen för att ta bort dem från listrutan.

n Kopiera protokoll till mappen för att lägga till dem i listrutan.
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Fliken Plate (Platta)
Obs! Om protokollet som väljs på fliken Protocol (Protokoll) inte har ett plattläsningssteg för realtids-
PCR-analys är fliken Plate (Platta) dold. Lägg till minst en plattläsning i protokollet för att visa fliken
Plate (Platta).

Fliken Plate (Platta) ger en förhandsvisning av plattfilen som du planerar att läsa in. I en PCR-körning i
realtid innehåller plattfilen en beskrivning av innehållet i varje brunn inklusive dess fluoroforer,
skanningsläge och plattyp. CFX Maestro Dx SE använder dessa beskrivningar för datainsamling och
analys.

Som standard visar programvaran plattan som är definierad i sektionen File Selection för Run Setup
(Filval för analysinställning) på fliken Files (Filer) i dialogrutan User > User Preferences (Användare >
Användarinställningar). Du kan ändra standardplatta i dialogrutan User Preferences
(Användarinställningar). Se Ändra standardfilinställningarna på sidan 83 för mer information.

På fliken Plate (Platta) kan du

n skapa en ny platta att ladda

n välja en befintlig platta att ladda eller redigera.

Se Kapitel 8, Förbereda plattor för mer information om hur du skapar och ändrar plattor.
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Så här skapar du en ny platta

1. Klicka på Create New (Skapa ny) på fliken Plate (Platta).

Plate Editor (Plattredigeraren) visas.

2. Använd Plate Editor (Plattredigerare) för att skapa en ny platta

3. Klicka på OK för att spara plattan och återgå till fliken Plate (Platta) i Run Setup (Körinställning).

4. Visa information för plattan och gör något av följande:

n Om informationen är korrekt klickar du på Next (Nästa) för att fortsätta till fliken Start Run (Starta
körning).

n Om informationen är felaktig klickar du på Edit Selected (Redigera valt) för att återgå till Plate
Editor (Plattredigerare). Granska plattfilen, spara ändringarna och klicka sedan på Next (Nästa)
på fliken Plate (Platta) för att fortsätta till fliken Start Run (Starta körning).

Så här väljer du en befintlig plattfil

1. Gör något av följande på fliken Plate (Platta):

n Klicka på Select Existing (Välj befintlig) och gå till en befintlig plattfil.

n Klicka på Express Load (Expressladdning) och välj en plattfil i listrutan.

Tips: Du kan lägga till plattor till eller ta bort dem från listrutan Express Load
(Expressladdning). Se Lägga till och ta bort plattfiler för expressladdning nedan för mer
information.

2. Visa information för plattan och gör något av följande:

n Om informationen är korrekt klickar du på Next (Nästa) för att fortsätta till fliken Start Run (Starta
körning).

n Om informationen är felaktig klickar du på Edit Selected (Redigera valt) för att öppna fönstret Plate
Editor (Plattredigerare). Granska plattfilen, spara ändringarna och klicka sedan på Next (Nästa) för
att fortsätta till fliken Start Run (Starta körning).

Lägga till och ta bort plattfiler för expressladdning

Du kan ändra innehållet i listrutan Express Load (Expressladdning) som finns i Plate Editor
(Plattredigerare). Plattorna som finns i den här listan sparas i följande mapp:

c:\Users\Public\Documents\Bio-Rad\CFX_MDx\Users\<användarnamn>\ExpressLoad\

Så här ändrar du listan Express Load (Expressladdning) med plattfiler

1. Gå till och öppna mappen Express Load (Expressladdning).

2. Granska plattfilerna (.pltd) i mappen.
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3. Gör något av följande:

n Radera plattfiler från mappen för att ta bort dem från listrutan.

n Kopiera plattfiler till mappen för att lägga till dem i listrutan.
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Fliken Start Run (Starta körning)
På fliken Start Run (Starta körning) visas information om experimentet som ska köras. Där visas också
det eller de anslutna instrumentblocken som du kan köra experimentet på.

På fliken Start Run (Starta körning) kan du göra följande:

n Visa utförlig körningsinformation, inklusive den valda protokollfilen, plattfilen och skanningsläget.

n Lägga till anteckningar om körningen.

n Visa information om alla anslutna instrument, inklusive deras körningsstatus (igång eller inaktiva),
provvolym i µl, locktemperatur, emuleringsläge samt ID eller streckkod om tillgängligt.

Obs! Du kan ändra kolumnerna som visas i tabellen Start Run on Selected Blocks (Starta
körning på valda block). Se Ändra information i tabellen Selected Blocks (Valda block) på
sidan 170 för information.

n Välja ett eller flera block där du ska utföra körningen.

n Fjärröppna eller fjärrstänga locket på varje valt instrument.

n Starta körningen.
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Ändra information i tabellen Selected Blocks (Valda block)

Du kan ändra kolumnerna som visas i Start Run (Startkörning) i tabellen Selected Block(s) (Valda block).
Du kan också ändra standardprovvolymen och locktemperaturvärden i tabellen. Inställningsändringarna
tillämpas på körningen som ska utföras.

Så här lägger du till kolumner i tabellen Start Run on Selected Blocks (Starta körning på
valda block).

u Högerklicka på tabellen och välj ett alternativ på menyn som visas.

Så här tar du bort kolumner i tabellen Start Run on Selected Blocks (Starta körning på valda
block)

u Högerklicka på tabellen och ta bort alternativet på menyn som visas.

Så här ändrar du provvolymen eller locktemperatur för ett block

u Välj provvolym eller locktemperaturcell för målblocket och skriv in ett nytt värde i cellen.

Så här lägger du till ett körnings-ID eller en streckkod för ett block

u Välj cellen ID/Bar Code (ID/Streckkod) för målblocket och skriv in ett ID eller skanna blocket med en
streckkodsläsare.

Köra ett experiment
Viktigt! Innan du kör ett experiment måste du se till att din dators antivirusprogram inte startar en
skanning under körningen. Se Installera CFX Maestro Dx SE-programvaran på sidan 33 och din
systemadministratör för mer information.

Så här kör du ett experiment

1. På fliken Start Run (Starta körning) kontrollerar du informationen för platta och protokoll i sektionen
Run Information (Körningsinformation).

2. (Valfritt) Skriv in anteckningar om körningen eller experimentet i textrutan Notes (Anteckningar).

3. Markera kryssrutan för ett eller flera block där du ska utföra körningen.

Tips: För att köra experimentet på alla block väljer du Select All Blocks (Välj alla block) nedanför
tabellen Selected Blocks (Valda block).

4. (Valfritt) Klicka på Flash Block Indicator (Blockets indikatorlampa) för att tända indikatorlampan för de
valda instrumentblocken.

5. Sätt in experimentplattorna i blocket:
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a. Klicka på Open Lid (Öppna lock). Det motoriserade locket till varje valt block öppnas.

b. Sätt in en experimentplatta i varje valt block.

c. Klicka på Close Lid (Stäng lock).

Tips: Tryck på Open Lid (Öppna lock) eller Close Lid (Stäng lock) på startskärmen på CFX Opus
Dx-system.

6. Klicka på Open Lid (Öppna lock) och Close Lid (Stäng lock) för att öppna och stänga det
motoriserade locket till varje valt instrumentblock.

7. Visa informationen för körningen och gör något av följande:

n Om informationen är korrekt klickar du på Start Run (Starta körning).

n Om informationen är felaktig:

o Korrigera informationen i tabellen Selected Blocks (Valda block) och klicka på Start Run
(Starta körning).

o Gå tillbaka till rätt flik och gör erforderliga ändringar, spara ändringarna och klicka sedan på
Next (Nästa) för att återgå till fliken Start Run (Starta körning) och starta körningen.

Så här startar du en ny körning från en föregående körning

u Gör något av följande:

n Välj File > Repeat a Run (Arkiv > Upprepa en körning) i huvudmenyraden. Gå till och
dubbelklicka på körningsdatafilen som du vill upprepa.

n Välj fliken Repeat Run (Upprepa körning) i Startup Wizard (Startguide) och dubbelklicka på
körningsdatafilen för körningen du vill upprepa.

Alternativt kan du klicka på Browse (Bläddra) på fliken Repeat Run (Upprepa körning) och gå till
och dubbelklicka på körningsdatafilen för körningen du vill upprepa.
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Dialogrutan Run Details (Körningsdetaljer)
När du klickar på Start Run (Starta körning) uppmanas du av CFX Maestro Dx SE att spara datafilen
(.pcrd). Sedan startas körningen och dialogrutan Run Details (Körningsdetaljer) öppnas. Dialogrutan Run
Details (Körningsdetaljer) har tre statusflikar:

n Run Status (Körningsstatus) – använd den här fliken för att visa protokollets aktuella status, öppna
eller stänga locket, pausa en körning, lägga till repetitioner, hoppa över steg eller stoppa körningen.

n Real-time Status (Realtidsstatus) – använd den här fliken för att visa fluorescensdata för realtids-
PCR efterhand som de samlas in.

n Time Status (Tidsstatus) – använd den här fliken för att visa ett nedräkningstidur i helskärm för
protokollet.

Dessa flikar förklaras utförligt i kommande avsnitt.

Fliken Run Status (Körningsstatus)
På fliken Run Status (Körningsstatus) visas aktuellt status för en pågående körning. I den här vyn kan du
även kontrollera locket och ändra den pågående körningen.
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1. Rutan Run Status (Körningsstatus) – visar protokollets aktuella förlopp.

2. Kontroller för Run Status (Körningsstatus) – gör att du kan styra instrumentet eller
avbryta det aktuella protokollet.

3. Rutan Run Information (Körningsinformation) – visar körningsinformation.

FÖRKLARING

Kommandon för Run Status (Körningsstatus)

Använd kommandona på fliken Run Status (Körningsstatus) för att antingen styra instrumentet från
programmet eller ändra en pågående körning.

Obs! Även om du gör ändringar i protokollet under körningen, t.ex. lägger till repetitioner, ändras
ingenting i den protokollfil som är associerad med körningen. Dessa åtgärder registreras i Run Log
(Körningslogg).

– öppnar det motoriserade locket på vissa instrument.

Viktigt! Om du öppnar locket under en körning pausas körningen under det aktuella steget och
data kan förändras. Kommandon för Run Status (Körningsstatus) på sidan 173.

– stänger det motoriserade locket på vissa instrument.

– lägger till fler repetitioner till det aktuella GOTO-steget i protokollet. Detta alternativ är endast
tillgängligt när ett GOTO-steg pågår.

Obs! Du kan lägga till ytterligare upprepningar under en GOTO-cykel när protokollet körs. Men
CFX Maestro Dx SE utgår från den senaste ändringen av antalet upprepningar. Om du till
exempel lägger till ytterligare 10 upprepningar i en pågående GOTO-cykel, ändrar
programvaran det totala antalet till n + 10. Om du sedan lägger till ytterligare 5 upprepningar i
samma cykel, ändrar CFX Maestro det totala antalet upprepningar till n + 5. Den första
ändringen (10 upprepningar) ignoreras. För att säkerställa att programvaran utför önskat antalet
upprepningar ska du ange det totala antalet (i det här fallet 15 upprepningar).

– hoppar över det aktuella steget i protokollet.

Obs! Om du initierar ett hopp under ett GOTO-steg hoppar systemet till nästa cykel i GOTO-
slingan. OmGOTO-stegets sista cykel pågick vid tidpunkten för hoppet, hoppar systemet till
nästa steg.
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– tänder lampan på det valda instrumentet för att identifiera de valda blocken.

– pausar protokollet.

Obs! Denna åtgärd registreras i Run Log (Körningslogg).

– återupptar ett pausat protokoll.

– stoppar körningen innan protokollet är slut.

Obs! Om du stoppar en körning innan protokollet är slut kan data förändras.

Öppna instrumentlocket under en PCR-körning

Om locket på något instrument öppnas under en PCR-körning visar CFX Maestro Dx SE följande
bekräftelsedialogruta:

Medan dialogrutan visas fortsätter instrumenten att köra protokollet. Om du trycker på knappen OK pausas
körningen och instrumentlocket lossnar och öppnas. Om du trycker på knappen Cancel (Avbryt) stängs
dialogrutan och körningen återupptas.
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Fliken Real-time Status (Realtidsstatus)
På fliken Real-time Status (Realtidsstatus) visas realtids-PCR-data som samlats in vid varje cykel under
körningen efter de två första plattavläsningarna.

1. Ruta för amplifieringskurva – visar realtidsamplifieringsdata under körningen.

2. Identifierare för brunnsgrupper – om brunnsgrupper identifierades under
plattinställningen, kan användare välja en specifik brunnsgrupp för att visa dess
kurvor, brunnar och tabellinformation.

Identifierare för stegnummer – om protokollet samlar in data vid fler än ett steg (till
exempel under amplifiering och smältkurva), kan användare välja ett specifikt steg
och visa kurvorna som samlats in under det steget.

3. Ruta för brunnsväljare – visar de aktiva, inaktiva och tomma brunnarna i plattan.

4. Ruta för plattinställningstabell – visar plattinställningen i tabellformat.

FÖRKLARING
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5. Ruta för körningsdetaljer – visar realtidsstatus för körningen inklusive följande:

n Aktuellt steg

n Aktuell repetition

n Aktuell temperatur

n Återstående tid

n Provtemperatur

n Locktemperatur

6. Plate Setup (Plattinställning) – öppnar dialogrutan Plate Setup (Plattinställning), i
vilken användare kan ändra den aktuella plattinställningen under en körning.

På fliken Real-time Status (Realtidsstatus) kan du göra följande:

n Visa eller dölja realtidskurvor genom att markera dem i brunnsväljarrutan eller
plattinställningstabellen.

n Visa enstaka kurvor eller grupper av kurvor genom att markera dem i listrutan för brunnsgrupper.

n Redigera plattan eller byta ut plattfilen.

n Tillämpa en PrimePCR-fil på körningen.

Visa och dölja realtidskurvor

Som standard är alla fyllda brunnar aktiva och visas i tabellen för plattinställning. Aktiva brunnar är blå i
brunnsväljarrutan. Dolda brunnar är ljusgrå och oanvända brunnar är mörkgrå i brunnsväljarrutan.

Du kan dölja kurvor från aktiva brunnar under körningen. CFX Maestro Dx SE fortsätter att samla in data
för alla brunnar, men när du döljer brunnar visas deras data inte i tabellen för plattinställning.

Så här döljer du realtidskurvor

u I brunnsväljarrutan klickar du på de aktiva (blå) brunnar som du vill dölja.

Så här visar du realtidskurvor

u I brunnsväljarrutan klickar du på de dolda (ljusgrå) brunnar som du vill visa.

Mer information om brunnsväljaren finns i Brunnsväljare på sidan 196.
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Redigera en Plate Setup (Plattinställning)

Så här redigerar du en plattinställning

u Klicka på Plate Setup (Plattinställning) och välj sedan View/Edit Plate (Visa/redigera platta).

Fönstret Plate Editor (Plattredigerare) visas, i vilket du kan redigera plattan medan körningen pågår.
För mer information om att redigera plattor, se Kapitel 8, Förbereda plattor.

Obs! Du kan även redigera kurvutseendena från fönstret Plate Editor (Plattredigerare).
Ändringar visas i amplifieringskurvplotten på fliken Real-time Status (Realtidsstatus).

Byta ut en plattfil

Tips: Det är särskilt lämpligt att byta ut en plattfil om du startar en körning med en Quick Plate-fil i
mappen ExpressLoad.

Så här byter du ut en plattfil

u Klicka på Plate Setup (Plattinställning) och välj sedan ett av följande alternativ:

n Replace Plate file (Byt ut plattfil) – välj den nya plattfilen från listan i webbläsarfönstret

n Apply PrimePCR file (Använd PrimePCR-fil) – sök efter en körningsfil från vilken plattlayouten
kommer att erhållas med hjälp av Smart search (Smart sökning), eller klicka på Browse
(Bläddra) för att hitta en fil som hämtades från Bio-Rad-webbplatsen och som inte finns i
PrimePCR-mappen.

Obs! CFX Maestro Dx SE kontrollerar skanningsläge och plattstorlek för plattfilen. Dessa måste
överensstämmamed körningsinställningarna med vilka körningen påbörjades.
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Fliken Time Status (Tidsstatus)
På fliken Time Status (Tidsstatus) visas tiden som återstår tills den aktuella körningen är slutförd.
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Utföra PrimePCR-experiment
PrimePCR-experiment använder den reaktionsväg eller de sjukdomsspecifika analyser som Bio-Rad har
validerat och optimerat i våtlaboratorium och som finns i följande format:

n Beredda paneler – plattor innehållande analyser som är specifika för en biologisk reaktionsväg eller
sjukdom, dessa omfattar PrimePCR-kontroller och -referensgener.

n Plattor med anpassad konfiguration – plattor som kan konfigureras i en användardefinierad layout
med möjlighet att välja analyser för intressemål, kontroller och referenser.

n Individuella analyser – rör som innehåller individuella primeruppsättningar för användning i
realtidsreaktioner.

För att minska den totala körtiden kan du ta bort smältsteget i protokollet. Bio-Rad rekommenderar starkt
att du inte gör några andra ändringar av ett PrimePCR-körningsprotokoll. Standardprotokollet är det som
har använts för analysvalidering. Avvikelser från det kan påverka resultatet. Protokolländringar noteras på
fliken Run Information (Körningsinformation) i den resulterande datafilen och i rapporter som skapas.

Så här startar du en PrimePCR-körning

u Gör något av följande för att starta PrimePCR-körning:

n Välj PrimePCR på fliken Run setup (Körningsinställning) i Startup Wizard (Startguide) och välj
lämplig kemi (SYBR® eller prob).

n Välj en PrimePCR-körning i listan Recent Runs (Senaste körningar) på fliken Repeat run
(Upprepa körning) i Startup Wizard (Startguide).

n Välj File > Open > PrimePCR Run File (Arkiv > Öppna > PrimePCR-körfil) i hemfönstret.

n Dra och släpp en PrimePCR-körfil i hemfönstret.

När du har valt en PrimePCR-körning öppnas fönstret Run Setup (Körningsinställning) på fliken Start Run
(Starta körning) med den PrimePCR-standardplattlayout som har lästs in baserat på det valda
instrumentet.

Så här tar du bort protokollets smältsteg

u Avmarkera rutan intill Include Melt Step (Inkludera smältsteg) på fliken Protocol (Protokoll).
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Så här importerar du målinformation för PrimePCR-plattor till en plattlayout

1. Gör något av följande:

n Välj Plate Setup > Apply PrimePCR File (Plattinställning > Använd PrimePCR-fil) på fliken Real-
time Status (Realtidsstatus) i dialogrutan Run Details (Körningsinformation).

n Välj Plate Setup > Apply PrimePCR File (Plattinställning > Använd PrimePCR-fil) i fönstret Data
Analysis (Dataanalys).

2. I dialogrutan PrimePCR run file (PrimePCR-körningsfil) klickar du på Browse (Bläddra) och går till
lämplig PrimePCR-fil (.csv).

3. Välj PrimePCR-målfilen och klicka på Open (Öppna).

CFX Opus Dx-system importerar målinformationen till plattlayouten.
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Överföra fristående data för analys
Viktigt! När du överför datafiler från CFX Opus Dx-system till CFX Maestro Dx SE överförs alla filer
som sparats i systemet. Kontrollera att du har tillräckligt diskutrymme för säker dataöverföring.

När körningen är slutförd analyserar CFX Maestro Dx SE fluorescensdata. Om körningen utförs i
fristående läge och sparas på själva CFX Opus Dx-systemmåste data överföras till CFX Maestro Dx SE-
datorn för analys.

CFX Opus Dx-system kan lagra upp till 100 realtids-PCR-körningar. När körningen är slutförd kan du
överföra fristående datafiler till CFX Maestro Dx SE-datorn via e-post, USB-enhet eller via själva
programvaran.

I det här avsnittet förklaras hur du överför fristående datafiler till CFX Maestro Dx SE-datorn.

Överföra data via e-post
Så här skickar du en datafil via e-post när körningen är avslutad

1. Ställ in e-postaviseringar för instrumentet.

Se Ställa in e-postaviseringar på sidan 79 eller bruksanvisningen för CFX Opus Dx realtids-PCR-
system.

2. När du ställer in e-postaviseringar måste du se till att Attach Data File (Bifoga datafil) är markerat.

Körningsdata skickas via e-post som en fil i formatet .pcrd.

Överföra data från CFX Opus Dx realtids-PCR-system
Med funktionen File Browser (Filläsare) på CFX Opus Dx-system kan du överföra datafiler till en ansluten
USB-enhet eller till en delad nätverksmapp. Du kan också överföra CFX Maestro Dx SE-protokollfiler från
en USB-enhet eller delad nätverksenhet till din mapp eller den offentliga mappen på CFX Opus Dx-
system och köra dem på CFX Opus Dx-system.

Tips: Det här avsnittet förklarar hur du överför data. Mer information om att konfigurera Ethernet-
finns i CFX Opus Dx realtids-PCR-system Bruksanvisning som du hittar på CFX Maestro Dx SE
menyn Help (Hjälp).

1. Gå till skärmen Home (Start) på CFX Opus Dx-system och tryck på Files (Filer) så visas skärmen File
Browser (Filläsare).

2. På skärmen File Browser (Filläsare) navigerar du till den fil du vill kopiera och trycker sedan på filen
för att visa rutan med filinformation.

3. I rutan med filinformation trycker du på Options (Alternativ) och sedan på Copy (Kopiera).
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Dialogrutan Select Location (Välj plats) visas.

4. Gör något av följande i dialogrutan Select Location (Välj plats):

n Navigera till en befintlig mapp.

n Navigera till platsen där du vill skapa en mapp att spara filen i och tryck sedan på Create Folder
(Skapa mapp)

( ) för att skapa en ny mapp på den platsen.

5. Tryck på Select (Välj) för att kopiera filen till den valda platsen eller Cancel (Avbryt) för att återgå till
skärmen File Browser (Filläsare).

Obs! Om det finns en fil med samma namn på den valda platsen visas en meddelanderuta.
Tryck på Yes (Ja) för att skriva över den befintliga filen eller No (Nej) för att återgå till skärmen
File Browser (Filläsare).

CFX Opus Dx-system visar ett bekräftelsemeddelande när filen har kopierats.
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Överföra data via CFX Maestro Dx programvara, Security Edition
Så här överför du data via CFX Maestro Dx SE

1. I rutan Detected Instruments (Hittade instrument) i hemfönstret högerklickar du på målinstrumentet
och väljer Retrieve Data Files (Hämta datafiler).

CFX Maestro Dx SE visar dialogrutan Browse For Folder (Sök efter mapp).

2. Gå till den plats där du vill spara datafilerna i dialogrutan Browse For Folder (Sök efter mapp) och
klicka på OK.

Överföringsprocessen skapar en mapp med namnet Real-Time Data (Realtidsdata) på den valda
platsen. Körningsdata sparas i mappen Real-Time Data (Realtidsdata) som separata .zpcr-filer.

Överföra data med hjälp av en USB-enhet
Om du sätter en USB-enhet i USB-porten på instrumentet sparas datafilen automatiskt till rotkatalogen för
USB-enheten när körningen har avslutats. Du kan också lokalisera tidigare sparade datafiler och spara
dem på en ansluten USB-enhet.

Så här överför du datafiler till en USB-enhet på CFX Opus Dx-system

u I dialogrutan Select Location (Välj plats) trycker du på USB och navigerar till målmappen dit du vill
kopiera filen, eller på Cancel (Avbryt) för att återgå till skärmen File Browser (Filläsare).

Obs! Om det finns en fil med samma namn på den valda platsen visas en dialogruta. Tryck på
Yes (Ja) för att skriva över den befintliga filen eller No (Nej) för att återgå till skärmen File
Browser (Filläsare).

CFX Opus Dx-system visar ett bekräftelsemeddelande när filen har kopierats.
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Överföra data via en delad nätverksenhet med hjälp av CFX Opus
Dx realtids-PCR-system
Tips: Du kan bara överföra data till och från en delad nätverksenhet via CFX Opus Dx-system.

CFX Opus Dx-system gör att du kan ansluta till en delad nätverksenhet med Ethernet. Efter anslutning
kan du överföra datafiler till och från en mapp på den delade nätverksenheten.

Så här överför du data till och från en delad nätverksenhet

u I dialogrutan Select Location (Välj plats) trycker du på Network (Nätverk) och navigerar till
målmappen dit du vill kopiera filen, eller på Cancel (Avbryt) för att återgå till skärmen File Browser
(Filläsare).

Obs! Om det finns en fil med samma namn på den valda platsen visas en dialogruta. Tryck på
Yes (Ja) för att skriva över den befintliga filen eller No (Nej) för att återgå till skärmen File
Browser (Filläsare).

CFX Opus Dx-system visar ett bekräftelsemeddelande när filen har kopierats.

Skapa en datafil
För att analysera data som överförs från instrumentet till CFX Maestro Dx SE-datorn måste den
komprimerade datafilen (.zpcr-filen) konverteras till en datafil (.pcrd-fil). CFX Maestro Dx SE konverterar
.zpcr-filen till en .pcrd-fil och väljer sedan en plattfil som har samma skanningsläge och plattstorlek och
tillämpar den på .pcrd-filen.

Så här skapar du en datafil från en fristående datafil

1. Gör något av följande i CFX Maestro Dx SE:

n Sök upp målfilen med formatet .zpcr och dra den till CFX Maestro Dx SE-hemfönstret.

n Välj File > Open > Stand-alone Run (Arkiv > Öppna > Fristående körning), gå till målfilen och välj
den.

CFX Maestro Dx SE visar dialogrutan Save As (Spara som).

2. Gå till mappen där du tänker spara .pcrd-filen och klicka på Save (Spara).

När du har sparat .pcrd-filen öppnar CFX Maestro Dx SE fönstret Data Analysis (Dataanalys) och
visar resulterande data.
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CFXMaestro Dx programvara, Security Edition bearbetar automatiskt realtids-PCR-data i slutet av varje
körning och öppnar fönstret Data Analysis (Dataanalys) där dessa data visas (.pcrd-filen).

n Dra en datafil (.pcrd-tillägg) till hemfönstret och släpp den.

n Välj File > Open > Data File (Arkiv > Öppna > Datafil) i hemfönstret och bläddra till .pcrd-målfilen.

n Välj File > Recent Data Files (Arkiv > Senaste datafiler) i hemfönstret och välj en av de tio senast
öppnade datafilerna i en lista.

n Välj fliken Analyze (Analysera) i Startup Wizard (Startguide) och välj bland Recent Files (Senast
använda filer) eller klicka på Browse (Bläddra) och leta upp datafilen.

Fönstret Data Analysis (Dataanalys)
Fönstret Data Analysis (Dataanalys) visar flera flikar som vardera visar analyserade data för en specifik
analysmetod eller körningsspecifik information. Flikar visas endast om data som har samlats in under
körningen är tillgängliga för analystypen i fråga.

Tips: Välj flikar som du vill visa på den nedrullningsbara menyn View (Visa) i fönstret Data Analysis
(Dataanalys). Välj Settings (Inställningar) > Restore Default Window Layout (Återställ
standardfönsterlayout) för att återgå till den ursprungliga fliklayouten.
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Verktygsraden för Data Analysis (Dataanalys)
Verktygsraden i fönstret Data Analysis (Dataanalys) ger snabb åtkomst till viktiga dataanalysfunktioner.

I Tabell 11 listas funktionerna för knapparna i verktygsraden.

Knapp Namn Funktion

Plate Setup
(Plattinställning)

View/Edit plate (Visa/redigera platta) – öppnar
Plate Editor (Plattredigerare) där du kan visa
och redigera brunnars innehåll.

Replace Plate (Ersätt platta): Väljer en plattfil
som ska ersätta plattlayouten.

Apply PrimePCR file (Använd PrimePCR-fil):
Väljer en körfil som ska ersätta plattlayouten
för en PrimePCR-körning.

ManageWell
Groups (Hantera
brunnsgrupper)

Öppnar fönstret Well Groups Manager
(Brunnsgruppshanterare) där du kan skapa,
redigera och ta bort brunnsgrupper.

Well Group
(Brunnsgrupp)

Väljer ett befintligt brunnsgruppsnamn i den
nedrullningsbara menyn. Standardvalet är All
Wells (Alla brunnar). Knappen visas endast när
brunnsgrupper skapas.

Analysis Mode
(Analysläge)

Analyserar data i läget Fluorophore (Fluorofor)
eller Target (Mål).

Help (Hjälp) Öppnar programvaruhjälpen där du kan hitta
onlinehjälp och en digital kopia av denna
handbok i Acrobat PDF-format.

Tabell 11. Verktygsraden i fönstret Data Analysis (Dataanalys)
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Menyraden Data Analysis (Dataanalys)
I Tabell 12 listas alternativen på menyraden i fönstret Data Analysis (Dataanalys).

Menyalternativ Kommando Funktion

File (Arkiv) Save (Spara) Sparar filen.

Save As (Spara som) Sparar filen med ett nytt namn.

File Passwords (Fillösenord) Gör det möjligt för användare att ange
lösenord för att spara och öppna filen.

Sign (Signera) Gör det möjligt för användare att signera
datafilen.

Repeat Run (Upprepa körning) Extraherar protokollet och plattfilen från
den aktuella körningen för att köra den
igen.

Close (Stäng) Stänger fönstret Data Analysis
(Dataanalys).

View (Visa) Run Log (Körningslogg) Öppnar fönstret Run Log (Körningslogg)
och visar den aktuella datafilens
körningslogg.

Audit Trail (Revisionslogg) Öppnar revisionsloggen för filen.

Quantification (Kvantifiering), Melt
Curve (Smältkurva), Gene
Expression (Genuttryck), End
Point (Ändpunkt), Custom Data
View (Anpassad datavy), QC
(Kvalitetskontroll), Run
Information (Körningsinformation)

Visar analyserade data på valda flikar i
fönstret Data Analysis (Dataanalys). Minst
en flik måste väljas.

Tabell 12. Menyradsalternativ i fönstret Data Analysis (Dataanalys)
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Menyalternativ Kommando Funktion

Inställningar Cq Determination Mode (Cq-
bestämningsläge)

Välj läget Regression eller Single
Threshold (Enkelt tröskelvärde) för att
bestämma hur Cq-värdena beräknas för
varje kurva.

Tabell 12. Menyradsalternativ i fönstret Data Analysis (Dataanalys), forts.

188 | CFX Maestro Dx SE programvara



Fönstret Data Analysis (Dataanalys)

Menyalternativ Kommando Funktion

Baseline Setting
(Baslinjeinställning)

Gör att du kan välja
baslinjesubtraktionsmetod för de valda
brunnsgrupperna.

Analysis Mode (Analysläge) Välj och analysera data efter Fluorophore
(Fluorofor) eller efter Target (Mål).

Cycles to Analyze (Cykler att
analysera)

Gör att du kan välja vilka cykler som ska
analyseras.

Baseline Threshold
(Baslinjetröskel)

Öppnar fönstret Baseline Threshold
(Baslinjetröskel) där du kan justera
baslinjen eller tröskelvärdet.

Trace Styles (Kurvutseenden) Öppnar fönstret Trace Styles
(Kurvutseenden).

Plate Setup (Plattinställning) Öppnar Plate Editor (Plattredigerare) där
du kan visa och redigera plattan samt
ersätta den aktuella plattan med en från en
användardefinierad plattfil eller en
PrimePCR-körfil.

Include All Excluded Wells
(Inkludera alla exkluderade
brunnar)

Inkluderar alla exkluderade brunnar i
analysen.

Mouse Highlighting
(Musmarkering)

Aktiverar och avaktiverar simultan
markering av data med muspekaren.

Tips: OmMouse Highlighting
(Musmarkering) är avaktiverat kan du
tillfälligt aktivera markering genom att
trycka på Ctrl-tangenten.

Restore Default Window Layout
(Återställ standardfönsterlayout)

Återställer ordningen av fönster till
standardinställningen.

Tabell 12. Menyradsalternativ i fönstret Data Analysis (Dataanalys), forts.
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Menyalternativ Kommando Funktion

Export Export All Data Sheets (Exportera
alla datablad)

Låter dig välja om du vill exportera alla
kalkylbladsvyer från varje flik till en .csv-,
.txt-, Excel- eller .xml-fil.

Export RDML File (Exportera
RDML-fil)

Låter dig välja antingen version 1.1 eller 1.0
av RDML som filen ska exporteras till.

Custom Export (Anpassad export) Öppnar fönstret Custom Export (Anpassad
export) där du kan ange vilka fält som ska
exporteras och filformatet.

Export to LIMS Folder (Exportera
till LIMS-mapp)

Öppnar ett fönster där du kan spara data i
ett förutbestämt format i LIMS-mappen.

Manual Export (Manuell export) Öppnar ett fönster för definition av platsen
där data ska sparas från alla
kalkylbladsvyer till Excel-filer som är
strukturerade särskilt för användning av
Seegene, Inc och Bio-Rad Laboratories.

Tips: Du kan också starta Seegene
Viewer automatiskt vid export. Se
Kommandon på menyn Tools
(Verktyg) på sidan 65 för mer
information.

Tools (Verktyg) Reports (Rapporter) Öppnar datafilens Report (Rapport).

Well Group Reports
(Brunnsgruppsrapporter)

Öppnar fönstret Well Group Report
(Brunnsgruppsrapport) för generering av
rapporter för angivna brunngrupper.

Import Fluorophore Calibration
(Importera fluoroforkalibrering)

Välj en kalibreringsfil som ska tillämpas för
den aktuella datafilen.

qbase+ Startar qbase+ v2.5 direkt från den aktuella
.pcrd-filen om det är installerat.

Generate LIMS PLRN file (Skapa
LIMS PLRN-fil)

Sparar datafilen som en LIMS-formaterad
.plrn-fil.

Tabell 12. Menyradsalternativ i fönstret Data Analysis (Dataanalys), forts.
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Flikinformation
Varje flik i fönstret Data Analysis (Dataanalys) visar data i diagram och kalkylblad för en specifik
analysmetod och har en brunnsväljare för val av data som du vill visa. När den öppnas visar Data Analysis
(Dataanalys) fliken Quantification (Kvantifiering) som standard. Du kan använda data i diagrammet
Amplification (Amplifiering) på fliken Quantification (Kvantifiering) för att ange lämpliga analysinställningar
för körningen.

Obs! Programvaran länkar data i rutorna för varje Data Analysis-flik (Dataanalys). Om du till exempel
markerar en brunn genom att placera muspekaren över den i brunnsväljarvyn kommer motsvarande
data att markeras i alla andra rutor.

Stegnummerväljare
Systemen CFX Opus Dx kan samla in fluorescensdata i flera protokollsteg; programvaran bevarar data
från varje steg fristående. CFX Maestro Dx SE visar stegnummerväljaren under diagrammet Standard
Curve (Standardkurva) på fliken Quantification (Kvantifiering). Om ett protokoll innehåller minst ett
datainsamlingssteg visar CFX Maestro Dx SE data från det första insamlingssteget.

Om protokollet innehåller fler än ett insamlingssteg kan du välja ett annat steg i listrutan. Exempel:

När du väljer ett steg tillämpar programvaran valet på alla data som visas i fönstret Data Analysis
(Dataanalys).
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Visa Well Groups (Brunnsgrupper) i Data Analysis (Dataanalys)
Brunnar i plattan kan grupperas i undergrupper för oberoende analys med användning av brunnsgrupper.
När du skapar brunnsgrupper visas deras gruppnamn i listrutan Well Groups (Brunnsgrupper) i
verktygsraden i fönstret Data Analysis (Dataanalys).

Om du skapade brunnsgrupper visar programmet standardbrunnsgruppen All Wells (Alla brunnar) när du
öppnar fönstret Data Analysis (Dataanalys), och visar data för alla brunnar med innehåll i diagrammen
och kalkylbladen. Endast brunnarna som laddats med innehåll visas i brunnsväljaren, och endast data för
dessa brunnar ingår i dataanalysberäkningarna.

Tips: För att skapa, redigera och radera brunnsgrupper, klicka på ManageWell Groups (Hantera
brunnsgrupper) i verktygsraden.

Obs! Om du inte skapade brunnsgrupper visas inte listrutan Well Groups (Brunnsgrupper) i
verktygsraden.

Ändra brunnsinnehåll efter en körning
Under dataanalys, om du ändrar sättet på vilket data visas genom att ändra innehållet i brunnarna i Plate
Editor (Plattredigerare), så ändras aldrig de fluorescensdata som samlats in från respektive brunn under
körningen. Efter det att modulen samlat in fluorescensdata, kan du inte radera dessa data men du kan
välja att ta bort data från vy och analys.

Så här ändrar du innehållet i brunnar efter en körning

u I fönstret Data Analysis (Dataanalys) klickar du på Plate Setup (Plattinställning) och väljer ett av
följande alternativ:

n Edit/View Plate (Redigera/Visa platta) – öppnar Plate Editor (Plattredigerare) i vilken du kan
göra manuella förändringar av layouten.

n Replace Plate file (Ersätt plattfil) – öppnar läsaren Select Plate (Välj platta), i vilken du kan
navigera till en tidigare sparad plattfil med vilken du kan ersätta den aktuella plattlayouten.

n Apply PrimePCR file (Använd PrimePCR-file) – öppnar dialogrutan Select PrimePCR file (Välj
PrimePCR-file) i vilken du kan gå till en PrimePCR-körningsfil och använda den på plattlayouten.

Tips: Du kan lägga till eller redigera information om innehållet i brunnen före en körning, under en
körning eller efter en slutförd PCR-körning. Du måste tilldela skanningsläge och plattstorlek före
körningen. Dessa parametrar går inte att ändra efter körningen.
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Dataanalysinställningar
Data i diagrammet Amplification (Amplifiering) på fliken Quantification (Kvantifiering) visar den relativa
fluorescensenheten (RFU) för varje brunn vid varje cykel. Varje kurva i diagrammet representerar data
från en enskild fluorofor i en brunn. Dessa data används för att bestämma Cq-värden för varje brunn per
fluorofor. Programmet använder ett av två lägen för att bestämma Cq-värden:

n Regression – använder en multivariabel, icke-linjär regressionsmodell på enskilda brunnskurvor och
använder sedan denna modell för att beräkna ett optimalt Cq-värde.

n Single Threshold (Enstaka tröskel) – använder värdet för en enstaka tröskel för att beräkna Cq-
värdet baserat på tröskelskärningspunkten för enskilda fluorescenskurvor.

Välj Settings > Cq Determination Mode (Inställningar > Cq-bestämningsläge) för att välja Cq-
bestämningsläget.

Justera tröskeln
I läget Single Threshold (Enkelt tröskelvärde) kan du justera tröskelvärdet för en fluorofor genom att klicka
på tröskelvärdeslinjen i diagrammet Amplification (Amplifiering) och flytta muspekaren vertikalt.
Alternativt kan du specificera en exakt korsande tröskel för den valda fluoroforen.

Baslinjeinställningar
Den här programvaran fastställer automatiskt baslinjen separat för varje brunn. Baslinjeinställningen
fastställer metoden för baslinjesubtraktion för alla fluorescenskurvor. Programvaran erbjuder tre alternativ
för baslinjesubtraktion:

n No Baseline Subtraction (Ingen baslinjesubtraktion) – visar data som relativa fluorescenskurvor.
Vissa analyser är inte möjliga i det här analysläget, och därför visar inte programvaran flikarna Gene
Expression (Genuttryck), End Point (Slutpunkt) och Allelic Discrimination (Allelisk diskriminering).

n Baseline Subtracted (Baslinje subtraherad) – visar data som baslinjesubtraherade kurvor för varje
fluorofor i en brunn. Programvaran måste baslinjesubtrahera uppgifterna för att fastställa
kvantifieringscykler, generera standardkurvor och fastställa koncentrationen av okända prover. För
generering av en baslinjesubtraherad kurva passar mjukvaran under baslinjecyklerna den bästa raka
linjen genom den registrerade fluorescensen för varje brunn och subtraherar sedan de data som
passar bäst från bakgrundssubtraherade data vid varje cykel.

n Baseline Subtracted Curve Fit (Baslinjesubtraherad anpassning av kurva) – visar data som
baslinjesubtraherade kurvor och programvaran slätar ut den baslinjesubtraherade kurvan med hjälp
av ett centrerat medelvärdesfilter. Den här processen utförs så att varje Cq lämnas invariant.
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Utöver dessa alternativ kan du också välja Apply Fluorescent Drift Correction (Använd korrigering av
fluorescensförflyttning). För brunnar som har onormalt avvikande RFU-värden under de första få cyklerna av
en körning härleder programvaran en beräknad baslinje från intilliggande brunnar för vilka en horisontell
baslinje har genererats.

Så här ändrar du inställningen av baslinjesubtraktion

u Välj Settings (Inställningar) > Baseline Setting (Baslinjeinställning).

Analysläge
Data kan grupperas och analyseras antingen enligt fluorofor eller målnamn. När de grupperas enligt
fluorofor, visas datakurvor enligt fluorofor så som indikeras i plattinställningen för den körningen. Enskilda
fluorofordata visas i diagrammet för amplifiering och standardkurva (om det är tillgängligt) när de lämpliga
kryssrutorna för fluoroforväljare, placerade under amplifieringsdiagrammet, är markerade.

När de grupperas enligt mål visas datakurvor enligt målnamn så som det angivits i plattinställningen för
den körningen.

Så här väljer du dataanalysläge

u Gör något av följande:

n Välj Settings > Analysis Mode (Inställningar > Analysläge).

n Välj ett läge från den nedrullningsbara menyn Analysis Mode (Analysläge) i verktygsraden.
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Cykler att analysera
Du kan begränsa antalet cykler att analysera. Du kan också analysera data från en specifik uppsättning
cykler. Du kan högst analysera 50 cykler.

Obs! Borttagning av cykler från början av en körning kan ha en betydande inverkan på baslinjen.

Så här begränsar du dataanalysen till ett specifikt intervall av cykler

1. Välj Settings > Cycles to Analyze (Inställningar > Cykler att analysera).

Dialogrutan Cycles to Analyze (Cykler att analysera) visas.

2. Ange värden för start- och slutcykel och klicka på OK.

Klicka på Restore Defaults (Återställ standardvärden) i dialogrutan Cycles to Analyze (Cykler att
analysera) för att återgå till cykler som ursprungligen användes för analysen.
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Brunnsväljare
AnvändWell Selector (Brunnsväljaren) för att visa eller dölja brunnsdata i diagrammen eller kalkylbladen i
fönstret Data Analysis (Dataanalys). Endast brunnar som har lästs in med provet kan väljas i
brunnsväljaren. Programvaran färgar brunnarna i Well Selector (Brunnsväljare):

n Blå – anger valda brunnar. Data från brunnar som har valts visas i fönstret Data Analysis
(Dataanalys).

n Ljusgrå – anger icke-valda brunnar. Data från brunnar som inte har valts visas inte i fönstret Data
Analysis (Dataanalys).

n Mörkgrå – anger tomma brunnar.

Så här visar eller döljer du brunnsdata

u Gör något av följande i brunnsväljaren:

n Klicka på en brunn om du vill dölja den. Klicka på brunnen igen för att visa den.

n För att dölja flera brunnar drar du över brunnarna som du vill markera. För att visa dessa
brunnar, dra över dem igen.

n Klicka i det övre vänstra hörnet av plattan för att dölja alla brunnar. Klicka i det övre vänstra
hörnet igen för att visa alla brunnar.

n Klicka i början av en kolumn eller rad för att dölja brunnarna. Klicka på kolumnen eller raden igen
för att visa brunnarna.
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Alternativ på högerklicksmenyn för brunnsväljare
I Tabell 13 visas högerklicksalternativ som är tillgängliga i brunnsväljarvyn.

Alternativ Funktion

Well XX (Brunn XX) Visar endast denna brunn, tar bort denna brunn från vyn, ställer in färg
för brunnen eller utesluter brunnen från analys.

Valda brunnar (högerklicka och
dra)

Visar endast dessa brunnar, tar bort dessa brunnar från vyn, ställer in
färg på dessa brunnar eller utesluter dessa brunnar från analysen.

Copy (Kopiera) Kopierar innehållet i en brunn till urklipp, inklusive Sample Type
(Provtyp) och Replicate # (Replikatnummer) som tillval.

Copy as Image (Kopiera som
bild)

Kopierar vyn för brunnsväljare som en bild.

Print (Skriv ut) Skriver ut vyn för brunnsväljare.

Print Selection (Skriv ut
markering)

Skriver ut aktuell markering.

Export to Excel (Exportera till
Excel)

Exporterar data till ett Excel-kalkylblad.

Export to CSV (Exportera till
CSV)

Exporterar data som ett .csv-dokument.

Export to Xml (Exportera till Xml) Exporterar data som ett .xml-dokument.

Well Labels (Brunnsetiketter) Ändrar brunnsetiketterna till Sample Type (Provtyp), Target Name
(Målnamn) eller Sample Name (Provnamn).

Tabell 13. Alternativ på högerklicksmenyn för brunnsväljare
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Tillfälligt utesluta brunnar från analys
Så här utesluter du tillfälligt brunnar från dataanalys

1. Högerklicka på brunnen i brunnsväljaren, på en fluorescenskurva eller på en punkt som plottats på
standardkurvan. Uteslut flera brunnar genom att högerklicka och för att markera flera brunnar, kurvor
eller punkter.

2. Välj lämpligt alternativ på högerklicksmenyn:

n Well > Exclude Well (Brunn > Uteslut brunn)

n Selected Wells > Exclude from Analysis (Valda brunnar > Uteslut från analys)

n Selected Traces > Exclude these wells from Analysis (Valda kurvor > Uteslut dessa brunnar från
analys)

Alternativt kan du ta bort dessa brunnar permanent från analys genom att rensa innehållet i brunnar i
Plate Editor (Plattredigerare) genom att klicka på knappen Clear Wells (Rensa brunnar).

Viktigt! Du måste ange eventuellt rensat brunnsinnehåll igen.

Så här inkluderar du en utesluten brunn

u Högerklicka på lämplig brunn i brunnsväljaren och välj Well > Include Well in Analysis (Brunn >
Inkludera brunn i analys).
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Diagram
Varje diagram i fönstret Data Analysis (Dataanalys) visar uppgifterna i en separat graf och har alternativ
med vilka du kan justera och exportera data eller diagramgrafik.

Diagramverktyg
I Tabell 14 visas högerklickalternativ som är tillgängliga i de flesta tabeller.

Alternativ Funktion

Copy (Kopiera) Kopierar diagrammet till ett urklipp.

Save Image As... (Spara bild
som...)

Sparar tabellen som en bildfil. Ange upplösning och mått för bilden och
välj sedan filtyp (PNG, GIF, JPG, TIF eller BMP).

Page Setup... (Utskriftsformat...) Väljer ett utskriftsformat för utskrift.

Print... (Skriv ut...) Skriver ut tabellen.

Set Scale to Default (Ange skala
som standard)

Visar alla data i stapeldiagrammet. Rullningslister visas om antalet
datapunkter/prover är för stort för att visa inom diagrammets ram.

Chart Settings
(Diagraminställningar)

Öppnar dialogrutan Chart Settings (Diagraminställningar) där du kan
ändra diagrammets visningsalternativ, inklusive:

n Diagram- och axelrubriker

n Teckensnitt och storlek för diagram och axel

n Skala för axel

n Position för förklaring

Tabell 14. Alternativ på högerklicksmenyn som är gemensamma för de flesta tabeller

Diagramverktyg visas också i varje diagram i fönstret Data Analysis (Dataanalys). Alla diagram visar
dessa verktyg:

Copy to Clipboard (Kopiera till urklipp) – kopierar innehållet i diagramvyn till urklipp.

Chart Settings (Diagraminställningar) – öppnar dialogrutan Chart Settings (Diagraminställningar) där du
kan ändra diagrammets visningsalternativ.

Export – öppnar dialogrutan Export Options (Exportalternativ) där du kan ändra upplösningen och
storleken på grafen och spara den till en specifik plats som en av följande filtyper:

n .bmp

n .jpg
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n .png

Stapeldiagramsverktyg

Utöver diagramverktygen har stapeldiagram följande verktyg:

Sort (Sortera) – sorterar målen och proverna alfabetiskt eller i omvänd alfabetisk ordning.

Color Settings (Färginställningar) – öppnar dialogrutan Color Settings (Färginställningar) där du kan
ändra färgen på mål och prover.

Mer information om dessa verktyg finns i Ändra och kommentera diagramvyn på sidan 262.

Amplifieringstabellverktyg

Utöver de verktyg som anges ovan visar amplifieringsdiagram följande verktyg:

Trace Styles (Kurvutseenden) – öppnar dialogrutan Trace Styles (Kurvutseenden) där du kan justera
utseendet på kurvorna i amplifieringsdiagrammet.

Baseline Threshold (Baslinjetröskel) – öppnar dialogrutan Baseline Threshold (Baslinjetröskel) där du
kan ändra standardbaslinjen för valda brunnar eller ändra tröskeln för varje fluorescenskurva i
amplifieringsdiagrammet.

Kopiera diagramdata till urklipp

Du kan kopiera innehållet i diagramvyn och klistra in det i ett program som accepterar bitmappbildfiler.

Så här kopierar du diagramdata till urklipp

1. Välj ikonen Copy to Clipboard (Kopiera till Urklipp) från diagramverktygen.

2. Öppna ett program som accepterar bitmappbilder, till exempel Microsoft Word.

3. Högerklicka och välj Paste (Klistra in) för att klistra in bitmappbilden från urklipp i programmet.

Ändra inställningarna för diagramvisning

I dialogrutan Chart Settings (Diagraminställningar) kan du ändra titlar, teckensnitt och teckenstorlekar,
axelskala och förklaringsplats för det visade diagrammet. Ändringar som görs gäller endast det visade
diagrammet och sparas med diagrammet.

Så här ändrar du inställningarna för diagramvisning

1. Klicka på Chart Settings (Diagraminställningar) i diagramverktygen.

Dialogrutan Chart Settings (Diagraminställningar) öppnas.
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2. Välj fliken Chart And Axes (Diagram och axlar) för att göra följande:

n Skriva in en rubrik på diagrammet.

n Skriva in en ny rubrik på x-axeln och vinkla etiketterna.

n Skriva in en ny rubrik på y-axeln.

3. Välj fliken Fonts (Teckensnitt) för att ändra diagrammets teckensnitt och teckensnittsstorlek.

Tips: Som standard skalas teckensnittsstorleken automatiskt när diagrammets storlek ändras.
Välj Change Font Size (Ändra teckensnittsstorlek) för att ställa in en statisk teckensnittsstorlek
för varje etikettyp.

4. Välj fliken Axes Scale (Axelskala) om du vill göra följande:

n Rensa x- och y-axelautoskalningen och ange lägsta och högsta skalningsvärden.

n Välja att visa stödlinjer eller skalstreck i diagrammet.

5. Välj fliken Legend (Förklaring) om du vill göra följande:

n Välja att dölja diagramförklaringen.

n Ändra diagramförklaringens standardposition.

Obs! När förklaringen finns till vänster eller höger om diagrammet visar den endast de första tio
fluoroforerna i diagrammet.

6. Klicka på Apply (Använd) när som helst för att visa diagraminställningsändringar utan att spara
ändringarna.

7. Klicka på OK för att spara ändringarna och återgå till diagrammet.
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Exportera diagrammet

Använd den här dialogrutan för att ändra grafens bredd, höjd och upplösning och exportera den i ett av
följande filformat:

n .bmp

n .jpg

n .png

Du kan sedan använda den exporterade grafen för att visa resultaten i poster-sessioner, Microsoft
PowerPoint-presentationer och facktidskrifter.

Obs! Ta hänsyn till följande när du ändrar inställningarna:

n Max- och minimivärden för bredd och höjd

o Vid 72 dpi: 0,1–83 tum

o Vid 96 dpi: 0,1–62 tum

o Vid 150 dpi: 0,1–40 tum

o Vid 300 dpi: 0,1–20 tum

o Vid 600 dpi: 0,1–10 tum

o I alla resolutioner: 2–6 000 pixlar

n Bredd–höjd-förhållandet baseras på bredden.

Så här exporterar du diagrammet

1. Klicka på Export i diagramverktygen.

Dialogrutan Export Preview (Förhandsvisning av export) visas.
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2. Ändra inställningarna för visningen efter behov.

3. Klicka på Export (Exportera).

4. Gör följande i dialogrutan Export:

a. (Valfritt) Gå till mappen där du vill spara diagramfilen.

b. Skriv ett namn för filen och välj en filtyp i listrutan.

5. Klicka på Save (Spara) för att spara tabellfilen.

Ändra inställningarna för baslinjetröskel

I läget Single Threshold (Enkelt tröskelvärde) kan du justera tröskelvärdet för en fluorofor genom att klicka
på tröskelvärdeslinjen i diagrammet Amplification (Amplifiering) och flytta muspekaren vertikalt.
Alternativt kan du specificera en exakt korsande tröskel för den valda fluoroforen.

Tips: Du kan specificera ett cykelintervall för att bestämma baslinjen för alla datafiler på fliken Data
Analysis (Dataanalys) i User > User Preferences (Användare > Användarinställningar).

Så här justerar du baslinjecykelns början och slut för varje brunn

1. På fliken Quantification (Kvantifiering), välj en enstaka fluorofor under amplifieringsdiagrammet.

2. Välj baslinjetröskel från diagramverktygen.

Dialogrutan Baseline Threshold (Baslinjetröskel) visas.
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3. Gör något av följande i avsnittet Baseline Cycles (Baslinjecykler):

n För att välja en brunn, klicka på dess radnummer.

n För att välja flera angränsande brunnar, klicka på radnumret för den första brunnen och dra
nedåt längs kolumnen till den avslutande brunnen.

n För att välja flera ej angränsande brunnar, håll tangenten Ctrl nedtryckt och klicka på radnumret
för respektive målbrunn.

n För att välja alla brunnar, klicka i tabellens övre vänstra hörn.

4. Justera cykeln för Baseline Begin (Baslinje börjar) och Baseline End (Baslinje slutar) för alla valda
brunnar, eller ändra cykelnumret för Begin (Börja) och End (Sluta) längst ned i kalkylbladet.

Tips: För att återställa inställningarna till de senast sparade värdena, klicka på Reset All User
Defined Values (Återställ alla användardefinierade värden).

5. Klicka på OK för att spara ändringarna och återgå till diagrammet.

Så här specificerar du ett cykelintervall för alla datafiler

u I fönstret Home (Hem) eller Plate Editor (Plattredigerare), välj User > User Preferences (Användare >
Användarinställningar) och sedan fliken Data Analysis (Dataanalys).

Sortera data för mål, prover och biologiska grupper

Obs! Det här alternativet är endast tillgängligt för genuttrycksdiagram.

Som standard visas listorna Targets (Mål), Samples (Prover) och Biological Groups (Biologiska grupper) i
alfabetisk ordning. I dialogrutan Sort (Sortera) kan du sortera visningen i omvänd alfabetisk ordning eller
manuellt flytta ett villkor till en annan plats i listan.

Så här sorterar du data för mål, prover och biologiska grupper

1. Klicka på Sort (Sortera) i diagramverktygen.

Dialogrutan Gene Expression Chart Sorting (Sortering i genuttrycksdiagram) öppnas.
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2. I dialogrutan klickar du på Z-A för att sortera listan i omvänd alfabetisk ordning.

3. Du flyttar ett villkor manuellt genom att välja det och klicka på lämplig knapp mellan diagrammen:

n Klicka på uppåt- eller nedåtpilen för att flytta det valda villkoret en position.

n Klicka på uppåt- eller nedåtstreckpilen för att flytta det valda villkoret högst upp eller längst ned
på listan.

4. Klicka på OK för att spara ändringarna och återgå till fliken Gene Expression (Genuttryck).
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Ändra färginställningarna för Target (Mål) och Sample (Prov)

Obs! Det här alternativet är endast tillgängligt för genuttrycksdiagram.

Använd dialogrutan Color Settings (Färginställningar) för att ändra färg för ett mål eller prov, eller för att ta
bort objektet från diagrammet.

Så här ändrar du färginställningar

1. Välj Color Settings (Färginställningar) i diagramverktygen.

Dialogrutan Color Settings (Färginställningar) visas.

2. För att ändra visningsfärgen för ett mål eller prov klickar du på dess färg i kolumnen Color (Färg).

3. Välj en ny färg i dialogrutan Color (Färg) som visas och klicka på OK.

4. Du kan ta bort objektet från genuttrycksdiagrammet genom att avmarkera dess kryssruta i kolumnen
Show Chart (Visa diagram).

Tips: Du kan ta bort alla objekt från genuttrycksdiagrammet genom att avmarkera kryssrutan
Show Chart (Visa diagram) i kolumnrubriken.

5. (Valfritt) Som standard visas stapeldiagramsfärgen i gradientform. För att visa färgen som enfärgad
väljer du Use Solid Colors (Använd enfärgat).

6. Klicka på OK för att spara ändringarna och återgå till fliken Gene Expression (Genuttryck).
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Förstora ett område i diagrammet
Så här förstorar du ett område i diagrammet

u Klicka på och dra över diagrammet och klicka sedan på Zoom (Zooma in)*. Programvaran ändrar
storleken på diagrammet och centrerar det på det valda området.

Obs! *I Bar Chart (Stapeldiagram) behöver du inte klicka på popup-kommandot Zoom (Zooma
in).

Så här återställer du diagrammet till fullständig vy

u Högerklicka i diagrammet och välj Set Scale to Default (Ställ in standardskala).

Kopiera diagram till en Microsoft-fil
Du kan kopiera datadiagram till Microsoft Word-, Excel- eller PowerPoint-dokument. Bildupplösningen är
densamma som på skärmen som bilden hämtades från.

Så här kopierar du diagram till en Microsoft-fil

1. I fönstret Data Analysis (Dataanalys), klicka på Copy To Clipboard (Kopiera till urklipp) i övre högra
hörnet i diagramrutan.

2. Öppna en tomMicrosoft-fil och klistra in innehållet från urklipp.

Gemensamma alternativ på högerklicksmenyer för diagram
I Tabell 15 visas menyalternativ som du kan högerklicka på och som är tillgängliga i tabeller. Några av
posterna visas för alla diagram, inklusive poster för att ändra hur data visas eller för enkel export av data
från ett diagram.

Alternativ Funktion

Copy (Kopiera) Kopierar diagrammet till urklipp.

Save Image As (Spara
bild som)

Sparar bilden i en viss storlek, upplösning och filtyp, inklusive PNG
(standard), JPG och BMP.

Page Setup
(Utskriftsformat)

Visar alternativ för utskriftsinställningar.

Print (Skriv ut) Skriver ut tabellen.

Tabell 15. Alternativ på högerklicksmenyn för diagram
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Alternativ Funktion

Set Scale to Default
(Ange skala som
standard)

Återställer diagrammets standardvy efter förstoring av diagrammet.

Chart Options
(Diagramalternativ)

Öppnar fönstret Chart Options (Diagramalternativ) för att ändra tabellen,
inklusive namnet, val av gränser för x- och y-axeln samt visning av
rutnätslinjer och mindre hjälpstreck på axlarna.

Obs! Menyalternativ som gäller för specifika diagram beskrivs i Kapitel 11, Dataanalysinformation.
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Kalkylblad
Kalkylbladen som visas i Data Analysis (Dataanalys) har alternativ för sortering och överföring av data.
Sorterar kolumnerna genom en av följande metoder:

n Klicka och dra en kolumn till en ny plats i den valda tabellen.

n Klicka på kolumnrubriken för att sortera data i stigande eller fallande ordning.

Så här sorterar du upp till tre datakolumner i fönstret Sort (Sortera)

1. Högerklicka i kalkylbladet och välj Sort (Sortera).

2. Välj det första kolumnnamnet för att sortera i dialogrutan Sort (Sortera). Sorterar data i stigande eller
fallande ordning.

3. Välj en andra och tredje kolumn för att sortera och välj Ascending (Stigande) eller Descending
(Fallande).

4. Klicka på OK för att sortera uppgifterna eller klicka på Cancel (Avbryt) för att stoppa sorteringen.

Tips: Markera data på associerade diagram och brunnsväljaren genom att hålla muspekaren över
en cell. Klicka i en cell för att kopiera och klistra in dess innehåll till ett annat program.

Gemensamma alternativ på högerklicksmenyer för kalkylblad
I Tabell 16 visas alternativ på högerklicksmenyn som är tillgängliga i alla kalkylbladsvyer.

Alternativ Funktion

Copy (Kopiera) Kopierar innehållet för de valda brunnarna till urklipp klistrar du in
innehållet i ett kalkylblad som Excel.

Copy as Image (Kopiera som
bild)

Kopierar kalkylbladsvyn som en bildfil och klistrar in den i en fil som
accepterar bildfiler, till exempel text-, bild- eller kalkylbladsfiler.

Print (Skriv ut) Skriver ut aktuell vy.

Print Selection (Skriv ut
markering)

Skriver ut aktuell markering.

Export to Excel (Exportera till
Excel)

Exporterar data till ett Excel-kalkylblad.

Export to Text (Exportera till text) Exporterar uppgifterna till en textredigerare.

Tabell 16. Alternativ på högerklicksmenyn för kalkylblad
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Alternativ Funktion

Export to CSV (Exportera till
CSV)

Exporterar data till en .csv-fil.

Export to Xml (Exportera till Xml) Exporterar data till en .xml-fil.

Export to Html (Exportera till
Html)

Exporterar data till en .html-fil.

Find (Sök) Söker efter text.

Sort (Sortera) Sorterar data i upp till tre kolumner.

Select Columns (Välj kolumner) Välj kolumner som ska visas på kalkylbladet.

Tabell 16. Alternativ på högerklicksmenyn för kalkylblad, forts.
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Export
I CFX Maestro Dx SE finns flera exportalternativ tillgängliga på den nedrullningsbara menyn Export:

n Export All Data Sheets (Exportera alla datablad)

n Export RDML Files (Exportera RDML-filer)

n Custom Export (Anpassad export)

n Export to LIMS Folder (Exportera till LIMS-mapp)

n Manual Export (Manuell export)

Exportera alla datablad
Du kan exportera alla kalkylbladsvyerna från alla flikar i CFX Maestro Dx SE till enskilda filer.

Så här exporterar du alla datablad

u Välj Export > Export All Data Sheets (Exportera > Exportera alla datablad) och välj önskad filtyp:

n CSV (*.csv)

n Text (*.txt)

n Excel Workbook ( *.xlsx) (Excel-arbetsbok)

Exporterade analyser sparas i flera Excel-arbetsböcker med en kalkylflik med analysdata per fil.
När en analys innehåller flera fluoroforer exporteras data från varje fluorofor till ett separat
kalkylblad.

n Excel Workbook - combined ( *.xlsx) (Excel-arbetsbok – kombinerad)

Exporterade analyser sparas i en enda Excel-arbetsbok som innehåller flera kalkylblad, ett för
varje analysdatauppsättning.

n Excel 97 - 2003 ( *.xls)

Viktigt! Din dator måste ha Microsoft Excel installerat för att du ska kunna exportera data till
ett Microsoft Excel-kalkylblad.

n Xml (*.xml)
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Exportera RDML-filer
RDML är en strukturerad och universell datastandard för utbyte av kvantitativa PCR (qPCR)-data.
Datastandarden är en textfil i formatet Extensible Markup Language (.xml). Gå till webbplatsen
International RDML Consortium (www.rdml.org) för ytterligare information om RDML-formatet för
datautbyte.

Viktigt! Exporterade RDML-filer inkluderar analysdata med de baslinjeinställningar som du
använder i fönstret Data Analysis (Dataanalys). För mer information om baslinjeinställningar, se
Baslinjeinställningar på sidan 193.

Obs! Spara RDML-filen som version 1.1 om du använder version 2.3 eller senare av programvaran
qbase+.

Så här exporterar du en RDML-fil

1. Välj Export > Export RDML Files (Exportera > Exportera RDML-fil) och välj RDML v1.1 eller RDML
v1.0 från listan som visas.

Dialogrutan Save As (Spara som) visas.

2. I dialogrutan Save As (Spara som) anger du ett filnamn och en plats där RDML-filen ska sparas.

3. Klicka på OK för att spara exportfilen.
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Skapa en anpassad exportfil
Så här skapar du en anpassad exportfil

1. Välj Export > Custom Export (Exportera > Anpassad export). Dialogrutan Custom Export (Anpassad
export) öppnas.

2. Välj exportformat i listrutan som visas.

3. Markera kryssrutorna för objekten som ska exporteras.

4. (Valfritt:) Klicka på Customize Column Names (Anpassa kolumnnamn) för att ändra kolumnnamnen.

5. Klicka på Export (Exportera). Dialogrutan Save As (Spara som) visas.

6. I dialogrutan Save As (Spara som) anger du ett filnamn och en plats där den exporterade filen ska
sparas.
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7. Klicka på OK för att spara exportfilen.
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Exportera till en LIMS-mapp
Du kan exportera data till ett LIMS-kompatibelt filformat. Se Bilaga C, LIMS-integrering för mer
information om hur du skapar, hanterar och använder LIMS-filer.

Så här exporterar du data i LIMS-format

1. Välj Export > Export to LIMS Folder (Exportera > Exportera till LIMS-mapp).

Dialogrutan Save As (Spara som) visas.

2. I dialogrutan Save As (Spara som) anger du ett filnamn och en plats där den exporterade filen ska
sparas.

3. Klicka på OK för att spara exportfilen.

Exportera Seegene-formaterade data
Du kan exportera data från alla kalkylbladsvyer till Excel-filer som är strukturerade särskilt för användning
av Seegene, Inc.

Tips: Du kan också starta Seegene Viewer automatiskt när exporten är klar. Se Kommandon på
menyn Tools (Verktyg) på sidan 65 för mer information.

Så här exporterar du data i ett Seegene-specifikt format

1. Välj Export > Manual Export (Exportera > Manuell export).

Dialogrutan Browse For Folder (Sök efter mapp) visas.

2. I dialogrutan Browse For Folder (Sök efter mapp) anger du en plats där de exporterade Seegene-
formaterade Excel-filerna ska sparas (.xlsx).

Analyserna exporteras till flera Excel-arbetsböcker med ett kalkylblad per fil.

3. Klicka på OK för att spara exportfilerna.
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Kapitel 11 Dataanalysinformation
Fönstret Data Analysis (Dataanalys) i CFX Maestro Dx programvara, Security Edition innehåller flera
flikar som du kan visa data från. I det här kapitlet ges en detaljerad beskrivning av de flikarna.

Tips: Du kan välja vilka flikar som ska visas i fönstret Data Analysis (Dataanalys) på menyn View
(Visa). Den anpassade layouten sparas med datafilen.
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Fliken Quantification (Kvantifiering)
Använd data på fliken Quantification (Kvantifiering) för att ange dataanalysvillkor, inklusive
baslinjeinställningar för individuella brunnar och tröskelinställningar. Fliken Quantification (Kvantifiering)
visar data i dessa fyra vyer:

n Amplification chart (Amplifieringsdiagram) – visar de relativa fluorescenserna (RFU) för varje brunn
vid varje cykel. Varje kurva i diagrammet representerar data från en enskild fluorofor i en brunn.

n Standard Cure (Standardkurva) – visas endast om körningen inkluderar brunnar som har utsetts till
provtypsstandard (Std). Standardkurvan visar tröskelcykeln plottad mot loggen för den inledande
mängden. Förklaringen visar Reaction Efficiency (E) (Reaktionseffektivitet (E)) för varje fluorofor i
brunnarna med ett prov av typen Standard.

n Brunnsväljare – väljer brunnarna med fluorescensdata som du vill visa.

n Kalkylblad – visar ett kalkylblad för data som har samlats in för valda brunnar.

Fluoroforalternativ
För att visa fluorofordata i diagram och kalkylblad på fliken Quantification (Kvantifiering) väljer du
målfluoroforer under diagrammet Amplification (Amplifiering). För att dölja fluoroforinformation i
dataanalysfönstret avmarkerar du motsvarande kryssruta.
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Dialogrutan Trace Styles (Kurvutseenden)
I dialogrutan Trace Styles (Kurvutseenden) kan du justera utseendet på kurvorna i diagrammen
Amplification (Amplifiering) och Melt Curve (Smältkurva) på flikarna Quantification (Kvantifiering) och Melt
Curve (Smältkurva). Sedan kan du förhandsgranska ändringarna i brunnväljaren som visas i dialogrutan
Trace Styles (Kurvutseenden).

Så här justerar du kurvutseenden

1. Välj bara en fluorofor under diagrammet Amplification (Amplifiering).

2. Gör något av följande för att öppna dialogrutan Trace Styles (Kurvutseenden):

n Klicka på Trace Styles (Kurvutseenden) i diagrammet Amplification (Amplifiering).

n Välj Settings > Trace Styles (Inställningar > Kurvutseenden) på menyraden Data Analysis
(Dataanalys).

n Högerklicka på en kurva och välj Trace Styles (Kurvutseenden).

Dialogrutan Trace Styles (Kurvutseenden) öppnas.

3. I dialogrutan Trace Styles (Kurvutseenden) väljer du en specifik uppsättning brunnar i brunnväljaren i
nedre delen av fönstret. Eller välj brunnar som innehåller en provtyp i den nedrullningsbara menyn i
kolumnenWells (Brunnar).

4. Gör något av följande:
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n Välj en färg på de valda brunnarna genom att klicka i rutan i kolumnen Color (Färg).

n Tilldela en symbol till de valda brunnarna genom att välja en symbol i listrutan Symbol.

n Välj snabbt en färg på brunnarna efter knappetikett genom att klicka på lämplig snabbinställning:

o Random byWell (Slumpmässig efter brunn)

o Random by Replicate (Slumpmässig efter replikat)

o Use Fluor Colors (Använd fluorfärger)

o Use Target Colors (Använd målfärger)

o Use Sample Colors (Använd provfärger)

n Tilldela brunnsetiketter genom att välja Sample Type (Provtyp), Target Name (Målnamn),
Sample Name (Provnamn) eller Symbol.

Alternativet Log Scale (Logaritmisk skala)
Välj Log Scale (Logaritmisk skala) under diagrammet Amplification (Amplifiering) för att visa
fluorescenskurvorna i en semilogaritmisk skala:

Tips: För att förstora en del av diagrammet drar du över målområdet. För att återgå till fullständig vy
högerklickar du i diagrammet och väljer Set Scale to Default (Ange skala som standard).
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Standardkurvdiagram
Programmet skapar ett diagram för Standard Curve (Standardkurva) på fliken Quantification
(Kvantifiering) om data inkluderar provtyper som definieras som Std (Standard) för minst en fluorofor i
körningen.

I diagrammet Standard Curve (Standardkurva) visas följande information:

n Namn på varje kurva (fluoroforen eller målet).

n Färg på varje fluorofor eller mål.

n Reaktionseffektivitet (E). Använd denna statistik för att optimera en multiplexreaktion och för att
utjämna data för en standardkurva.

Obs! Reaktionseffektiviteten beskriver hur stor del av ditt mål som produceras vid varje cykel i
protokollet. En effektivitet på 100 % indikerar att du fördubblar ditt mål vid varje cykel.

n Bestämningskoefficient, R2 (skrivs som R^2). Använd denna statistik för att bestämma hur korrekt
linjen beskriver data (hur god passformen är).

n Slope (Lutning)

n y-skärning
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Menyalternativ i Amplification Chart (Amplifieringsdiagram)
Förutom de gemensamma alternativen på högerklicksmeny för diagram (se Gemensamma alternativ på
högerklicksmenyer för diagram på sidan 207) finns det tillgängliga menyalternativ på diagrammet
Amplification (Amplifiering), dessa anges i Tabell 17.

Menyalternativ Funktion

Well XX, Fluor Target
(Brunn XX, Fluormål)

Visar endast denna brunn, tar bort denna brunn från vyn, ställer in färg på
denna kurva, eller utesluter denna brunn från analys.

Selected Traces (Valda
kurvor)

Visar endast dessa brunnar, tar bort dessa brunnar från vyn, ställer in färg
på dessa kurvor, eller utesluter dessa brunnar från analys.

Show Threshold Values
(Visa tröskelvärden)

Visar tröskelvärdet för varje amplifieringskurva i diagrammet.

Trace Styles
(Kurvutseenden)

Öppnar fönstret Trace Styles (Kurvutseenden) för att ändra
kurvutseenden som visas på flikarna Quantification (Kvantifiering) och
Melt Curve (Smältkurva).

Baseline Thresholds
(Baslinjetrösklar)

Öppnar fönstret Baseline Thresholds (Baslinjetrösklar) för att ändra
baslinjen eller trösklar för respektive fluorofor (ändringar visas i
diagrammet Amplification (Amplifiering) på fliken Quantification
(Kvantifiering)).

Tabell 17. Alternativ på höger- och vänsterklicksmenyn i diagrammet Amplification
(Amplifiering)

Kalkylbladet Quantification (Kvantifiering)
I Tabell 18 definieras data som visas i kalkylbladet på fliken Quantification (Kvantifiering).

Information Beskrivning

Well (brunn) Brunnsposition i plattan

Fluor (Fluorofor) Fluorofor detekterad

Target (Mål) Målnamn som laddats i brunnarna i Plate Editor (Plattredigerare)

Content (Innehåll) En kombination av Sample Type (Provtyp) (obligatoriskt) och Replicate
# (Replikatnummer) (valfritt) som laddas i Plate Editor (Plattredigerare)

Tabell 18. Innehåll i kalkylbladet på fliken Quantification (Kvantifiering)
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Information Beskrivning

Sample (Prov) Provnamn som laddats i brunnarna i Plate Editor (Plattredigerare)

Cq Kvantifieringscykel för varje kurva

Ändra mål-, innehåll- eller provdata

Du kan ändra data i kolumnerna Target (Mål), Content (Innehåll) och Sample (Prov) genom att redigera
plattfilen med hjälp av Plate Editor (Plattredigeraren) även efter att du har avslutat experimentet.

Så här ändrar du data i kolumnerna Content (Innehåll), Target (Mål) och Sample (Prov)

u Klicka på Plate Setup (Plattinställning) och välj sedan View/Edit Plate (Visa/redigera platta) för att
öppna Plate Editor (Plattredigerare).
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Fliken Quantification Data (Kvantifieringsdata)
Fliken Quantification Data (Kvantifieringsdata) visar kvantifieringsdata som samlats in i varje brunn.
CFX Maestro Dx SE visar data i fyra olika kalkylbladsvyer:

n Results (Resultat) – visar ett kalkylblad med uppgifterna. Det här är standardvyn.

n Standard Curve Results (Standardkurvresultat) – visar ett kalkylblad för standardkurvan.

n Plate (Platta) – visar data i varje i brunn som plattkarta.

n RFU – visar RFU-mängder i varje brunn för varje cykel.

Välj enskilda kalkylblad från listrutan som visas under fliken Quantification Data (Kvantifieringsdata).

Kalkylbladet Results (Resultat)
Kalkylbladet Results (Resultat) visar data för varje brunn i plattan.

Obs! Alla beräkningar av Std. Dev (Standardavvikelse) tillämpas på replikatgrupper som har tilldelas
i brunnarna i fönstret Plate Editor (Plattredigerare). Beräkningarna ger Cq-medelvärdet för varje
brunn i replikatgruppen.

I Tabell 19 definieras data som visas i kalkylbladet Results (Resultat).

Information Beskrivning

Well (brunn) Brunnsposition i plattan

Fluor (Fluorofor) Fluorofor detekterad

Tabell 19. Innehåll i kalkylbladet Results (Resultat)
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Information Beskrivning

Target (Mål) Namn på amplifieringsmål (gen)

Content (Innehåll) Provtyp och replikatnummer

Sample (Prov) Provbeskrivning

Biological Set Name (Namn på
biologisk uppsättning)

Namn på biologisk uppsättning

Cq Kvantifieringscykel

CqMean (Cq-medelvärde) Medelvärde för replikatgruppens kvantifieringscykel

Cq Std. Dev (Cq-
standardavvikelse)

Standardavvikelse för replikatgruppens kvantifieringscykel

Starting Quantity (SQ)
(Startkvantitet)

Uppskattning av målets startkvantitet

Log Starting Quantity (Logg för
startkvantitet)

Logg för startkvantitet

SQ Mean (Medelvärde för
startkvantitet)

Medelvärde för startkvantitet

SQ Std. Dev (Cq-
standardavvikelse för
startkvantitet)

Standardavvikelse för startkvantiteten för flera replikat

Tabell 19. Innehåll i kalkylbladet Results (Resultat), forts.
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Kalkylbladet Standard Curve Results (Standardkurvresultat)
I kalkylbladet Standard Curve Results (Standardkurvresultat) visas den beräknade standardkurvans
parametrar.

I Tabell 20 definieras data som visas i kalkylbladet Standard Curve Results (Standardkurvresultat).

Information Beskrivning

Fluor (or Target) (Fluor eller Mål) Fluorofor (eller Mål) detekterat

Efficiency (Effektivitet) % Reaktionseffektivitet

Slope (Lutning) Standardkurvans lutning

Y-intercept (Y-skärningspunkt) Punkt där kurvan skär y-axeln

R^2 Bestämningskoefficient

Tabell 20. Innehåll i kalkylbladet Standard Curve Results (Standardkurvresultat)
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Kalkylbladet Plate (Platta)
I kalkylbladet Plate (Platta) visas en plattkarta över data för en fluorofor i taget.

Så här visar du data för en specifik fluorofor

u Klicka på dess flik längst ned i kalkylbladet.
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Kalkylbladet RFU
I kalkylbladet RFU visas avläsningarna av de relativa fluorescensenheterna (RFU) för varje brunn som
erhållits under varje cykel i körningen. Brunnsnumret visas högst upp i varje kolumn och cykelnumret
visas till vänster om varje rad.
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Fliken Melt Curve (Smältkurva)
När det gäller DNA-bindande färger och ej klyvbara hybridiseringsprober är fluorescensen starkast när de
två DNA-strängarna hybridiseras. Efterhand som temperaturen stiger mot smälttemperaturen (Tm),
sjunker därför fluorescensen med en konstant hastighet (konstant lutning). Vid Tm sker en dramatisk
reduktion av fluorescensen med en märkbar förändring av lutning. Hastigheten för denna förändring
bestäms genom plottning av den negativa första regressionen av fluorescens jämfört med temperatur (-d
(RFU)/dT). Den största förändringshastigheten av fluorescens leder till synbara toppar och representerar
Tm av de dubbelsträngade DNA-komplexen.

CFX Maestro Dx SE plottar RFU-data som samlats in under en smältkurva som en funktion av
temperatur. För att analysera smälttoppsdata tilldelar programmet en inledande och avslutande
temperatur till varje topp genom att flytta tröskeln. Botten i toppområdet specificeras av positionen för
smälttröskeln. En giltig topp måste ha en minimihöjd i relation till avståndet mellan tröskeln och höjden på
den högsta toppen.

På fliken Melt Curve (Smältkurva) visas Tm (smälttemperatur) för amplifierade PCR-produkter i fyra vyer:

n Melt Curve (Smältkurva) – visar realtidsdata för varje fluorofor som RFU:er per temperatur för varje
brunn.

n Melt Peak (Smälttopp) – visar den negativa regressionen för RFU-data per temperatur för varje
brunn.

n Well selector (Brunnsväljare) – visar brunnar för att visa och dölja data.

n Peak spreadsheet (Kalkylbladet Topp) – visar data som samlats in i den valda brunnen.

Obs! I detta kalkylblad visas upp till två toppar för varje kurva. Om du vill se fler toppar klickar du
på fliken Melt Curve Data (Smältkurvsdata).
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I Tabell 21 definieras data som visas i kalkylbladet Melt Curve (Smältkurva).

Information Beskrivning

Well (brunn) Brunnsposition i plattan

Fluor (Fluorofor) Fluorofor detekterad

Content (Innehåll) En kombination av provtyp och replikatantal

Sample (Prov) Namn på prov som laddats i Plate Editor (Plattredigerare)

Melt Temp
(Smälttemp)

Temperaturen för smälttoppen för varje brunn

Obs! Endast de två högsta topparna visas i detta kalkylblad.

Tabell 21. Innehåll i kalkylbladet Melt Curve (Smältkurva)
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Justera smältkurvsdata
Så här justerar du smältkurvsdata

u Gör något av följande:

n Klicka på och dra tröskelvärdesstaplarna i diagrammet Melt Peak (Smälttopp) för att inkludera
eller exkludera toppar i dataanalysen.

n Välj Positive (Positiva) på den nedrullningsbara menyn Peaks (Toppar) för att visa
kalkylbladsdata för toppar över smälttröskelvärdeslinjen, eller välj Negative (Negativa) för att
visa kalkylbladsdata för toppar under smälttröskelvärdeslinjen.

n Öppna fönstret Trace Styles (Kurvutseenden) där du kan ändra färgen på kurvorna i
diagrammen Melt Curve (Smältkurva) och Melt Peak (Smälttopp).

n Välj ett nummer i väljaren Step Number (Stegnummer) för att visa data för Melt Curve
(Smältkurva) i ett annat steg i protokollet. Listan visar fler än ett steg om protokollet innehåller
plattavläsningar i fler än ett smältkurvsteg.

n Välj brunnar i brunnsväljaren för att fokusera på delmängder av data.

n Välj en brunnsgrupp för att visa och analysera en delmängd av brunnarna i plattan. Välj varje
brunnsgrupp efter namn i den nedrullningsbara menynWell Group (Brunnsgrupp) i
verktygsraden.
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Fliken Melt Curve Data (Smältkurvsdata)
På fliken Melt Curve Data (Smältkurvsdata) visas data från fliken Melt Curve (Smältkurva) i flera
kalkylblad, som innehåller alla smältpunkter för varje kurva. CFX Maestro Dx SE erbjuder fyra
kalkylbladsalternativ för att visa smältkurvsdata:

n Melt Peaks (Smälttoppar) – visar alla data, däribland alla smälttoppar, för varje kurva. Det här är
standardvyn.

n Plate (Platta) – visar en vy av data och innehåll för varje brunn i plattan.

n RFU – visar RFU-kvantiteterna vid varje temperatur för varje brunn.

n -d(RFU)/dT – visar den negativa förändringshastigheten i RFU när temperaturen (T) ändras. Det här
är det första regressionsdiagrammet för varje brunn i plattan.

Välj varje kalkylblad i listrutan som visas under fliken Melt Curve Data (Smältkurvsdata).

Kalkylbladet Melt Peaks (Smälttoppar)
Kalkylbladet Melt Peaks (Smälttoppar) visar alla smältkurvsdata.

I Tabell 22 på sidan 233 definieras de data som visas i kalkylbladet Melt Peaks (Smälttoppar).
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Fliken Melt Curve Data (Smältkurvsdata)

Information Beskrivning

Well (brunn) Brunnsposition i plattan

Fluor (Fluorofor) Fluorofor detekterad

Content (Innehåll) Provtyper listade i fönstret Plate Editor (Plattredigerare)

Target (Mål) Amplifieringsmål (gen)

Sample (Prov) Provnamn listat i fönstret Plate Editor (Plattredigerare)

Melt Temperature
(Smälttemperatur)

Smälttemperatur för varje produkt, listad som en topp (högsta) per
rad i kalkylbladet

Peak Height (Topphöjd) Toppens höjd

Begin Temperature
(Starttemperatur)

Temperatur vid början av toppen

End Temperature (Sluttemperatur) Temperatur vid slutet av toppen

Tabell 22. Innehåll i kalkylbladet Melt Peaks (Smälttoppar)

Kalkylbladet Plate (Platta)
Kalkylbladet Plate (Platta) visar smältkurvsdata i ett plattformat.

Obs! För att justera vilken topp programvaran anropar justerar du tröskellinjen i diagrammet Melt
Peak (Smälttopp) på fliken Melt Curve (Smältkurva).

I Tabell 23 på sidan 234 definieras data som visas i kalkylbladet Plate (Platta).
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Information Beskrivning

Content (Innehåll) Kombination av Sample Type (Provtyp) och Replicate # (Replikatnummer). Provtyp
är obligatoriskt medan replikat är valfritt.

Sample (Prov) Provbeskrivning

Peak 1 (Topp 1) Första smälttopp (högsta)

Peak 2 (Topp 2) Andra smälttopp (lägre)

Tabell 23. Innehåll i kalkylbladet Plate (Platta)

Kalkylbladet RFU
I kalkylbladet RFU visas fluorescensen för varje brunn vid varje cykel som erhållits under smältkurvan.

I Tabell 24 definieras data som visas i RFU-kalkylbladet.

Information Beskrivning

Well Number (Brunnsnummer) (A1, A2, A3,
A4, A5)

Brunnsposition i plattan för de laddade
brunnarna

Temperature (Temperatur) Smältpunkten för det amplifierade målet, plottad
som en brunn per rad och flera brunnar för flera
produkter i samma brunn

Tabell 24. Innehåll i kalkylbladet RFU
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Fliken Melt Curve Data (Smältkurvsdata)

Kalkylbladet -d(RFU)/dT
Kalkylbladet -d(RFU)/dT visar det negativa förändringsvärdet i RFU när temperaturen (T) ändras.

I Tabell 25 definieras data som visas i kalkylbladet -d(RFU)/dT.

Information Beskrivning

Well Number (Brunnsnummer) (A1, A2,
A3, A4, A5)

Brunnsposition i plattan för de laddade brunnarna

Temperatur -d(RFU)/dT Negativt förändringsvärde i RFU när temperaturen (T) ändras

Tabell 25. Innehåll i kalkylbladet -d(RFU)/dT
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Fliken End Point (Slutpunkt)
Öppnar fliken End Point (Slutpunkt) för analys av slutliga RFU (Relative Fluorescence Units) för
provbrunnarna. Programvaran jämför RFU-nivåerna för brunnar med okända prover med RFU-nivåerna
för brunnar med negativa kontroller och ”benämner” de okända som positiva eller negativa. Positiva
prover har ett RFU-värde som är större än det genomsnittliga RFU-värdet för de negativa kontrollerna
plus gränsvärdet (cutoff-värdet).

För att analysera slutpunktsdata måste plattan innehålla negativa kontroller, annars kan inte
programvaran göra bestämningen.

n Kör ett protokoll av typen Quantification (Kvantifiering) – ställ in ett standardprotokoll. När körningen
är klar öppnar du fönstret Data Analysis (Dataanalys), justerar dataanalysinställningarna på fliken
Quantification (Kvantifiering) och klickar på fliken End Point (Slutpunkt) för att välja en
slutpunktscykel.

n Protokollet End Point Only (Endast slutpunkter) – läs in protokollet End Point Only (Endast
slutpunkter) på fliken Plate (Platta) i fönstret Run Setup (Körningsinställning), välj eller skapa en
platta och starta körningen.
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Fliken End Point (Slutpunkt)

På fliken End Point (Slutpunkt) visas de genomsnittliga RFU-värdena för bestämning av huruvida målet
har amplifierats av den senaste (slut-) cykeln. Bestämmed hjälp av dessa data huruvida en specifik
målsekvens förekommer (positiv) i ett prov. Positiva mål har högre RFU-värden än det gränsvärde (cutoff-
värdet) du definierar.

Tips: Du skapar ett slutpunktsprotokoll genom att öppna fliken Protocol (Protokoll) (i fönstret Run
Setup (Körningsinställning)) och välja Run > End Point Only Run (Kör > Körning av endast
slutpunkter).

När körningen är klar öppnas datafilen på fliken End Point (Slutpunkt), som består av följande avsnitt:

n Settings (Inställningar) – justerar dataanalysinställningarna.

n Results (Resultat) – visar resultaten omedelbart efter att du har justerat inställningarna.

n Well Selector (Brunnsväljare) – väljer brunnarna med de slutpunktsdata som du vill visa.

n RFU spreadsheet (RFU-kalkylblad) – visar slut-RFU som samlats in i de valda brunnarna.

Resultatdata
Avsnittet Results (Resultat) visar följande data:

n Lowest RFU value (Lägsta RFU-värde) – lägsta RFU-värde i data

n Highest RFU value (Högsta RFU-värde) – högsta RFU-värde från data

n Negative Control Average (Genomsnitt för negativ kontroll) – genomsnittligt RFU för brunnar som
innehåller negativa kontroller

n Cut Off Value (Gränsvärde) – beräknas genom att toleransen (RFU eller andel av intervall som anges
i inställningarna) och medelvärdet för de negativa kontrollerna läggs till. Prover med RFU:er som är
större än gränsvärdet kallas ”Positiv”. Så här justerar du gränsvärdet, ändrar RFU eller andel av
intervall

Gränsvärdet beräknas med följande formel:

Gränsvärde = Genomsnitt för negativ kontroll + tolerans

Välj en tolerans med någon av följande metoder:

n RFUs (default) (RFU:er, standard) – välj den här metoden för att använda ett absolut RFU-värde för
toleransen. Det lägsta RFU-toleransvärdet är 2. Max är det absoluta värdet för det högsta RFU-
värdet minus det absoluta värdet för det lägsta RFU-värdet. RFU-standardtoleransvärdet är 10 % av
det totala RFU-intervallet.
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n Percent of Range (Andel av intervall) – välj den här metoden för att använda en andel av RFU-
intervallet för toleransen. Den lägsta andelen av intervallet är 1 %. Den högsta andelen av intervallet
är 99 %. Standardandelen av intervallet är 10 %.
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Fliken End Point (Slutpunkt)

Justera slutpunktsdataanalys
Så här justerar du data på fliken End Point (Slutpunkt)

u Gör något av följande:

n Välj en fluorofor i listrutan.

n Välj ett värde för End Cycle Average (Slutcykel för beräkning av medeltal) för att ställa in antalet
cykler som ska användas för att beräkna medeltalet av slutpunkts-RFU.

n Välj RFUs för att visa data i Relative Fluorescence Units.

n Välj Percentage of Range (Andel av intervall) för att visa data som en andel av RFU-intervallet.

n Välj brunnar i brunnsväljaren för att fokusera på delmängder av data.

n Välj en brunnsgrupp för att visa och analysera en delmängd av brunnarna i plattan. Välj varje
brunnsgrupp efter namn i den nedrullningsbara menynWell Group (Brunnsgrupp) i
verktygsraden.

RFU-kalkylblad för analys av End Point (Slutpunkt)
Tabell 26 definierar data som visas i RFU-kalkylbladet på fliken End Point (Slutpunkt).

Information Beskrivning

Well (brunn) Brunnsposition i plattan

Fluor (Fluorofor) Fluorofor detekterad

Content (Innehåll) Kombination av Sample Type (Provtyp) och Replicate # (Replikatnummer)

End RFU (Slut-RFU) RFU vid slutpunktscykeln

Call (Bestämning) Positive (Positiv) eller Negative (Negativ), där positiva prover har ett RFU-
värde som är större än genomsnitts-RFU för de negativa kontrollerna plus
Cut Off Value (Gränsvärde)

Sample (Prov) Sample Name (Provnamn) laddat i Plate Editor (Plattredigerare)

Tabell 26. Innehåll i kalkylbladet RFU End Point (Slutpunkt)

Användarhandbok | 239



Kapitel 11 Dataanalysinformation

Fliken Allelic Discrimination (Allelisk diskriminering)
Fliken Allelic Discrimination (Allelisk diskriminering) tilldelar genotyper till brunnar med okända prover.
Använd dessa data för att identifiera prover med olika genotyper, inklusive Allele 1 (Allel 1), Allele 2 (Allel
2), Heterozygote (Heterozygot), No Call (Ingen bestämning) (ingen amplifiering) eller Undetermined
(Obestämd).

Obs! Data för allelisk diskriminering måste komma från multiplexkörningar med minst två fluoroforer.
Varje fluorofor identifierar en allel i alla prover.

Allelisk diskrimineringsanalys kräver minst följande brunnsinnehåll:

n Två fluoroforer i varje brunn

n NTC-prover (no template control) för optimerad dataanalys

CFX Maestro Dx SE erbjuder fyra alternativ för att visa allelisk diskrimineringsdata:

n Diagrammet Allelic Discrimination (Allelisk diskriminering) – visar data i ett RFU-diagram för Allel
1/Allel 2. Varje punkt i diagrammet representerar data från båda fluoroforer i en brunn. Du kan växla
mellan kartesianska och polära koordinater genom att markera och avmarkera kryssrutan Polar
Coordinates (Polära koordinater). Kartesianska koordinater representerar RFU för Allel 1 på x-axeln
och RFU för Allel 2 på y-axeln. Polära koordinater representerar vinkeln på x-axeln och avståndet på
y-axeln mellan RFU och ursprunget (median för alla NTC).
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Fliken Allelic Discrimination (Allelisk diskriminering)

n Brunnskalkylblad – visar allelisk diskrimineringsdata som samlats in i varje brunn i plattan.

n Brunnsväljare – väljer brunnarna med alleliska data som du vill visa.

n Panelen Selected Fluorophores (Utvalda fluoroforer) – ändrar x- och y-axeletiketterna i diagrammet
för Allelic Discrimination (Allelisk diskriminering), cykeln som ska analyseras, och om
bestämningskartan ska visas.

Justera data för allelisk diskriminering
Programvaran tilldelar automatiskt en genotyp till brunnar med okända prover baserat på NTC-
positionerna och vinkeln samt avståndet för de okända datapunkterna från NTC.

Så här justerar du data för allelisk diskriminering

u Gör något av följande:

n Visa polära koordinater genom att markera kryssrutan i diagrammet Allelic Discrimination
(Allelisk diskriminering).

n Visa en annan fluorofor genom att välja den i listrutan i panelen Selected Fluorophores (Valda
fluoroforer).

n Ändra en bestämning genom att dra datapunkterna över diagrammet Allelic Discrimination
(Allelisk diskriminering) och välja ett alternativ i listan Selected Wells (Valda brunnar):

o Allele 1 (Allel 1)

o Allele 2 (Allel 2)

o Heterozygote (Heterozygot)

o Undetermined (Obestämd)

o No Call (Ingen bestämning)

o Auto Call (Automatisk bestämning)

Tips: Välj Auto Call (Automatisk benämning) för att återgå till standardbenämningen.
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Alternativ på diagrammenyn
Förutom de gemensamma alternativen på högerklicksmeny för diagram (se Gemensamma alternativ på
högerklicksmenyer för diagram på sidan 207) finns det tillgängliga menyalternativ på diagrammet Allelic
Discrimination (Allelisk diskriminering), dessa anges i Tabell 27.

Menyalternativ Funktion

Zoom (Zooma in) Fokuserar diagramvyn till det valda området (genom att du klickar på
och drar markören i diagrammet).

Tips: Du återställer zoomningen och visar alla datapunkter
genom att högerklicka och välja Set Scale to Default (Ställ in
standardskala).

Well (Brunn) För den valda brunnen är alternativen: visa endast denna brunn, ta
bort denna brunn från vyn, ställ in färgen på denna kurva och uteslut
denna brunn från analysen.

Selected Wells (Valda brunnar) För de valda brunnarna (väljs genom att du klickar på och drar
markören i diagrammet) är alternativen: visa endast dessa brunnar,
ta bort dessa brunnar från vyn, ställ in färgen på dessa kurvor och
uteslut dessa brunnar från analysen.

Tabell 27. Alternativ på höger- och vänstermenyerna för diagrammet Allelic Discrimination
(Allelisk diskriminering)

Kalkylbladet Allelic Discrimination (Allelisk diskriminering)
I Tabell 28 definieras de data som visas i kalkylbladet Allelic Discrimination (Allelisk diskriminering).

Information Beskrivning

Well (brunn) Brunnsposition i plattan

Sample (Prov) Provnamnsbeskrivning

Call (Bestämning) Allelens identitet, inklusive automatisk Allele 1 (Allel 1), Allele 2 (Allel
2), Heterozygote (Heterozygot), No Call (Ingen bestämning) eller
Undetermined (Obestämd)

Tabell 28. Innehåll i kalkylbladet Allelic Discrimination (Allelisk diskriminering)
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Fliken Allelic Discrimination (Allelisk diskriminering)

Information Beskrivning

Type (Typ) Auto (Automatisk) eller Manual (Manuell), beskriver hur bestämningen
gjordes. Automatisk indikerar att programvaran valde bestämningen.
Manuell indikerar att användaren valde bestämningen

RFU1 RFU för Allel1

RFU2 RFU för Allel2

Tabell 28. Innehåll i kalkylbladet Allelic Discrimination (Allelisk diskriminering), forts.
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Fliken Custom Data View (Anpassad datavisning)
På fliken Custom Data View (Anpassad datavisning) visas flera paneler i ett anpassningsbart format
samtidigt.

Listrutan Load a Preset View (Läs in förinställningsvy) har ett urval av visningsformatmallar. Standardvyn
som visas beror på vilken fil som analyseras. Om det till exempel finns smältkurvsinformation visas
standardvyn Amp+Melt.

244 | CFX Maestro Dx SE programvara



Fliken Custom Data View (Anpassad datavisning)

Skapa en anpassad datavisning
Så här skapar du en anpassad datavisning

u Gör något av följande:

n Välj en alternativ förinställningsvy från listrutan.

n Välj en annan diagramvy från listrutan överst i varje enskild ruta.

n Ändra antalet rader och kolumner på fliken.

n Ändra mått för enskild panel. Dra staplarna i kanten av varje panel.

Klicka på Save as Preset (Spara som förinställning) för att spara den anpassade datavyn som en
förinställd mall. Klicka på Manage Presets (Hantera förinställningar) för att ta bort, byta namn på eller
återställa befintliga förinställningar.

Användarhandbok | 245



Kapitel 11 Dataanalysinformation

Fliken QC (Kvalitetskontroll)
Använd fliken QC (Kvalitetskontroll) för att snabbt bedöma kvaliteten på körningsdata baserat på reglerna
som definieras på fliken QC i fönstret User Preferences (Användarinställningar).

CFX Maestro Dx SE erbjuder fyra alternativ för visning av kvalitetskontrolldata:

n Amplification chart (Amplifieringsdiagram) – visar RFU för varje brunn vid varje cykel. Varje kurva i
diagrammet representerar data från en enskild fluorofor i en brunn.

n QC rules table (Tabell för kvalitetskontrollregler) – visar tillgängliga kvalitetskontrollregler och
inställningar som definierar enskilda regler. Tillämpade kvalitetskontrollregler anges med en bock.

n Well selector (Brunnsväljare) – väljer brunnarna med fluorescensdata som du vill visa.

n Sammanfattningsruta för kvalitetskontrollregel – visar den valda kvalitetskontrollregeln och
markerar brunnar som inte klarar regeln.

Ändra kvalitetskontrollkriterier
Så här ändrar du kvalitetskontrollkriterier

u Markera eller avmarkera kryssrutan Use (Använd) för att inkludera eller exkludera regeln från
kvalitetskontroll.
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Fliken QC (Kvalitetskontroll)

Utesluta brunnar som inte klarar kvalitetskontrollen
CFX Maestro Dx SE visar brunnar som inte klarar kvalitetskontrollkriterier i kolumnen Results (Resultat) i
tabellen QC rules (Kvalitetskontrollregler) och i sammanfattningspanelen.

Så här utesluter du brunnar som inte uppfyller kvalitetskontrollkriterier

u Välj Exclude Wells (Uteslut brunnar) för varje brunn som ska uteslutas.
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Fliken Run Information (Körningsinformation)
På fliken Run Information (Körningsinformation) visas protokollet och annan information om varje körning.
Använd den här fliken för att göra följande:

n Visa protokollet.

n Ange eller redigera anteckningar om körningen.

n Ange eller redigera ID eller streckkod för körningen.

n Visa händelser som kan ha inträffat under körningen. Använd dessa meddelanden som hjälp vid
felsökning av en körning.

Tips: Högerklicka på protokollet för att kopiera, exportera eller skriva ut det. Högerklicka i rutorna
Notes (Anteckningar), ID/Bar Code (ID/Streckkod) eller Other (Övrigt) för att ångra, klippa ut, kopiera,
klistra in, radera eller markera texten.
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Dataanalysrapporter

Dataanalysrapporter
I dialogrutan Report (Rapport) visas information om den aktuella datafilen i fönstret Data Analysis
(Dataanalys). För att öppna en rapport väljer du Tools > Reports (Verktyg > Rapporter) eller klickar på
Reports (Rapporter) i verktygsraden.

Dialogrutan Report (Rapport) innehåller följande avsnitt:

n Meny och verktygsrad – innehåller alternativ för att formatera, spara och skriva ut rapporten eller
mallen.

n Alternativlista (längst upp till vänster i dialogrutan) – innehåller alternativ att visa i rapporten.

n Alternativruta (längst ned till vänster i dialogrutan) – visar textrutor i vilka du kan skriva in information
om ett visst alternativ.

n Förhandsgranskningsruta (till höger i dialogrutan) – visar en förhandsgranskning av den aktuella
rapporten.
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Kategorier för dataanalysrapporter
I Tabell 29 visas alla alternativ som är tillgängliga för en dataanalysrapport beroende på typ av data som
används i fönstret Data Analysis (Dataanalys).

Kategori Alternativ Beskrivning

Header (Rubrik)

Titel, undertitel och logotyp för
rapporten

Report Information
(Rapportinformation)

Körningsdatum, användarnamn,
datafilnamn, datafilsökväg och
vald brunnsgrupp

Audit Information
(Revisionsinformation)

Ytterligare information som
krävs för revision, inklusive
signaturer

Notes (Anteckningar) Anteckningar om datarapporten

Run Setup (Körningsinställning)

Run Information
(Körningsinformation)

Körningsdatum, användarnamn,
datafilnamn, datafilsökväg och
vald brunnsgrupp

Protocol (Protokoll) Textvy av protokollsteg och
alternativ

Plate Display (Plattvy) Plattvy av informationen i varje
brunn för plattan

Quantification (Kvantifiering)

Analysis Settings
(Analysinställningar)

Stegnummer för datainsamling,
analysläge och metod för
baslinjesubtraktion

Amplifiering
(Amplifieringstabell)

Amplifieringstabell för körningar
som inkluderar
kvantifieringsinformation

Tabell 29. Kategorier för dataanalysrapporter i alternativlistan

250 | CFX Maestro Dx SE programvara



Dataanalysrapporter

Kategori Alternativ Beskrivning

Standard Curve Chart
(Standardkurvdiagram)

Standardkurvdiagram

Data Kalkylblad som listar data för
varje brunn

Gene Expression (Genuttryck) – Bar Chart (Stapeldiagram)

Analysis Settings
(Analysinställningar)

Analysläge, diagramdata,
skalalternativ och diagramfel

Chart (Diagram) Kopia av stapeldiagrammet

Target Names (Målnamn) Diagrammed målnamn

Sample Names (Provnamn) Diagrammed provnamn

Data Kalkylblad som listar data för
varje brunn

Target Stability (Målstabilitet) Diagram för målstabilitetsvärden

Box-and-whisker chart
(Låddiagram)

Låddiagram

Dot Plot chart
(Punktdiagram)

Dot plot chart (Punktdiagram)

Gene Expression (Genuttryck) – Clustergram och Scatter Plot (Spridningsdiagram)

Analysis Settings
(Analysinställningar)

Inställningar för respektive typ
av diagram

Chart (Diagram) Kopia av diagrammet

Data Kalkylblad som listar data i varje
mål

Gene Expression (Genuttryck) – ANOVA-data

ANOVA Settings (ANOVA-
inställningar)

P-värdeströskel som används i
analysen

Tabell 29. Kategorier för dataanalysrapporter i alternativlistan, forts.
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Kategori Alternativ Beskrivning

ANOVA Results (ANOVA-
resultat)

Tabell med resultat från ANOVA
och Tukeys HSD (Honestly
Significant Difference) post-hoc-
analys

Melt Curve (Smältkurva)

Analysis Settings
(Analysinställningar)

Inställning för smältstegnummer
och tröskelvärde

Melt Curve Chart (Diagram
för smältkurva)

Diagram för smältkurva

Melt Peak Chart (Diagram för
smälttopp)

Diagram för smälttopp

Data Kalkylblad som listar data för
varje brunn

Allelic Discrimination (Allelisk diskriminering)

Analysis Settings
(Analysinställningar)

Fluoroforer, cykel och visning av
anropskarta

Allelic Discrimination Chart
(Tabell för allelisk
diskriminering)

Kopia av diagrammet för allelisk
diskriminering

Data Kalkylblad som listar data för
varje brunn

End Point (Slutpunkt)

Analysis Settings
(Analysinställningar)

Fluorofor, avslutande cykler vars
medelvärde ska beräknas, läge,
lägsta RFU-värde, högsta RFU-
värde och gränsvärde

Data Kalkylblad som listar data för
varje brunn

Tabell 29. Kategorier för dataanalysrapporter i alternativlistan, forts.
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Kategori Alternativ Beskrivning

QC Parameters
(Kvalitetskontrollparametrar)

Data Kalkylblad som anger
parametrar för varje
kvalitetskontrollregel

Tabell 29. Kategorier för dataanalysrapporter i alternativlistan, forts.
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Skapa en dataanalysrapport
Du kan spara rapportlayouten som en mall och använda den igen för liknande rapporter.

Så här skapar du en dataanalysrapport

1. Gör slutliga justeringar av innehållet i brunnen, valda brunnar, diagram och kalkylblad i fönstret Data
Analysis (Dataanalys) innan du genererar rapporten.

2. Välj Tools > Reports (Verktyg > Rapporter) på menyraden Data Analysis (Dataanalys) för att öppna
dialogrutan Report (Rapport).

3. Välj alternativen du vill inkludera i rapporten. Rapporten öppnas med standardalternativ valda.
Markera eller avmarkera kryssrutorna för att ändra hela kategorier eller enskilda alternativ inom en
kategori.

Se Tabell 29 på sidan 250 för tillgängliga alternativ.

Obs! Data som visas i rapporten beror på aktuella val på flikarna för fönstret Data Analysis
(Dataanalys). En kvantifieringskörning innehåller till exempel inte en standardkurva, och därför
visas dessa data i fönstret Data Analysis (Dataanalys) eller i datarapporten.

4. Ändra ordningsföljden på kategorier och objekt i en rapport. Dra alternativen till motsvarande plats.
Objekt kan bara flyttas inom kategorierna de tillhör.

5. (Valfritt) Ange information som är relevant för det valda alternativet i rutan Report Options
(Rapportalternativ):

n Välj en informationsundergrupp att visa i rapporten.

n Välj specifika inställningar för det valda alternativet.

n Välj text som ska visas för det valda alternativet.

6. Klicka på Update Report (Uppdatera rapport) för att uppdatera Report Preview
(Rapportförhandsgranskning) med eventuella ändringar.

7. Skriv ut eller spara rapporten:

a. Klicka på knappen Print Report (Skriv ut rapport) i verktygsraden för att skriva ut den aktuella
rapporten.

b. Välj File > Save (Arkiv > Spara) för att spara rapporten i filformatet PDF (Adobe Acrobat Reader-
fil), MHT (Microsoft-dokument) eller MHTML (Microsoft-dokument).

c. Välj en plats där filen ska sparas.

d. Välj File > Save As (Arkiv > Spara som) för att spara rapporten med ett nytt namn eller på en ny
plats.
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8. (Valfritt) Skapa en rapportmall med den information du vill ha. För att spara de aktuella
rapportinställningarna i en mall väljer du Template > Save (Mall > Spara) eller Save As (Spara som).
Hämta sedan rapportmallen nästa gång du vill skapa en ny rapport.
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Skapa Well Group Reports (Brunnsgrupprapporter)
Så här skapar du en brunnsgrupprapport

1. Välj Tools > Well Group Reports (Verktyg > Brunnsgruppsrapporter) i fönstret Data Analysis
(Dataanalys).

2. I dialogrutan Well Groups Reports (Brunnsgrupprapporter) väljer du de brunnsgrupper,
amplifieringssteg och smältsteg som ska ingå i rapporten.

3. Ange sökvägen eller gå till destinationsmappen där rapporten ska sparas.

4. (Valfritt) Välj Choose a Report Template (Välj en rapportmall) och gå till mallfilmappen.

5. (Valfritt) Välj Open Destination Folder (Öppna destinationsmapp) för att öppna mappen och visa
rapporterna när de har skapats.

6. Klicka på Create Reports (Skapa rapporter).
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Med användning av strikt kvalificerade kontroller i dina reaktioner kan du använda CFX Maestro Dx
programvara, Security Edition för att utföra en genuttryckskörning för att normalisera de relativa
skillnaderna i en målkoncentration bland prover. Vanligtvis används uttrycksnivåer för en eller flera
referensgener för att normalisera uttrycksnivåerna för en intressant gen. Referensgener tar hänsyn till
laddningsskillnader eller andra variationer som representeras i respektive prov och deras uttrycksnivåer
bör inte påverkas i det biologiska systemet som studeras.

Välj fliken Gene Expression (Genuttryck) i fönstret Data Analysis (Dataanalys) för att utvärdera relativa
skillnader mellan PCR-reaktioner i två eller flera brunnar. Du kan till exempel utvärdera relativt antal
virusgenom eller relativt antal transfekterade sekvenser i en PCR-reaktion. Det vanligaste
användningsområdet för genuttrycksstudier är jämförelsen av cDNA-koncentration i fler än en reaktion för
att uppskatta nivåerna av budbärar-RNA i steady state.

Programvaran beräknar den relativa uttrycksnivån för ett mål med ett av dessa scenarier:

n Relativ uttrycksnivå för en målsekvens (Mål 1) i relation till ett annat mål (Mål 2); till exempel
mängden av en gen i relation till en annan gen under samma provbehandling.

n Relativ uttrycksnivå för en målsekvens i ett prov jämfört med sammamål under olika provbehandling;
till exempel den relativa mängden av en gen i relation till sig själv under olika tidsmässiga,
geografiska eller utvecklingsvillkor.

Plattinställning för genuttrycksanalys
För att utföra en genuttrycksanalys måste innehållet i brunnarna innefatta följande:

n Två eller fler mål – de två målen som representerar olika amplifierade gener eller sekvenser i
proverna.

n Ett eller flera referensmål – minst ett mål måste vara ett referensmål för normaliserat uttryck. Tilldela
alla referensmål i fönstret Experiment Settings (Experimentinställning) och analysera data i läget
Normalized Expression (Normaliserat uttryck) (ΔΔCq). Körningar som inte innehåller en referens
måste analyseras i läget Relative Expression (Relativt uttryck) (ΔCq).

n Gemensamma prover – reaktionerna måste innehålla gemensamma prover (minst två krävs) för att
visa data som plottas på fliken Gene Expression (Genuttryck). Dessa prover ska representera olika
behandlingar eller villkor för var och en av målsekvenserna. Tilldela ett kontrollprov (valfritt) i fönstret
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Experiment Settings (Experimentinställningar). Om ingen kontroll har valts använder programvaran
lägsta Cq som kontroll.

Kraven för inställning av Gene Expression (Genuttryck) i Plate Editor (Plattredigerare) beror på huruvida
reaktionsinnehållen är singleplex-PCRmed en fluorofor i reaktionerna, eller multiplex-PCRmed fler än en
fluorofor i reaktionerna.

Guidad plattinställning
Om plattinställningen för en datafil inte innehåller informationen som krävs för analys och fliken Gene
Expression (Genuttryck) är vald visas i utrymmet som normalt är reserverat för stapeldiagrammet
anvisningar för hur du anger den här informationen. Följ stegen nedan för normaliserat genuttryck:

1. Definiera mål- och provnamn med något av följande:

n Plate Setup (Plattinställning) – öppnar fönstret Plate Editor (Plattredigerare)

n Replace Plate file (Ersätt plattfil) – öppnar läsaren Select Plate (Välj platta), i vilken du kan
navigera till en tidigare sparad plattfil med vilken du kan ersätta den aktuella plattlayouten.

n Replace PrimePCR file (Ersätt PrimePCR-fil) – öppnar dialogrutan Select PrimePCR file (Välj
PrimePCR-fil) i vilken du kan navigera till en PrimePCR™-körningsfil och använda den på
plattlayouten.

2. Välj ett eller flera referensmål samt ett kontrollprov med hjälp av dialogrutan Experiment Settings
(Experimentinställning).

Om plattlayouten redan innehåller mål- och provinformation krävs endast det andra steget, som
markeras med orange färg. Det här steget måste utföras före analys av normaliserat genuttryck.

Obs! Data för spridningsdiagram och clustergram visas endast om alla villkor för normaliserat
genuttryck som anges under Plate Setup for Gene Expression Analysis (Plattinställning för
genuttrycksanalys) har uppfyllts.

258 | CFX Maestro Dx SE programvara



Genuttrycksdiagram

Genuttrycksdiagram
CFX Maestro Dx SE visar genuttrycksdata i flera vyer. I Tabell 30 listas diagramalternativen som är
tillgängliga i programvaran.

Knapp Namn Funktion

Graphing (Diagram) Visar data för normaliserat genuttryck i någon
av följande vyer:

n Bar chart (Stapeldiagram)
(standardinställning)

n Box and whisker chart (Låddiagram)

n Dot plot chart (Punktdiagram)

Clustergram Visar data för normaliserat genuttryck i en
hierarki baserat på graden av likhet av uttryck
för olika mål och prover.

Scatter Plot (Spridningsdiagram) Visar det normaliserade uttrycket av mål för en
kontroll jämfört med ett experimentellt prov.

ANOVA Visar resultatet av envägs-ANOVA på
genuttrycksdata med hjälp av följande R-paket
för att utföra ANOVA och bestämma Tukey-
resultat:

n Companion to Applied Regression (car)
(Tillsammans med tillämpad regression)

n Least-square means
(Minstakvadratmetoden, lsmeans)

Verktyget Reference Gene
Selection (Val av referensgen)

(Tillgängligt på fliken Study Analysis
(Studieanalys) i fönstret Gene Study
(Genstudie)) Identifierar de testade
referensgenerna och kategoriserar dem som
Ideal (Idealisk), Acceptable (Acceptabel) eller
Unstable (Instabil) baserat på deras stabilitet.

PrimePCR Controls Analysis
(PrimePCR-kontrollsanalys)

(Tillgänglig på fliken Study Analysis
(Studieanalys) i fönstret Gene Study
(Genstudie)) Visar resultaten för de testade
proverna.

Tabell 30. Alternativ för genuttrycksdiagram
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Graphing (Diagram)

Det relativa uttrycket av mål visas i dessa två vyer:

n Diagram för Gene Expression (Genuttryck) – visar PCR-realtidsdata som något av följande:

o ΔΔCq – relativt normaliserat uttryck beräknat med användning av kontrollprover och referensmål.

o ΔCq – relativ kvantitet av målgenen i ett prov i relation till ett kontrollprov.

Se Ändra och kommentera diagramvyn på sidan 262 för mer information om att visa data.

n Kalkylblad – visar ett kalkylblad för genuttrycksdata.

Tips: Högerklicka på valfritt diagram eller kalkylblad för alternativ. Välj View/Edit Plate
(Visa/redigera platta) från den nedrullningsbara menyn Plate Setup (Plattinställning) för att
öppna Plate Editor (Plattredigerare) och ändra brunnsinnehållet i plattan.

Tips: Välj Sort (Sortera) från högerklicksmenyn för att ändra ordningen på namnen på Target
(Mål) och Sample (Prov) i diagrammet.

Normaliserat genuttryck

Använd den uppmätta uttrycksnivån för en eller flera referensgener som normaliseringsfaktor för att
normalisera data. Referensgener är mål som inte regleras i det biologiska systemet som studeras, till
exempel actin,GAPDH eller tubulin.
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Så här konfigurerar du en analys av normaliserat genuttryck (ΔΔCq)

1. Öppna en datafil (.pcrd-tillägg)

2. Granska uppgifterna på fliken Quantification (Kvantifiering) i fönstret Data Analysis (Dataanalys).
Justera data, till exempel ändring av tröskel och analysläge.

3. Välj fliken Gene Expression (Genuttryck).

4. Klicka på Experiment Settings (Experimentinställningar) på fliken Gene Expression (Genuttryck)

5. Gör följande i dialogrutan Experiment Settings (Experimentinställningar):

a. Välj fliken Samples (Prover) och välj en kontroll. När en kontroll tilldelas normaliserar CFX Maestro
Dx SE de relativa kvantiteterna för alla gener med kontrollkvantiteten, som anges till 1.

b. Välj fliken Target (Mål) och välj referensgener. Analys av genuttryck kräver en referens bland
målen i dina prover.

6. Välj Normalized Expression (Normaliserat uttryck) (ΔΔCq) om det inte redan är valt och visa sedan
uttrycksnivåerna på fliken Gene Expression (Genuttryck).

Obs! Du kan också använda Setup Wizard (Inställningsguide) för att ange plattlayouten för
analys av normaliserat genuttryck.

Relativ kvantitet

Per definition är data för relativ kvantitet (ΔCq) inte normaliserade. Denna metod används för att
kvantifiera prover som inte innehåller några referensgener (mål). Forskare brukar förlita sig på ett av
följande beaktanden när de förbereder sin körning:

n Varje prov innehåller samma mängd massa av RNA eller cDNA i varje brunn.

n Alla variationer i mängden laddat biologiskt prov normaliseras efter körningen med någon metod i
dataanalysen utanför programvaran. Exempelvis kan en forskare välja att dividera det relativa
kvantitetsvärdet med den normaliserande faktorn, eventuellt massan av laddad nukleinsyra för varje
prov, eller antalet celler från vilka nukleinsyran har isolerats.

Så här kör du en analys av Relative Quantity (Relativ kvantitet) (ΔCq)

u På fliken Gene Expression (Genuttryck), välj Relative Quantity (Relativ kvantitet) (ΔCq) från listrutan
Mode (Läge) i höger ruta.

Tips: Du kan jämföra resultat med data från andra genuttryckskörningar genom att öppna en ny
genstudie eller lägga till en datafil till en befintlig genstudie.
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Ändra och kommentera diagramvyn
Med menykommandona på diagrammets verktygsfält och diagramverktygen för dataanalys kan du ändra
diagramvyn, kommentera varje diagram och ändra diagramvisningen. Diagramverktygsraden visas
mellan diagrammet och dataanalyskalkylbladet längst ned på skärmen.

Verktyg i diagramverktygsraden

Tips: Information om diagramverktygen som visas på höger sida av dataanalysdiagram finns i
Diagram på sidan 199.

Verktygsraden under diagrammen ger snabb åtkomst till anteckningsverktyg.

I Tabell 31 listas funktionerna för knapparna i diagramverktygsraden.

Knapp Namn Funktion

Bar Chart (Stapeldiagram) Visar målens relativa uttryck.

Box andWhisker chart (Låddiagram) Visar data som kvartilintervall
(beräkningsinformation finns i
Beräkningar med Box andWhisker
chart (Låddiagram) på sidan 298).

Obs! Endast tillgängligt om Analyze
Using (Analysera med) är inställd på
Biological Groups Only (Endast
biologiska grupper).

Dot Plot chart (Punktdiagram) Visar de enskilda provdatapunkterna
för varje mål.
Obs! Endast tillgängligt om Analyze
Using (Analysera med) är inställd på
Biological Groups Only (Endast
biologiska grupper).

Add Arrow (Lägg till pil) Ritar en pil på det aktiva diagrammet.

Tabell 31. Diagramverktygsrad
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Knapp Namn Funktion

Add Circle (Lägg till cirkel) Ritar en cirkel på det aktiva
diagrammet.

Add Text (Lägg till text) Infogar en textruta i det aktiva
diagrammet där du kan lägga till text
för att identifiera intresseobjekt i
diagrammet.

Undo (Ångra) Tar bort eller återställer den senaste
anteckningen på det aktiva
diagrammet.

Redo (Gör om) Återställer den senaste åtgärden av
typen Undo (Ångra) på det aktiva
diagrammet.

Clear All (Rensa alla) Rensar alla anteckningar på det aktiva
diagrammet.

Tabell 31. Diagramverktygsrad, forts.

Sortera data för mål, prover och biologiska grupper

Obs! Det här alternativet är endast tillgängligt för genuttrycksdiagram.

Som standard visas listorna Targets (Mål), Samples (Prover) och Biological Groups (Biologiska grupper) i
alfabetisk ordning. I dialogrutan Sort (Sortera) kan du sortera visningen i omvänd alfabetisk ordning eller
manuellt flytta ett villkor till en annan plats i listan.

Så här sorterar du data för mål, prover och biologiska grupper

1. Klicka på Sort (Sortera) i diagramverktygen.

Dialogrutan Gene Expression Chart Sorting (Sortering i genuttrycksdiagram) öppnas.
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2. I dialogrutan klickar du på Z-A för att sortera listan i omvänd alfabetisk ordning.

3. Du flyttar ett villkor manuellt genom att välja det och klicka på lämplig knapp mellan diagrammen:

n Klicka på uppåt- eller nedåtpilen för att flytta det valda villkoret en position.

n Klicka på uppåt- eller nedåtstreckpilen för att flytta det valda villkoret högst upp eller längst ned
på listan.

4. Klicka på OK för att spara ändringarna och återgå till fliken Gene Expression (Genuttryck).
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Ändra färginställningarna för Target (Mål), Sample (Prov) och Biological Group
(Biologisk grupp)

Använd dialogrutan för Color Settings (Färginställningar) för att ändra färg för ett mål, prov eller en
biologisk grupp, eller ta bort objektet från diagrammet.

Så här ändrar du målfärginställningarna

1. Verifiera i den högra rutan i dialogrutan Gene Expression (Genuttryck) att Sample (Prov) visas i
listrutan X-Axis (X-axel).

2. I Chart Tools (Diagramverktyg) väljer du Color Settings (Färginställningar).

Dialogrutan Color Settings (Färginställningar) visas.

3. För att ändra visningsfärgen för ett mål klickar du på dess färg i kolumnen Color (Färg).

4. Välj en ny färg i dialogrutan Color (Färg) som visas och klicka på OK.

5. För att ta bort ett mål från genuttrycksdiagrammet avmarkerar du motsvarande kryssruta i kolumnen
Show Chart (Visa diagram).

Tips: För att rensa alla mål avmarkerar du Show Chart (Visa diagram) i kolumnrubriken.

6. (Valfritt) Som standard visas staplarna som enfärgade. För att visa staplarna i gradientfärger rensar
du Use Solid Colors (Använd enfärgat).

7. Klicka på OK för att spara ändringarna och återgå till fliken Gene Expression (Genuttryck).

Så här ändrar du färginställningarna för prov eller biologisk grupp

1. Verifiera i den högra rutan i dialogrutan Gene Expression (Genuttryck) att Target (Mål) visas i
listrutan X-Axis (X-axel).

2. Utför stegen i Så här ändrar du målfärginställningarna på sidan 265.

Ändra tabellvisning

Så här växlar du den aktuella diagramvyn

u Välj verktygsradkommandot för målvyn.

Obs! Fliken Gene Expression (Genuttryck) öppnas alltid och visar data i standardvyn Bar Chart
(Stapeldiagram).
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Utesluta avvikande datapunkter

I diagrammet Dot Plot (Punktdiagram) kan du enkelt visa och utesluta avvikelser från din analys.

Så här utesluter du avvikande datapunkter

u Högerklicka på målavvikelsen i diagrammet Dot Plot (Punktdiagram) och välj Exclude Well from
Analysis (Uteslut brunn från analys).

Datapunkten tas bort från diagrammet Dot Plot (Punktdiagram) och brunnen byter färg till grått i Well
Selector (Brunnsväljare) på fliken Quantification (Kvantifiering).

Så här inkluderar du en utesluten avvikande datapunkt

u På fliken Quantification (Kvantifiering) högerklickar du på brunnen i Well Selector (Brunnsväljare) och
väljer Well > Include in Analysis (Brunn > Inkludera i analys).

Visa datapunktsinformation

Så här visar du information om datapunkter

u Placera markören på en enskild datapunkt i låddiagrammet eller punktdiagrammet.

Ett verktygstips visas med provnamnet och dess uttryck (relativ kvantitet eller normaliserat uttryck
beroende på det valda läget).

Kommentera diagram

Du kan lägga till pilar, cirklar och text i varje stapeldiagramvy för att tydligt kommunicera data.
Anteckningarna sparas med stapeldiagrammet och visas i den exporterade och utskrivna filen.
Anteckningar som görs i en diagramvy läggs emellertid inte till i de andra diagramvyerna.

Så här ritar du en pil eller cirkel på diagrammet

1. Klicka på det specifika verktyget i stapeldiagrammets verktygsrad.

2. Klicka i stapeldiagrammet och dra markören över diagrammet efter behov.
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Så här lägger du till text i diagrammet

1. Klicka på Add Text (Lägg till text) i stapeldiagrammets verktygsrad.

2. Klicka i stapeldiagrammet. En textruta visas på den platsen.

3. Lägg till text i textrutan.

4. Klicka någonstans i diagrammet för att lämna textrutan.

Tips: Tryck på Retur för att lägga till flera rader i textrutan.

Så här flyttar du en anteckning

1. Håll markören på anteckningen. Ikonen ändras till ett pekfinger och anteckningskanten markeras.

2. Klicka på anteckningen och dra den till en annan plats.

3. Släpp anteckningen för att låsa fast den på platsen.

Så här ångrar du en anteckning

u Klicka på Undo (Ångra).

Den senast tillagda anteckningen tas bort.

Tips: Du kan ångra de tio senaste anteckningarna, en i taget.

Så här gör du om en anteckning

u Klicka på Redo (Gör om).

Den senast borttagna anteckningen återställs.

Tips: Du kan göra om de tio senaste anteckningarna, en i taget.

Så här tar du bort en anteckning

u Högerklicka på anteckningen och välj Delete (Ta bort).
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Justera data för Gene Expression (Genuttryck)
När du har valt analysläge, normaliserat uttryck (∆∆Cq) eller relativ kvantitet (∆Cq), justerar du de data du
ser på fliken Gene Expression (Genuttryck) genom att ändra inställningsalternativen till höger om
diagrammet.

Tips: Du ställer in standardalternativen för data för Gene Expression (Genuttryck) i dialogrutan User
Preferences (Användarinställningar) (se Ställa in standardparametrar för genuttrycksdatafil på sidan 90).

Diagramdata

Ställ in y-axelvärdet på Linear (Linjär) skala för att aktivera alternativen för diagramdata. Med alternativen
för diagramdata kan du presentera data i diagrammet med ett av följande alternativ:

n Relative to control (I förhållande till kontroll) – rita data med axeln skalad från 0 till 1. Om du tilldelar
en kontroll i körningen väljer du det här alternativet för att snabbt visualisera målets uppreglering och
nedreglering.

n Relative to zero (I förhållande till noll) – rita data med origo på noll.

Analyze Using (Analysera med)

Använd den nedrullningsbara menyn för att välja hur data ska analyseras och plottas. Alternativen är
följande:

n Samples Only (Endast prover) – data analyseras och plottas per prov.

n Biological Groups Only (Endast biologiska grupper) – data analyseras och plottas för biologiska
grupper. Uttrycket som visas för den biologiska gruppen är det geometriska medelvärdet för proverna
i den gruppen.

n Sample Biological Group (Prov från biologisk grupp) – data analyseras och plottas per prov och den
biologiska gruppen anges efter provnamnet. P-värden som visas beräknas baserat på biologisk
grupp.

n Biological Group Sample (Biologisk grupp för provet) – data analyseras och plottas per prov och den
biologiska gruppen anges före provnamnet. P-värden som visas beräknas baserat på biologisk
grupp.

Använd den nedrullningsbara menyn och välj ett prov som ska användas för att normalisera Relative
Quantity (Relativ kvantitet):

Kommentera P-värden och P-värdeströskel

När Annotate P-Values (Kommentera P-värden) är valt, visar programmet en asterisk (*) i
stapeldiagrammet ovanför ett mål om dess P-värde ligger under den valda tröskeln. Programmet
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beräknar P-värdet automatiskt genom att jämföra provets uttrycksnivå med det valda kontrollprovets
uttrycksnivå med användning av ett vanligt t-test. P-värdeströskelns intervall är 0,000–1,000.

X-axelalternativ

X-axis option (x-axelalternativet) gör det möjligt att välja x-axeldata för diagrammet Gene Expression
(Genuttryck):

n Target (Mål) – ritar målnamnen på x-axeln.

n Sample (Prov) – ritar provnamnen på x-axeln.

Y-axelalternativ

Y-axis option (y-axelalternativet) gör det möjligt att visa diagrammet Gene Expression (Genuttryck) i en av
följande tre skalor:

n Linear (Linjär) – välj om du vill visa en linjär skala.

Tips: När y-axeln ställs in på Linear (Linjär) aktiveras listrutan Graph Data (Diagramdata) där du
kan välja att rita data i förhållande till kontrollen eller i förhållande till noll.

n Log 2 (Logaritm 2) – välj om du vill utvärdera prover över ett stort dynamiskt intervall.

n Log 10 (Logaritm 10) – välj om du vill utvärdera prover över ett mycket stort dynamiskt intervall.

Skalningsalternativ

Välj Normalized Gene Expression (Normaliserat genuttryck) (ΔΔCq) och ställ in på None (Inget) för att
aktivera skalningsalternativen i diagrammet Gene Expression (Genuttryck). Välj ett av följande
skalningsalternativ för att beräkna och presentera data på det sätt som bäst passar
körningsutformningen:

n Unscaled (Oskalat) – presenterar det oskalade, normaliserade genuttrycket.

n Highest (Högsta) – skalar det normaliserade genuttrycket för varje mål genom att dividera
uttrycksnivån för varje prov med den högsta nivån av uttryck i alla prover.

Det här skalningsalternativet använder skala-till-högsta-formeln.

n Lowest (Lägsta) – skalar det normaliserade genuttrycket för varje mål genom att dividera
uttrycksnivån för varje prov med den lägsta nivån av uttryck i alla prover.

Det här skalningsalternativet använder skala-till-lägsta-formeln.

n Average (Medelvärde) – skalar det normaliserade genuttrycket för varje mål genom att dividera
uttrycksnivån för varje prov med det geometriska medelvärdet av uttrycksnivåerna för alla prover.

Det här skalningsalternativet använder skala-till-medel-formeln.
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Välj ett alternativ för typen av felberäkningar (felstaplar) i diagrammet Gene Expression (Genuttryck):

Diagrammultiplikator för felstaplar

Välj en multiplikator för felstaplarna i diagrammet Gene Expression (Genuttryck). Välj ett av dessa heltal:

n +/- 1 (standard)

n 2

n 3

Typen av multiplikator ändras när du väljer felstapeln:

n SEMs for standard error of the mean (SEM för medelvärdets standardfel)

n Std Devs for standard deviations (SD för standardavvikelser)

Experiment Settings (Experimentinställningar)
Tips: Den här dialogrutan är också tillgänglig i Plate Editor (Plattredigerare). Se Ändra Experiment
Settings (Experimentinställningar) på sidan 149 för mer information.

I dialogrutan Experiment Settings (Experimentinställningar) kan du visa eller ändra listan med mål, prover
eller biologiska grupper, välja referensgener, välja kontroller eller ange att gruppen Gene Expression
Analysis (Genuttrycksanalys) ska analyseras om biologiska grupper har lagts till i brunnarna.

Så här öppnar du dialogrutan Experiment Settings (Experimentinställningar)

u På fliken Graphing (Diagram) klickar du på Experiment Settings (Experimentinställningar) längst ned
i den högra rutan.

Dialogrutan Experiment Settings (Experimentinställningar) visas med fliken Targets (Mål).

Så här justerar du målinställningar

u Gör något av följande på fliken Targets (Mål):

n För att välja ett mål som referens för dataanalys av genuttryck väljer du namnet i kolumnen
Reference (Referens).

n För att ändra färgen på målet klickar du på dess cell i kolumnen Color (Färg) och ändrar färgen i
dialogrutan Color (Färg) som visas.

Färgförändringen visas i tabellerna Gene Expression (Genuttryck).

n För att använda ett tidigare definierat effektivitetsvärde ska du avmarkera målets kryssruta i
kolumnen Auto Efficiency (Automatisk effektivitet) och ange ett nummer för målets
effektivitetsandel.
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Programvaran beräknar den relativa effektiviteten för ett mål med Auto Efficiency (Automatisk
effektivitet) om data för ett mål inkluderar en standardkurva.

Så här ändrar du inställningarna för prov

u Gör något av följande på fliken (Prover och biologiska grupper):

n För att välja ett prov som kontroll för dataanalys av genuttryck väljer du det i kolumnen Control
(Kontroll).

n För att ändra färgen på provet klickar du på dess cell i kolumnen Color (Färg) och ändrar färgen i
dialogrutan Color (Färg) som visas.

Färgförändringen visas i tabellerna Gene Expression (Genuttryck).

n För att visa provet i Gene Expression-diagrammen (Genuttryck) väljer du det i kolumnen Show
Chart (Visa diagram).

n För att ta bort provet från Gene Expression-diagrammen (Genuttryck) tar du bort det i kolumnen
Show Chart (Visa diagram).

Tips: Provets gruppens data blir kvar i tabellen Results (Resultat).

Så här exkluderar du en provtyp från analysberäkningar

u Markera motsvarande kryssruta längst ned i dialogrutan Experiment Settings
(Experimentinställningar)

Obs! Det här utesluter kontroller och/eller standarder från analys av genuttryck.

Alternativ på högerklicksmenyn
Högerklicka på genuttrycksdiagrammet för att välja alternativen som visas i Tabell 32.

Alternativ Funktion

Copy (Kopiera) Kopierar diagrammet till ett urklipp.

Save Image As (Spara bild som) Sparar tabellen som en bildfil. Ange upplösning och mått för bilden och
välj sedan filtyp (PNG, JPG, eller BMP).

Page Setup (Utskriftsformat) Väljer ett utskriftsformat för utskrift.

Print (Skriv ut) Skriver ut tabellen.

Tabell 32. Alternativ på högerklicksmenyn för genuttryck
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Alternativ Funktion

Set Scale to Default (Ange skala
som standard)

Show All (Visa alla) visar alla data i stapeldiagrammet. Scroll Bar
(Rullningslist) visar en rullningslist om antalet prover inte kan visas i
diagrammets ram samtidigt somminimibredden på listen upprätthålls.

Chart Settings
(Diagraminställningar)

Öppnar fönstret Chart Settings (Diagraminställningar) för att justera
grafen.

Sort (Sortera) Sorterar ordningen av prover eller mål som visas på tabellens x-axel.

Use Corrected Std Devs
(Använd korrigerade
standardavvikelser)

Beräknar felstaplarna med hjälp av formeln för korrigerad
standardavvikelse.

Use Solid Bar Colors (Använd
solida stapelfärger)

Visar solida staplar i diagrammet.

X–Axis Labels (Etiketter för x-
axeln)

Visar x-axelns etiketter vågrätt eller vinklade.

Tabell 32. Alternativ på högerklicksmenyn för genuttryck, forts.

Datakalkylblad
I Tabell 33 definieras de data som visas i datatabellen Gene Expression (Genuttryck).

Obs! Värden i tabellen beräknas baserat på typ av graf och inställningar som har valts i den högra
rutan.

Information Beskrivning

Target (Mål) Valt målnamn (amplifierad gen) i fönstret Experiment Settings
(Experimentinställningar).

Biological Group (Biologisk
grupp)

Sample Biological Group (Prov
från biologisk grupp)

Biological Group Sample
(Biologisk grupp för provet)

Valt namn på prov och/eller biologisk grupp i fönstret Experiment
Settings (Experimentinställningar).

Tabell 33. Beskrivning av informationen i kalkylbladet på fliken
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Information Beskrivning

Control (Kontroll) Kontrollnamn som valts i fönstret Experiment Settings
(Experimentinställningar). Om Analyze Using (Analysera med) är
inställt på Samples Only (Endast prover) väljs provet Control (Kontroll)
i fönstret Experiment Settings (Experimentinställningar). Om antingen
Biological Groups Only (Endast biologiska grupper), Sample Biological
Group (Prov från biologisk grupp) eller Biological Group Sample
(Biologisk grupp för provet) väljs är kontrollen den biologiska grupp
som väljs i fönstret Experiment Settings (Experimentinställningar).

Relative Quantity or
Expression (Relativ kvantitet
eller Uttryck)

Relativ kvantitet (ΔCq) eller normaliserat genuttryck (ΔΔCq), beroende
på valt läge.

Relative Quantity or Expression
SEM (or SD) (SEM (eller SD) för
relativ kvantitet eller uttryck)

Medelvärdets standardfel (SEM) eller standardavvikelse (SD) för
relativ kvantitet eller normaliserat uttryck, beroende på vilket alternativ
som är valt. Endast tillgängligt om Analyze Using (Analysera med) är
inställd på Samples Only (Endast prover), Sample Biological Group
(Prov från biologisk grupp) eller Biological Group Sample (Biologisk
grupp för provet).

Corrected Relative Quantity or
Expression SEM (or SD)
(Korrigerad SEM (eller SD) för
relativ kvantitet eller uttryck)

Korrigerad värdeberäkning för SEM eller SD för relativ kvantitet eller
normaliserat uttryck, beroende på vilket alternativ som är valt. Endast
tillgängligt om Analyze Using (Analysera med) är inställd på Samples
Only (Endast prover), Sample Biological Group (Prov från biologisk
grupp) eller Biological Group Sample (Biologisk grupp för provet).

Mean Cq (Medelvärde för Cq) Medelvärde för kvantifieringscykeln (visas inte om Analyze Using
(Analysanvändning) är inställd på Biological Groups Only (Endast
biologiska grupper).

Cq SEM (eller SD) SEM eller SD för kvantifieringscykeln, beroende på valt alternativ
(visas inte om Analyze Using (Analysanvändning) är inställd på
Biological Groups Only (Endast biologiska grupper).
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Alternativet Show Details (Visa detaljer)
Tabell 34 definierar de data som visas när Show Details (Visa detaljer) väljs på högerklicksmenyn i
kalkylbladet för stapeldiagrammet.

Information Beskrivning

Data Set (Datauppsättning) Fluorescensdata från en fluorofor i datafilen

Relative Quantity (Relativ
kvantitet)

Beräknad relativ kvantitet av prover

Relative Quantity SD (SD för
relativ kvantitet)

Standardavvikelse för beräkningen av relativ kvantitet

Corrected Relative Quantity SD
(SD för korrigerad relativ
kvantitet)

Beräknad standardavvikelse för den korrigerade relativa kvantiteten

Relative Quantity SEM (SEM för
relativ kvantitet)

Medelvärdets standardfel för beräkningen av relativ kvantitet

Corrected Relative Quantity
SEM (SEM för korrigerad relativ
kvantitet)

Beräknat medelvärdesstandardfel för den korrigerade relativa
kvantiteten

Relative Quantity(lg) (Relativ
kvantitet(lg))

Log2 för den relativa kvantitet som används för statistisk analys

SD RQ(lg) Standardavvikelse för den relativa kvantiteten (log2)

SEM Expression(lg) (SEM för
uttryck(lg))

Medelvärdets standardfel för uttrycket (log2)

Unscaled Expression (Ej skalat
uttryck)

Beräknat ej skalat uttryck

Unscaled Expression SD (SD för
ej skalat uttryck)

Beräknad standardavvikelse för det ej skalade uttrycket

Corrected Unscaled Expression
SD (SD för korrigerat ej skalat
uttryck)

Beräknad standardavvikelse för det korrigerade ej skalade uttrycket

Tabell 34. Information i kalkylbladet för stapeldiagrammet med Show Details (Visa detaljer) valt
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Information Beskrivning

Unscaled Expression SEM
(SEM för ej skalat uttryck)

Beräknat medelvärdesstandardfel för det ej skalade uttrycket

Corrected Unscaled Expression
SEM (SEM för korrigerat ej
skalat uttryck)

Beräknat medelvärdesstandardfel för det korrigerade ej skalade
uttrycket

Unscaled Expression(lg) (Ej
skalat uttryck(lg))

Log2 för det ej skalade uttrycket

SD Unscaled Expression(lg) (SD
ej skalat uttryck(lg))

Standardavvikelse för det ej skalade uttrycket (log2)

SEM Unscaled Expression(lg)
(SEM för ej skalat uttryck(lg))

Medelvärdets standardfel för det ej skalade uttrycket (log2)

Expression (Uttryck) Normaliserat genuttryck

Corrected Expression SD (SD
för korrigerat uttryck)

Beräknad standardavvikelse (SD) för det korrigerade uttrycket

Expression SEM (SEM för
uttryck)

Medelvärdets standardfel (SEM) för uttrycket

Corrected Expression SEM
(SEM för korrigerat uttryck)

Beräknat medelvärdesstandardfel för det korrigerade uttrycket

Expression(lg) (Uttryck(lg)) Log2 för uttrycket (normaliserat uttryck) som används för statistisk
analys

SD Expression(lg) (SD för
uttryck(lg))

Standardavvikelse för uttrycket (log2)

SEM Expression(lg) (SEM för
uttryck(lg))

Medelvärdets standardfel för uttrycket (log2)

Mean Cq (Medelvärde för Cq) Medelvärde för kvantifieringscykeln

Cq SD (SD för Cq) Standardavvikelse för kvantifieringscykeln

Cq SEM (SEM för Cq) Medelvärdesstandardfel för kvantifieringscykeln

Tabell 34. Information i kalkylbladet för stapeldiagrammet med Show Details (Visa detaljer) valt,
forts.
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Clustergram
Clustergrammet visar data i en hierarki baserad på graden av likhet i uttryck för olika mål och prover.

Obs! Du måste välja ett referensmål för att visa någon annan dataplott än relativt uttryck för
stapeldiagram.

Clustergrambilden avbildar relativt uttryck för ett prov eller mål på följande sätt:

n Uppreglering (röd) – högre uttryck

n Nedreglering (grön eller blå färg) – lägre uttryck

n Ingen reglering (svart)

n Inget värde beräknat (svart med ett vitt X)

Ju ljusare färgnyans, desto större skillnad i relativt uttryck. Om inget värde för normaliserad Cq kan
beräknas, är rutan svart med ett vitt X.

I ytterkanterna av dataplotten finns ett dendrogram, vilket indikerar klusterhierarkin. Mål eller prover med
likartade uttrycksmönster kommer att ha angränsande grenar medan de med olikartade mönster kommer
att ha ett större avstånd.

Inställningar
Det går att ställa in följande alternativ:

n Cluster By (Klusterindela efter) – välj Targets (Mål), Samples (Prover), Both (Båda) eller None
(Ingen).

n Size (Storlek) – justerar bildstorleken och ändrar graden av diagramförstoring.

n Split Out Replicates (Dela upp replikat) – visar värdena för enskilda replikat.

Tips: Det går att ändra färgschemat för från röd/grön (standard) till röd/blå genom att välja det alternativet
på högerklicksmenyn i dessa diagram.

Alternativ på högerklicksmeny
Alternativen på högerklicksmenyn för clustergrammet är identiska med alternativen för stapeldiagrammet.
Se Tabell 32 på sidan 271 för tillgängliga alternativ. Välj dessutom Color Scheme (Färgschema) för att
ändra nedregleringsuttrycket från standardinställningen Röd/Grön till Röd/Blå i diagrammet.

Datakalkylblad
I kalkylbladet visas värden för målet, provet och normaliserat uttryck.

276 | CFX Maestro Dx SE programvara



Scatter Plot (Spridningsdiagram)

Scatter Plot (Spridningsdiagram)
Spridningsdiagrammet visar det normaliserade uttrycket av mål för en kontroll jämfört med ett experimentprov.
Linjerna i diagrammet anger tröskelvärdet för x-faldig förändring. Datapunkter mellan linjerna indikerar att
skillnaden i uttryck för det målet (genen) är försumbar mellan proverna. Datapunkter utanför linjerna överskrider
tröskelvärdet för x-faldig förändring och kan vara av intresse.

Diagrambilden visar följande förändringar i måluttryck baserat på tröskelvärdet för x-faldig förändring:

n Uppreglering (röd cirkel) – relativt högre uttryck

n Nedreglering (grön eller blå cirkel) – relativt lägre uttryck

n Ingen förändring (svart cirkel)

Klicka på och dra endera tröskelvärdeslinje för att justera den x-faldiga förändringens tröskelvärde.

Inställningar
Det går att ställa in följande alternativ:

n Control Sample (Kontrollprov)

n Experimental Sample (Experimentprov)

n Fold Change Threshold (Tröskel för X-faldig förändring). När du ökar eller minskar värdet för x-faldig
förändring flyttas tröskelvärdeslinjerna i diagrammet i enlighet därmed.

Alternativ på högerklicksmeny
Alternativen på högerklicksmenyn för spridningsdiagrammet är identiska med alternativen för
stapeldiagrammet. Se Tabell 32 på sidan 271 för tillgängliga alternativ. Välj dessutom Symbol för att
ändra symbolen som används i plotten från standardcirkeln till en av följande:

n Triangle (Triangel)

n Cross (Kors)

n Square (Fyrkant)

n Diamond (Romb)

Datakalkylblad
I kalkylbladet visas värden för målet och normaliserat uttryck för kontroll- och experimentprover. Här visas
också ommål är upp- eller nedreglerade jämfört med målregleringen.
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Kalkylbladet Results (Resultat)
Kalkylbladet Results (Resultat) sammanfattar data från alla diagram. I Tabell 35 definieras data som visas
i kalkylbladet Results (Resultat).

Information Beskrivning

Target (Mål) Målnamn (amplifierad gen)

Sample (Prov) Provnamn

Mean (Medelvärde för) Cq Medelvärde för kvantifieringscykeln

Mean Efficiency Corrected
(Medelvärde av
effektivitetskorrigerad) Cq

Medelvärde för kvantifieringscykeln efter justering för
reaktionseffektiviteten

Normalized Expression
(Normaliserat uttryck)

Måluttryck normaliserat till ett referensmål (ΔΔCq)

Relative Normalized Expression
(Relativt normaliserat uttryck)

Normaliserat uttryck i förhållande till ett kontrollprov, kallas även Fold
Change (X-faldig förändring)

Regulation (Reglering) Förändring i uttryck i förhållande till ett kontrollprov

Compared to Regulation
Threshold (Jämfört med
regleringströskelvärdet)

Upp- eller nedreglering av ett experimentellt prov baserat på
tröskelvärdesinställningen

Tabell 35. Information på fliken Results (Resultat)

Obs! Data för replikat finns bara i kalkylbladen på dataanalysflikar där Split Out Replicates (Dela upp
replikat) har valts (alltså Clustergram (clustergram)). Det kan bli en diskrepans mellan uttrycksdata i
genuttrycksanalysens kalkylblad om du väljer ”none” (inget) som kontrollprov på stapeldiagrammet.
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Genstudie
Skapa en genstudie för att jämföra genuttrycksdata från ett eller flera realtids-PCR-experiment med hjälp
av en kalibrator mellan körningar som normaliserar mellan experimenten. Skapa en genstudie genom att
lägga till data från en eller flera datafiler (.pcrd-tillägg) i genstudien. Programvaran grupperar dem till en fil
(.mgxd-tillägg).

Obs! Det högsta antalet prover som går att analysera i en genstudie begränsas av storleken på
datorns RAM-minne och virtuella minne.

Inter-run Calibration (Kalibrering mellan körningar)
Försök till kalibrering mellan körningar påbörjas automatiskt i varje genstudie för varje mål för
normalisering av variationer mellan körningar mellan mål som har analyserats i separata realtids-PCR-
körningar (det vill säga olika .pcrd-filer genererade från olika plattor).

För att programvaran ska känna igen ett prov som en kalibrator inom körning måste den ha samma
målnamn, provnamn, och, i förekommande fall, samma namn på biologisk uppsättning för varje platta
som jämförs.

Obs! Det måste finnas minst ett kalibratorprov mellan körningar i genstudien för att kalibrering mellan
körningar ska fungera. Mål utan lämpliga kalibratorprover mellan körningar behandlas utan
korrigering i genstudien (rekommenderas inte).

Kalibratorer mellan körningar kan tillämpas på två sätt:

n Per target (Per mål) – olika PCR-primrar kan ha olika effektiviteter. Kalibratorn mellan körningar
tillämpas som standard till alla brunnar på samma platta som har sammamålnamn, till exempel Cq
som genereras med samma analys.

n Entire study (Hela studien) – användaren väljer en kalibrator mellan körningen som tillämpas på hela
genstudien.
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Dialogrutan Gene Study (Genstudie)

Dialogrutan Gene Study (Genstudie) har två flikar:

n Fliken Study Setup (Studieinställning) – hanterar körningarna i genstudien.

Viktigt! Data i den ursprungliga filen förändras inte om du lägger till eller tar bort datafiler i en
genstudie.

n Fliken Study Analysis (Studieanalys) – visar genuttrycksdata för kombinerade körningar.

Fliken Study Setup (Studieinställning)
I Tabell 36 definieras data som visas på fliken Study Setup (Studieinställning).

Kolumnnamn Beskrivning

File Name (Filnamn) Namn på körningsdatafil (.pcrd-tillägg)

File Folder (Filmapp) Katalog som lagrar datafilen för varje körning i genstudien

Date Created (Skapades
den)

Den dag då körningsdata samlades in

Tabell 36. Fliken Study Setup (Studieinställning) i dialogrutan Gene Study (Genstudie)
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Kolumnnamn Beskrivning

Well Group Name (Namn på
brunnsgrupp)

Namnet på brunnsgruppen som valdes när filen lades till i genstudien.

Tips: För att kunna analysera en brunnsgrupp i genstudien måste
du välja brunnsgruppen i fråga i fönstret Data Analysis
(Dataanalys) innan du importerar datafilen i genstudien.

Step (Steg) Protokollsteg som inkluderar plattavläsning för insamling av realtids-
PCR-data

Run Type (Körningstyp) Antingen användardefinierad eller PrimePCR-körning

Protocol Edited (Protokoll
redigerat)

Om det här alternativet är markerat anger det att protokollet som
användes för en PrimePCR-körning har redigerats

View Plate (Visa platta) Öppnar en karta av plattan med data från var och en av körningarna
som ingår i genstudien

Tabell 36. Fliken Study Setup (Studieinställning) i dialogrutan Gene Study (Genstudie), forts.

Förbereda en genstudie
Så här förbereder du en genstudie

1. Innan du importerar data till en genstudie måste följande utföras i fönstret Data Analysis
(Dataanalys):

n Verifiera att prover med samma innehåll har samma namn. I en genstudie förutsätter
programmet att brunnar med samma Target name (Målnamn) eller Sample name (Provnamn)
innehåller samma prover.

n Justera baslinjen och tröskeln (Cq) på fliken Quantification (Kvantifiering) för att optimera data i
varje körning.

n Välj brunnsgruppen du vill inkludera i genstudien.

För att du ska kunna visa data från en brunnsgrupp i genstudien, måste den gruppen väljas
innan du importerar datafilen.

På fliken Study Setup (Studieinställning) visas en lista över alla körningar i genstudien.

2. I dialogrutan Gene Study (Genstudie) väljer du fliken Study Setup (Studieinställning).

3. Klicka på Add Data Files (Lägg till datafiler) för att välja en fil i ett webbläsarfönster.

Tips: För att snabbt lägga till körningar till en genstudie kan du dra datafilerna (med
filnamnstillägget .pcrd) till dialogrutan Study Setup (Studieinställning).
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4. CFX Maestro Dx SE utför automatiskt genstudieanalysen efterhand som du lägger till datafiler. Välj
fliken Study Analysis (Studieanalys) för att visa resultaten.

Så här tar du bort körningar från genstudien

u Välj en eller flera filer i listan och klicka på Remove (Ta bort).

Så här lägger du till anteckningar om genstudien

u Skriv in anteckningar om filerna och analysen i textrutan Notes (Anteckningar).

Fliken Study Analysis (Studieanalys)
På fliken Study Analysis (Studieanalys) visas data från alla körningar i genstudien. Alternativen för
genuttrycksdataanalysen är desamma som för en enstaka datafil med följande undantag:

n För stapeldiagram visas kalibreringsvärden mellan körningar (om sådana beräknats) när du klickar
på Inter-run Calibration (Kalibrering mellan körningar).

Obs! Endast följande provtyper kan användas som en kalibrator mellan körningar:

o Unknown (Okänd)

o Standard

o Positive Control (Positiv kontroll)

Provtyperna Negative Control (Negativ kontroll), No Template Control (NTC, kontroll utan templat)
och No Reverse Transcriptase Control (NRT, kontroll utan reverserat transkriptas) kan inte användas
som en kalibrator mellan körningar.

n Verktyget Reference Gene Selection (Val av referensgen) identifierar de testade referensgenerna
och kategoriserar dem som Ideal (Idealisk), Acceptable (Acceptabel) eller Unstable (Instabil) baserat
på deras stabilitet:

o Idealiska referensgener är stabila och representerar minimala variationer i alla de testade
proverna.

o Acceptabla referensgener är inte idealiskt stabila och representerar måttliga variationer bland de
testade proverna. Använd dessa referensgener i analys om det inte finns några idealiska
referensgener.

o Instabila referensgener representerar mycket stor variation bland de testade proverna. Det
rekommenderas att dessa gener utesluts från analyser.

n Verktyget PrimePCR Analysis Controls (Prime-PCR-analyskontroller) visar resultaten av de testade
proverna i en tabell:

282 | CFX Maestro Dx SE programvara



Genstudie

o Fliken Summary (Sammanfattning) visar en sammanfattning av alla testade prover. Prover som
godkänts i alla kontrollanalyser visas i grönt. Prover som inte godkänts i en eller flera
kontrollanalyser visas i gult.

o Fliken PCR visar resultaten av den positiva PCR-kontrollanalysen. Denna analys detekterar
hämning eller experimentella problem som påverkar genuttryck.

o Fliken RT visar resultaten av den omvända transkriptionskontrollanalysen. Denna analys
utvärderar kvalitativt RT-prestanda och identifierar prover där RT-prestanda sannolikt försämrar
genuttryck.

o Fliken gDNA visar resultaten av DNA-kontaminationskontrollanalysen. Denna analys
bestämmer om genomiskt DNA (gDNA) förekommer i ett prov vid en nivå som kan påverka
qPCR-resultat.

o Fliken RQ visar resultaten av RNA-kvalitetsanalyserna (RQ1 och RQ2). Dessa analyser
bedömer kvalitativt om RNA-integritet skulle kunna ha en negativ påverkan på genuttryck.

Kategorier i genstudierapport
Använd dialogrutan Gene Study Report (Genstudierapport) för att ordna genstudiedata i en rapport. I
Tabell 37 listas alla tillgängliga alternativ för en genstudierapport.

Kategori Alternativ Beskrivning

Header (Rubrik)

Titel, undertitel och logotyp för rapporten

Report Information
(Rapportinformation)

Data, användarnamn, datafilnamn, datafilsökväg
och den valda brunnsgruppen

Gene Study File List (Lista
med genstudiefiler)

Lista med alla datafiler i genstudien

Notes (Anteckningar) Anteckningar om datarapporten

Study Analysis (Studieanalys): Bar Chart (Stapeldiagram)

Analysis Settings
(Analysinställningar)

Lista med valda analysparametrar

Chart (Diagram) Stapeldiagram för genuttryck som visar data

Tabell 37. Kategorier för en genstudierapport
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Kategori Alternativ Beskrivning

Target Names (Målnamn) Lista med mål i genstudien

Sample Names
(Provnamn)

Lista med prover i genstudien

Data Kalkylblad som visar data

Target Stability
(Målstabilitet)

Målstabilitetsdata

Inter-run Calibration
(Kalibrering mellan
körningar)

Data från kalibrering mellan körningar

Box-and-Whisker chart
(Låddiagram)

Låddiagram för genuttryck

Dot-Plot Chart
(Punktplottdiagram)

Punktplottdiagram för genuttryck

Study Analysis (Studieanalys): Clustergram och Scatter Plot (Spridningsdiagram)

Analysis Settings
(Analysinställningar)

Inställningar för respektive typ av diagram

Chart (Diagram) Diagram för genuttryck som visar data

Data Kalkylblad som listar data i varje mål

Study Analysis (Studieanalys): ANOVA Data
(ANOVA-data)

ANOVA Settings (ANOVA-
inställningar)

P-värdeströskel som används i analysen

ANOVA Results (ANOVA-
resultat)

Tabell med resultat från ANOVA och Tukeys
HSD (Honestly Significant Difference) post-hoc-
analys

Shapiro-Wilk Normality
Test (Shapiro-Wilk-
normalitetstest)

Biologisk grupp, antal, P-värde, och eventuella fel
som uppkommer för respektive mål i analysen

Tabell 37. Kategorier för en genstudierapport, forts.
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Kategori Alternativ Beskrivning

ANOVA Errors (ANOVA-
fel)

Fel som identifieras under ANOVA-beräkningar

Tabell 37. Kategorier för en genstudierapport, forts.
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Skapa en genstudierapport
Så här skapar du en genstudierapport

1. Justera data och diagram i genstudierapporten efter behov innan du skapar en rapport.

2. Välj Tools > Reports (Verktyg > Rapporter) i menyn Gene Study (Genstudie) för att öppna
dialogrutan Report (Rapport).

3. Välj alternativen du vill inkludera i rapporten. Rapporten öppnas med standardalternativ valda.
Markera eller avmarkera kryssrutorna för att ändra hela kategorier eller enskilda alternativ inom en
kategori.

Kategorier i genstudierapport på sidan 283 listar tillgängliga alternativ som kan visas.

4. Ändra ordningsföljden på kategorier och objekt i en rapport. Dra alternativen till önskad plats. Objekt
kan bara flyttas inom kategorierna de tillhör.

5. Klicka på Update Report (Uppdatera rapport) för att uppdatera Report Preview
(Rapportförhandsgranskning) med eventuella ändringar.

6. Skriv ut eller spara rapporten. Klicka på knappen Print Report (Skriv ut rapport) i verktygsraden för att
skriva ut den aktuella rapporten. Välj File > Save (Arkiv > Spara) för att spara rapporten i filformatet
PDF (Adobe Acrobat Reader-fil) och välj en plats där filen ska sparas. Välj File > Save As (Arkiv >
Spara som) för att spara rapporten med ett nytt namn eller på en ny plats.

7. (Valfritt) Skapa en rapportmall med den information du vill ha. För att spara de aktuella
rapportinställningarna i en mall väljer du Template > Save (Mall > Spara) eller Save As (Spara som).
Hämta sedan rapportmallen nästa gång du vill skapa en ny rapport.
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CFXMaestro Dx programvara, Security Edition beräknar formler automatiskt och visar resultaten i
flikarna Data Analysis (Dataanalys). I den här bilagan förklaras ingående hur CFX Maestro Dx SE
beräknar formler.

Reaktionseffektivitet
Evidens tyder på att användning av ett noggrant mått på effektivitet för varje primer- och probe-
uppsättning ger noggrannare resultat vid analys av genuttrycksdata. Standardvärdet för effektivitet som
används i beräkningarna av genuttryck är 100 %. För att utvärdera reaktionseffektiviteten skapar du en
standardkurva med användning av seriespädningar av ett representativt prov genom ett relevant
dynamiskt intervall och registrerar sedan effektiviteten för påföljande genuttrycksanalys. Om din körning
innefattar en standardkurva så beräknar programmet effektiviteten automatiskt och visar den under
Standard Curve (Standardkurva) på fliken Quantification (Kvantifiering) när Auto Efficiency (Automatisk
effektivitet) är markerat på fliken Targets (Mål) i fönstret Experiment Settings (Experimentinställning).

Effektiviteten (E) i effektivitetsformlerna avser de ”effektiviteter” som beskrivs av Pfaffl (2001) and
Vandesompele et al. (2002). I dessa publikationer är en effektivitet på 2 (perfekt dubblering med varje
cykel) ekvivalent med 100 % effektivitet i detta program. Du har möjligheten att konvertera dina
effektivitetsberäkningar till de som används i programvaran genom att använda följande matematiska
relationer:

n E = (% Effektivitet * 0,01) + 1

n %Effektivitet = (E – 1) * 100

Relative Quantity (Relativ kvantitet)
Formeln för relativ kvantitet (ΔCq) för alla prover (GOI) är:

Obs! Den här formeln används för att beräkna relativ kvantitet om inget kontrollprov har definierats.

Där:
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n E = Effektivitet för primer- och probsats. Denna effektivitet beräknas med formeln
(% effektivitet * 0,01) + 1, där 100 % effektivitet = 2

n C q (min) = Genomsnittligt Cq för provet med lägsta genomsnittliga Cq för GOI

n C q (prov) = Genomsnittligt Cq för provet

n GOI = Gen av intresse (ett mål)

Relativ kvantitet när en kontroll väljs
När ett kontrollprov eller en biologisk grupp tilldelas beräknas den relativa kvantiteten (RQ) för ett prov
med en gen av intresse (GOI) med den här formeln:

Där:

n E = Effektivitet för primer- och probsats. Denna effektivitet beräknas med formeln
(% effektivitet * 0,01) + 1, där 100 % effektivitet = 2

n Cq (kontroll) = Genomsnittligt Cq för kontrollprovet

n Cq (prov) = Genomsnittligt Cq för alla prover med GOI

n GOI = Gen av intresse (ett mål)

Standardavvikelse för relativ kvantitet
Viktigt! Den här beräkningen gäller endast om Analyze Using (Analysanvändning) är inställd på
Samples Only (Endast prover), Sample Biological Group (Prov från biologisk grupp) eller Biological
Group Sample (Biologisk grupp för provet).

Formeln för den relativa kvantitetens standardavvikelse är

Där:

n SD relativ kvantitet = standardavvikelse för relativ kvantitet

n SD CqGOI-prov = Standardavvikelse för Cq för provet (GOI)

n Relativ kvantitet = Relativ kvantitet för provet

n E = Effektivitet för primer- och probsats. Denna effektivitet beräknas med formeln
(% effektivitet * 0,01) + 1, där 100 % effektivitet = 2
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n GOI = Gen av intresse (ett mål)

Effektivitetskorrigerad Cq (CqE)
Formeln för effektivitetskorrigerad Cq är

Där:

n E = effektivitet

Medelvärde av effektivitetskorrigerad Cq (MCqE)
Formeln för medelvärde av effektivitetskorrigerad Cq är

Där:

n CqE = effektivitetskorrigerad Cq

n n = antal replikat
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Normaliserat uttryck
Normaliserat uttryck (ΔΔCq) är den relativa kvantiteten av målet (genen) normaliserat till kvantiteterna av
referensmålen (gener eller sekvenser) i det biologiska systemet. Du väljer referensmål genom att öppna
fönstret Experiment Settings (Experimentinställning) och klicka på referenskolumnen för varje mål som
tjänar som en referensgen.

Formeln för normaliserat uttryck som använder beräkningen för beräknad relativ kvantitet (RQ) är

Där:

n RQ = Relativ kvantitet för ett prov

n Ref = referensmålet i en körning med ett eller flera referensmål i varje prov

n GOI = Gen av intresse (ett mål)

Förutsatt att referensmålen inte ändrar uttrycksnivå i det biologiska systemet tar beräkningen av
normaliserat uttryck hänsyn till laddningsskillnader och -variationer i cellnummer som representeras i vart
och ett av proverna.
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Expression (Uttryck) och Relative Quantity (Relativ kvantitet) för
biologiska grupper
När Analyze Using (Analysera med användning av) är inställt på Biological Groups Only (Endast
biologiska grupper), visar programmet det genomsnittliga uttrycket (normaliserat uttryck eller relativ
kvantitet, beroende på valet av läge) för proverna inom den biologiska gruppen. Eftersom uttryck brukar
vara log-normalt distribuerat räknas genomsnittet för uttrycket ut med användning av det geometriska
medelvärdet:

Där:

n Exp1, Exp2, Expn = Relativ kvantitet eller normaliserat uttryck av proverna i den biologiska gruppen

n n = antal prover i den biologiska gruppen

Normaliserat uttryck när en kontroll är vald
När du väljer ett kontrollprov i fönstret Experiment Settings (Experimentinställning) ställer programmet in
uttrycksnivån för kontrollprovet på 1. I denna situation normaliserar programmet de relativa kvantiteterna
för allt mål(gen)uttryck till kontrollkvantiteten (värdet 1). Detta normaliserade uttryck är ekvivalent med
analysen av det ej skalade normaliserade uttrycket när en kontroll är vald.

Obs! Detta kallas även relativt normaliserat uttryck (RNE) och X-faldig förändring.
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Standardavvikelse för det normaliserade uttrycket
Omskalning av det normaliserade uttrycksvärdet uppnås genom att standardavvikelsen för det
normaliserade uttrycket divideras med det normaliserade uttrycksvärdet för de högsta eller lägsta
enskilda uttrycksnivåerna, beroende på det skalningsalternativ som du väljer. Formeln för
normaliseringsfaktorns standardavvikelse (SD) är

Där:

n RQ = Relativ kvantitet för ett prov

n SD = standardavvikelse

n NF = Normaliseringsfaktor

n Ref = Referensmål

n n = Antal referensmål

När ett kontrollprov tilldelas behöver du inte utföra den här omskalningsfunktionen på standardavvikelsen,
som visas i följande formel:

Där:

n NE = Normaliserat uttryck

n RQ = Relativ kvantitet för ett prov

n SD = standardavvikelse

n GOI = Gen av intresse (ett mål)
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Normaliserat uttryck skalat till högsta uttrycksnivå
När körningen inte innehåller kontroller kan du skala det normaliserade uttrycket (NE) för varje mål (gen)
genom att dividera uttrycksnivån för varje prov med den högsta uttrycksnivån i alla prover. Programmet
ställer in den högsta uttrycksnivån till ett värde på 1 och skalar om alla provuttrycksnivåer. Formeln för
den högsta skalningen är

Där:

n GOI = Gen av intresse (mål)

Normaliserat uttryck skalat till lägsta uttrycksnivå
När körningen inte innehåller kontroller kan du skala det normaliserade uttrycket (NE) för varje mål (gen)
genom att dividera uttrycksnivån för varje prov med den lägsta uttrycksnivån i alla prover. Programmet
ställer in den lägsta uttrycksnivån till ett värde på 1 och skalar om alla provuttrycksnivåer. Formeln för
lägsta skalning är

Där:

n GOI = Gen av intresse (mål)

Normaliserat uttryck skalat till medelhög uttrycksnivå
Om körningen inte innehåller kontroller kan du skala det normaliserade uttrycket (NE) för varje mål (gen)
genom att dividera uttrycksnivån för varje prov med det geometriska medelvärdet för uttrycksnivån hos
alla prover. Programmet ställer in genomsnittlig uttrycksnivå till ett värde på 1 och skalar om alla
provuttrycksnivåer. Formeln för genomsnittlig skalning är

Där:

n GOI = Gen av intresse (mål)

n GM = Geometriskt medelvärde för normaliserat uttryck för alla prover
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Standardavvikelse för det skalade normaliserade uttrycket
Omskalning av det skalade värdet för normaliserat uttryck (NE) uppnås genom att det normaliserade
uttryckets standardavvikelse (SD) divideras med värdet för normaliserat uttryck för den högsta (MAX)
eller lägsta (MIN) uttrycksnivån beroende på valt skalningsalternativ.

Obs! När ett kontrollprov tilldelas behöver du inte utföra den här omskalningsfunktionen på
standardavvikelsen.

Beräkningen för den här formeln är

Där:

n NE = Normaliserat uttryck

n SD = standardavvikelse

n GOI = Gen av intresse (mål)

n MAX = högsta uttrycksnivå

n MIN = lägsta uttrycksnivå
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Felstaplar för standardavvikelse (lg) och medelvärdets
standardfel (lg)

Förutom användningen av konfidensintervall kan felstaplar visas för biologiska grupper baserat på
standardavvikelsen eller medelvärdets standardfel för log2 av uttrycket. Felstaplarna beräknas på
följande sätt:

RQ nedre felstapel = 2RQ(lg)-SD RQ(lg) eller 2RQ(lg)-SEM RQ(lg)

RQ övre felstapel = 2RQ(lg)+SD RQ(lg) eller 2RQ(lg)+SEM RQ(lg)

Där:

n RQ(lg) = log2 för den relativa kvantiteten för den biologiska gruppen

n SD RQ(lg) = standardavvikelse för den relativa kvantiteten (log2)

n SEM RQ(lg) = medelvärdets standardfel för den relativa kvantiteten (log2)

Uttryckets nedre felstapel = 2Exp.(lg)-SD Exp.(lg) eller 2Exp.(lg)-SEM Exp.(lg)

Uttryckets övre felstapel = 2Exp.(lg)+SD Exp.(lg) eller 2Exp.(lg)+SEM Exp.(lg)

Där:

n Exp.(lg) = log2 av uttrycket (normaliserat uttryck) för den biologiska gruppen

n SD RQ(lg) = standardavvikelse för uttrycket (log2)

n SEM RQ(lg) = medelvärdets standardfel för uttrycket (log2)
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X-faldig förändring
Fold change (X-faldig förändring) är ett mått på ökningen eller minskningen i uttrycket av ett mål för ett
experimentellt jämfört med ett kontrollprov eller biologisk grupp och bestäms på följande sätt:

Om Expression (experimental) > Expression (control) (Uttryck (experimentell) > Uttryck (kontroll)):

Om Expression (experimental) < Expression (control) (Uttryck (experimentell) < Uttryck (kontroll):

Obs! För Graphing (Diagram), baseras Expression (Uttryck) antingen på den relativa kvantiteten
eller det normaliserade uttrycket, beroende på vilket läge som valts (se Graphing (Diagram) på
sidan 260). För Scatter Plot (Spridningsdiagram) och Clustergram beräknas dock alltid x-faldig
förändring från det normaliserade uttrycket.
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Formler för korrigerade värden
Viktigt! Dessa beräkningar gäller endast när Analyze Using (Analysanvändning) är inställd på
Samples Only (Endast prover), Sample Biological Group (Prov från biologisk grupp) eller Biological
Group Sample (Biologiskt grupprov).

En skillnad mellan korrigerade värden och ej korrigerade värden ses endast om en standardkurva skapas
som del av realtids-PCR-körningen. Programvaran använder tre ekvationer för att bestämma felspridning:

n Standardfel

n Standardfel för normaliserat uttryck

n Standardfel för den normaliserade genen av intresse (mål)

Formeln för standardfel är

Där:

n n = Antal referensmål (gener)

n SD = standardavvikelse

Standardfelet för normaliseringsfaktorn i formeln för normaliserade uttryck är

Där:

n n = Antal referensmål

n SE = Standardfel

n NF = Normaliseringsfaktor

n RQ = Relativ kvantitet

Formeln för standardfel för normaliserad gen av intresse (GOI) är

Där:

n SE = Standardfel

n GOI = Gen av intresse (ett mål)
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n NF = Normaliseringsfaktor

n n = Antal referensmål

Beräkning av konfidensintervall för analys av biologiska
grupper

När analyser utförs av biologiska grupper Analyze Using (Analysanvändning) har ställts in på Biological
Groups Only (Endast biologiska grupper)) beräknas konfidensintervallen för relativ kvantitet och relativt
normaliserat uttryck.

Konfidensintervallen beräknas i logaritmisk skala baserat på t-fördelningen med följande formel:

Där:

n = medeluttryck för uttrycksnivåerna i logaritmisk skala för proverna i den biologiska gruppen

n SD = standardavvikelse för uttrycksnivåerna i logaritmisk skala för proverna i den biologiska gruppen

n n = antal prover i den biologiska gruppen

n t = erhålls från t-fördelningen baserat på graderna av frihet och alfanivån

Obs! Alfanivån kan ställas i fältet för P-tröskelvärde på fliken Graphing (Diagram).

När konfidensintervallen har beräknats omvandlas de till linjär skala och presenteras i tabellen Gene
Expression Data (Genuttrycksdata) och stapeldiagrammet på fliken Graphing (Diagram).

Beräkningar med Box and Whisker chart (Låddiagram)
Box andWhisker chart (låddiagrammet) visar distributionen av uttrycksvärdena inom en biologisk grupp
genom att plotta data som kvartiler. Kvartil 1 och 3 representeras av rutans nedre respektive övre gränser.
Medianen visas som en heldragen linje tvärsigenom rutan. ”Whiskers” (morrhårsvärdena) representerar
de minimi- och maximivärden som inte är avvikande i datauppsättningen. Avvikande värden är värden
som överskrider kvartil 1 och 3 med 1,5 gånger intervallet mellan kvartilerna.

Obs! Om det bara finns ett prov i den biologiska gruppen visas det som en enstaka cirkel, vilket
indikerar en enstaka datapunkt.

I nedanstående Box andWhisker chart (låddiagram) demonstreras hur dessa data återges.
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1. Avvikande värde. Detta avvikande värde är > Q3 + (1,5 x [Q3 – Q1]).

Obs! Placera muspekaren över cirkeln för att visa ett verktygstips som visar provnamnet
och informationen om relativ kvantitet eller normaliserat uttryck beroende på vilket läge
som valts.

2. Maximiavgränsning för ej avvikande värden

3. Övre/3:e kvartilen (Q3). 75 % av uttrycksvärdena är lägre än Q3.

4. Median, eller värdet närmast mitten, för de rangordnade uttrycksvärdena

5. Nedre/1:a kvartilen (Q1). 25 % av uttrycksvärdena är lägre än Q1.

6. Minimiavgränsning för ej avvikande värden

7. Avvikande värde. Detta avvikande värde är < Q1 – (1,5 x [Q3 – Q1]).

FÖRKLARING
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Bilaga B Revisionsloggar
CFXMaestro Dx programvara, Security Edition skapar revisionsloggar för data- och genstudiefiler (.prcd-
och .mgxd-filer). Alla ändringar som görs i eller åtgärder som utförs på säkra data- och genstudiefiler
registreras i filens revisionslogg när filen sparas. CFX Maestro Dx SE skapar en separat revisionslogg för
varje fil.

Du kan välja File > Save As (Arkiv > Spara som) och spara säkra signerade eller osignerade data- och
genstudiefiler i en annan mapp eller med ett annat namn. Den nya filen ärver revisionsloggen från
originalfilen. Revisionsloggen för den nya filen inkluderar även Spara som-aktiviteten. Ändringar av eller
åtgärder som utförts på den nya filen registreras i dess egna revisionslogg. Originalfilen behåller sin
revisionslogg, där ytterligare aktivitet registreras.

Revideringsbara händelser på sidan 303 listar de händelser som programvaran registrerar.

Visa revisionsloggar
Varje revisionslogg visar följande information:

n Revisionsrubrik

o File version (Filversion) – den sparade versionen av filen

o Date (Datum) – datumet för den aktuella revideringsbara händelsen

o User (Användare) – Windows-domänen och -användarnamnet för den inloggade användaren

o Comment (Kommentar) – den senast sparade kommentaren

o Signature (Signatur) – den elektroniska signaturen för den sista personen som undertecknade
filen

o Signature reason (Signaturskäl) – anledningen till signaturen

o Application (Program) – CFX Maestro Dx SE

o Application version (Programversion) – den aktuella versionen av CFX Maestro Dx SE

o Full user (Fullständig användare) – den inloggade användarens fullständiga namn

o Machine (Maskin) – den dator där CFX Maestro Dx SE är installerad.

n Revisionsändring
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o Object (Objekt) – objektet som ändrades (det reviderade objektet)

o Old value (Tidigare värde) – det tidigare värdet

o New value (Nytt värde) – det nya värdet

o Desciption (Beskrivning) – beskrivningen av ändringen

Så här visar du revisionsloggen

u Välj View > Audit Trail (Visa > Revisionslogg) i den öppna data- eller genstudiefilen. Filens
revisionslogg visas.

Som standard sorteras data efter datum och tid och alla händelser visas i den utvidgade vyn. Du kan
filtrera vyn efter användarnamn och objekt, och du kan dölja den utvidgade vyn för att enkelt sortera
efter rubrikfält. Du kan också visa revisionsloggen som en HTML-rapport.

Så här sorterar du efter användarnamn

u Välj målanvändaren i listrutan User Name (Användarnamn).

Så sorterar du efter objekt

u Välj målet i listrutan Object (Objekt).

Så här döljer du den fullständiga beskrivningen av händelser

u Klicka på Collapse All (Dölj alla).

Så här sorterar du data i ändringstabellen

u Klicka på diamantsymbolen i datakolumnsrubriken för att sortera i stigande ordning (A till Ö, minsta
antal till största eller tidigast till senaste).
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Så här skriver du ut revisionsloggen

1. Klicka på HTML Report (HTML-rapport) för att visa revisionsloggen i en webbläsare.

2. Gör något av följande i webbläsarfönstret:

n Välj Arkiv > Skriv ut.

n Högerklicka på rapporten och välj Skriv ut.

Revideringsbara händelser
CFX Maestro Dx SE registrerar följande revideringsbara händelser i data- och genstudiefiler.

Revideringsbara händelser under körning

n Run Start Time (Starttid för körning)

n Run Time Plate edits (Plattredigeringar under körning)

n Run Time Protocol edits (Protokollredigeringar under körning)

n Run End Time (Sluttid för körning)

Revideringsbara händelser när en datafil skapas

n Data file created (Datafil skapad)

n Interpolated Plate Reads added by the system (Interpolerade plattavläsningar läggs till av systemet)

Revideringsbara händelser när en datafil sparas

n General (Allmänt)

o Name (Namn)

o Signing (Signering)

o Plate Setup (Plattinställning)

o Display Wells (Visa brunnar)

o Analyzed fluorophores (Analyserade fluoroforer)

o Plate edits (Plattredigeringar)

o Analysis mode (Analysläge)

o PCR Active Well Group (PCR, aktiv brunnsgrupp)
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n Quantification tab (Fliken Kvantifiering)

o Active step (Aktivt steg)

o Settings – Cq Determination mode (Inställningar – Cq Bestämningsläge)

o Settings – Baseline Setting (Inställningar – Baslinjeinställning)

o Drift correction applied (Förflyttningskorrigering tillämpad)

o Settings – Cycles to Analyze (Inställningar – Cykler att analysera)

o Settings – Analysis Mode (Inställningar – Analysläge)

o Settings— Baseline Threshold (Inställningar – Baslinjetröskel)

n Melt Curve tab (Fliken Smältkurva)

o Active step (Aktivt steg)

o Peak type displayed (Topptyp visas)

o Peak analysis threshold (Toppanalyströskel)

n End Point tab (Fliken Slutpunkt)

o Active fluorophore/target (Aktivt fluorofor/mål)

o End cycles to average (Slutcykler till medeltal)

o Tolerance calculation method (Toleransberäkningsmetod)

o Percentage of range (Procent av intervall)

n Allelic Discrimination tab (Fliken Allelisk diskriminering)

o X- and Y-axis fluorophore (X- och Y-axelns fluorofor)

o Select cycle number (Välj cykelnummer)

o View call map (Visa anropskarta)

n Gene Expression tab – All plots (Fliken Genuttryck – alla plottningar)

o Experiment Settings – Target reference (Experimentinställningar – Målreferens)

o Experiment Settings – Sample control (Experimentinställningar – Provkontroll)

o Experiment Settings – Auto efficiency (Experimentinställningar – Automatisk effektivitet)

o Experiment Settings – Efficiency (Experimentinställningar – Effektivitet)
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n Gene Expression tab – Graphing (Fliken Genuttryck – Diagram)

o Analysis mode (Analysläge)

o Graph data (Diagramdata)

o X-axis (X-axel)

o Y-axis (Y-axel)

o Scaling option (Skalningsalternativ)

o Error bar (Felstapel)

o Error bar multiplier (Multiplikator för felstaplar)

o P-value threshold (Tröskel för P-värde)

n Gene Expression tab – Clustergram (Fliken Genuttryck – Clustergram)

o Cluster By (Kluster efter)

o Split out replicates (Dela upp replikat)

n Gene Expression tab— Scatter Plot (Fliken Genuttryck – Spridningsdiagram)

o Control biological group (Biologisk kontrollgrupp)

o Experimental Biological Group (Biologisk experimentgrupp)

o Fold change threshold (Tröskel för X-faldig)

n Gene Expression tab— ANOVA (Fliken Genuttryck – ANOVA)

o P-value threshold (Tröskel för P-värde)

n Plate Setup – View/Edit Plate (Plattinställning – Visa/redigera platta)

o Settings – PlateType (Inställningar – Plattyp)

o Settings – Units (Inställningar – Enheter)

o Editing Tools – Flip Plate (Redigeringsverktyg – Vänd platta)

o Well groups (Brunnsgrupper)

o Plate fluorophores (Plattfluoroforer)

n Plate Setup—Replace Plate and Apply PrimePCR File (Plattinställning – Ersätt platta och använd
PrimePCR-fil)

o Plate Setup Import (Import av plattinställning)
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Revideringsbara ändringar för genstudiefiler

General (Allmänt)

n Name (Namn)

n Study Setup tab (Fliken Studieinställning)

o Add/Remove data files (Lägg till/ta bort datafiler)

n Study Analysis tab (Fliken Studieanalys)
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Du kan konfigurera CFX Maestro Dx programvara, Security Edition för användning med ett LIMS
(Laboratory Information Management System). För LIMS-integration kräver CFX Maestro Dx SE
plattinställningsinformation som genererats av LIMS-plattformen (en LIMS-fil, *.plrn), en protokollfil som
skapats med hjälp av CFX Maestro Dx SE (*.prcl), en definierad dataexportplats och ett definierat
exportformat.

När körningen är klar genererar CFX Maestro Dx SE en datafil (.pcrd) och sparar den till en definierad
mapp för dataexporter. CFX Maestro Dx SE kan också skapa en LIMS-kompatibel datafil i .csv-format och
spara den på samma plats.

Skapa LIMS-kompatibla datafiler
I den här bilagan förklaras hur du ställer in CFX Maestro Dx SE för att skapa, spara och exportera
LIMS-kompatibla datafiler.

Ställa in LIMS-mapp och dataexportalternativ
Som standard sparar CFX Maestro Dx SE LIMS-protokoll, filer och dataexportfiler i den här mappen:
C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Det går att konfigurera CFX Maestro Dx SE så att filerna sparas i en annan mapp och ändra
exportalternativen för LIMS-data.

Så här konfigurerar du en LIMS-mapp och dataexportalternativ

1. Välj Tools > Options (Verktyg > Alternativ) i hemfönstret.

2. Välj Data Export Settings (Dataexportinställningar) i dialogrutan Options (Alternativ).
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3. (Valfritt:) Välj Automatically export LIMS data at end of run (Exportera LIMS-data automatiskt efter
körningen).

Programvaran exporterar automatiskt LIMS-data efter varje körning och sparar den på den angivna
platsen.

4. Klicka på LIMS Data Export Settings (LIMS-dataexportinställningar) om du vill ändra
standardexportalternativen för LIMS-data.

Viktigt! Endast LIMS-data som har exporterats som en .csv-fil kan importeras tillbaka i
CFX Maestro Dx SE.

5. I dialogrutan LIMS Data Export Format Settings (Inställningar av LIMS-dataexportformat) väljer du
nödvändiga exportalternativ och klickar på OK.

6. I dialogrutan Options (Alternativ) går du till och väljer en standardmapp i vilken du vill spara LIMS-
datafilerna. Du kan välja olika platser för varje filtyp:

n Protocol (Protokoll)

n LIMS file (LIMS-fil)

n Data export (Dataexport)

308 | CFX Maestro Dx SE programvara



Skapa LIMS-kompatibla datafiler

7. Klicka på OK för att spara ändringarna och stänga dialogrutan Options (Alternativ).

Skapa ett LIMS-protokoll
Du startar en LIMS-körning genom att skapa en CFX Maestro Dx SE-protokollfil (*.prcl) och spara den på
den angivna platsen för LIMS-protokollmappen.

Mer information finns i Kapitel 7, Skapa protokoll.

Skapa en LIMS-fil
En LIMS-fil (*.plrn) innehåller plattinställningsinformation och protokollets filnamn. Den här filen genereras
av ditt interna LIMS. CFX Maestro Dx SE använder LIMS-filen för att skapa en plattfil för användning med
en protokollfil.

CFX Maestro Dx SE tillhandahåller plattimportmallar som du kan redigera för att skapa anpassade LIMS-
plattfiler.

Tips: Den här åtgärden bör utföras av en LIMS-specialist.

Så här skapar du en LIMS-fil

1. Välj View > Show > LIMS File Folder (Visa > Visa > LIMS-filmapp) i hemfönstret.

2. Öppna mappen LIMS Templates (LIMS-mallar) och välj en .csv-fil att importera till din interna LIMS.

3. Redigera mallfilen genom att fylla i de fält som visas i Tabell 38.

4. Gör något av följande:

n För att spara dina ändringar för framtida bruk, spara filen som en .csv-fil.

n För att spara dina ändringar och använda filen omedelbart, spara filen med .plrn-tillägget.

n Spara mallen med filnamnstillägget .plrn i mappen LIMS File (LIMS-fil).

Viktigt! CFX Maestro Dx SE kan endast öppna .plrn-filen. Du måste spara .csv-filen som .plrn
för att starta LIMS-körningen.

Kolumn Rad Beskrivning Innehåll Syfte

A 1 Plate Header (Plattrubrik) Redigera inte Fördefinierat

A, B, C 2 Field/Data/Instruction
(Fält/Data/Instruktion)

Redigera inte Fördefinierat

Tabell 38. Beskrivning av LIMS .csv-filinnehållet
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Kolumn Rad Beskrivning Innehåll Syfte

B 3 Version Redigera inte Fördefinierat

B 4 Plattstorlek Redigera inte Fördefinierat

B 5 Plate Type (Plattyp) Ange "BRWhite”, "BR
Clear" eller annan
kalibrerad plattyp

Krävs

B 6 Skanningsläge Ange "SYBR/FAMOnly:",
"All Channels" eller "FRET"

Krävs

B 7 Enheter Ange något av följande:
"copy number", "fold
dilution", "micromoles",
"nanomoles", "picomoles",
"femtomoles", "attomoles",
"milligrams", "micrograms",
"nanograms", "picograms",
"femtograms", "attograms"
eller "percent"

Krävs

B 8 Run Log (Körnings-ID) Ge en kort beskrivning eller
ange en streckkod som
identifierar den här
körningen (minst 30 tecken,
komman får ej användas)

Tillval

B 9 Run Notes
(Körningskommentarer)

Ange en beskrivning av
körningen

Tillval

B 10 Run Protocol
(Körningsprotokoll)

Ange protokollfilnamnet
exakt som det är skrivet.

Krävs

A 11 Data File (Datafil) Ange datafilnamn Tillval

A 12–15 TBD/tom Redigera inte Fördefinierat

A 16 Plate Data (Plattdata) Redigera inte Fördefinierat

A 17–113 Well Position
(Brunnsposition)

Redigera inte Fördefinierat

Tabell 38. Beskrivning av LIMS .csv-filinnehållet, forts.
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Kolumn Rad Beskrivning Innehåll Syfte

B-G Ch1 Dye, Ch2 Dye, Ch3
Dye, Ch4 Dye, Ch5 Dye,
FRET

Ange namnet på en
kalibrerad fluorofor (till
exempel FAM) för varje
kanal som används

Krävs

H Provtyp Ange en av följande
provtyper: "Unknown",
(Okänd), "Standard",
"Positive Control", (Positiv
kontroll) "Negative Control",
(Negativ kontroll) "NTC"
eller "NRT"

Krävs

F Sample Name
(Provnamn)

Ange provnamn Tillval

J-O CH1 Target, CH2 Target,
CH3 Target, CH4 Target,
CH5 Target, FRET Target

Ange målnamnet för varje
kanal som används

Tillval

P Collection Name
(Samlingsnamn)

Ange namn på biologisk
uppsättning

Tillval

Q Replikat Ange ett positivt heltal för
varje uppsättning replikat.
Värdet får inte vara noll.

Tillval

R-W CH1 Quantity, CH2
Quantity, CH3 Quantity,
CH4 Quantity, CH5
Quantity, FRET Quantity

Ange kvantitetsvärden för
eventuella standarder.
Ange koncentrationen i
decimalform.

Krävs för alla
standarder

Tabell 38. Beskrivning av LIMS .csv-filinnehållet, forts.
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Kolumn Rad Beskrivning Innehåll Syfte

X Well Note
(Brunnskommentar)

Ange en brunnskommentar
(högst 20 tecken)

Obs! Även om
CFX Maestro Dx SE
har en gräns på 20
tecken när du skriver
brunnskommentarer
via programvaran, kan
fältet Well Note
(Brunnskommentar)
innehålla upp till 500
tecken om det ingår i
en importerad .plrn-fil.
Men CFX Maestro Dx
SE visar endast de
första 20 tecknen. Den
exporterade .pcrd-filen
innehåller alla tecken i
fältet Well Note
(Brunnskommentar),
inga data går förlorade.

Tillval

Y-AD Ch1Well Color, Ch2Well
Color, Ch3Well Color,
Ch4Well Color, Ch5Well
Color, FRETWell Color

Ange eventuell
användardefinierad
kurvfärg i ett 32-bitars
decimalformat med heltal
(argb)

Tillval

Tabell 38. Beskrivning av LIMS .csv-filinnehållet, forts.

Starta en LIMS-körning
Så här startar du en LIMS-körning

1. Gör något av följande för att öppna en LIMS-fil i .plrn-format:

n I hemfönstret väljer du View > Show > LIMS File Folder (Visa > Visa > LIMS-filmapp) och öppnar
målfilen (.plrn).

n I hemfönstret väljer du File > Open > LIMS File (Arkiv > Öppna > LIMS-fil) och öppnar målfilen
(.plrn).
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Filen öppnas på fliken Start Run (Starta körning) i guiden Run Setup (Körningsinställning). På fliken
Start Run (Starta körning) visas information om experimentet som ska köras. Där visas också det
eller de anslutna instrumentblocken som du kan köra experimentet på.

2. Välj ett instrument på fliken Start Run (Starta körning) och klicka på Start Run (Starta körning).

Exportera data till ett LIMS
När körningen slutförs, genererar CFX Maestro Dx SE en datafil (.pcrd) och sparar den på platsen för den
definierade dataexportmappen.

Så här exporterar du datafilen till ett LIMS

u Öppna .pcrd-filen och välj Export > Export to LIMS Folder (Exportera > Exportera till LIMS-mapp).

Tips: Om du väljer Automatically Export Data after Run (Exportera data automatiskt efter körning) i
LIMS Options (LIMS-alternativ), skapar CFX Maestro Dx SE en LIMS-kompatibel datafil i .csv-format
och sparar den i samma mapp.
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Bilaga D Felsöka CFX Maestro Dx programvara,
Security Edition

Den här bilagan innehåller förslag på hur du kan felsöka problem som kan uppstå när du uppgraderar
eller kör CFX Maestro Dx programvara, Security Edition.

Vitlista CFX Maestro Dx programvara, Security Edition-filer
och -mappar

Din IT-avdelning kan ha vidtagit hårda säkerhetsåtgärder för programvara som skydd mot virus och
skadlig kod. Dessa åtgärder kan påverka tiden som krävs för att uppgradera eller köra CFX Maestro Dx
SE.

För att förbättra prestanda för CFX Maestro Dx SE rekommenderar Bio-Rad att IT-avdelningen vitlistar
följande filer och mappar i brandväggsinställningarna i antivirusprogrammet som är installerat på
CFX Maestro Dx SE-datorn:

Mappar

n C:\Program Files (x86)\Bio-Rad\CFX_MDx

n C:\ProgramData\Bio-Rad\CFX_MDx

n C:\Users\Public\Documents\Bio-Rad\CFX_MDx

Filer

n Alla .exe-filer i mappen C:\Program Files (x86)\Bio-Rad\CFX_MDx

n R.exe och Rscript.exe (finns i mappen C:\Program Files (x86)\Bio-Rad\CFX _MDx\ R\
R-3.3.1\bin)
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Application Log (Applikationslogg)
Innan en ny körning startas utför CFX Opus Dx-systemet ett självdiagnostiktest för att bekräfta att det körs
inom specifikationerna. Programvaran registrerar resultaten av detta test i filen Run Log (Körningslogg)
och filen Application Log (Applikationslogg). Om du lägger märke till ett problem i ett eller flera experiment
öppnar du körnings- och applikationsloggarna för att ta reda på när problemet uppstod.

CFX Maestro Dx SE Dx spårar information om tillståndet för ett instrument under en körning i Application
Log (Applikationslogg). Använd dessa loggar för att spåra händelser som uppstår på instrument och i
programvaran samt för felsökning.

Så här öppnar du applikationsloggen

u I hemfönstret väljer du View > Application Log (Visa > Applikationslogg).

Klicka på knappen HTML Report (HTML-rapport) för att visa applikationsloggen som en HTML-fil.
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Hämta loggfiler för program och firmware
Program- och firmwareloggarna innehåller information som beskriver åtgärder som utförts under
användningen av programvaran och prestanda för körningar. Dessa loggar registrerar även eventuella
program- eller firmwarefel som uppstår vid användning av programvaran eller instrumentet.

Så här kommer du åt loggfilerna för programmet och firmware:

1. Högerklicka på instrumentet i rutan Detected Instruments (Hittade instrument).

2. Välj Retrieve Log Files (Hämta loggfiler).

3. I dialogrutan Browse for Folder (Bläddra till mapp) väljer du målmappen på den nätverksenhet eller
lokala enhet där du vill spara loggfilerna.

Obs! Mappen heter "Logs" (Loggar).

4. Klicka på OK för att spara filerna.

Viktigt! Om du sparar en loggfil med samma filnamn som en befintlig loggfil kommer den
befintliga loggfilen att skrivas över.

Felsökning
Normalt kan problemmed program- och instrumentkommunikation lösas genom omstart av datorn och
systemet. Glöm inte att spara eventuella pågående arbeten innan du startar om.

Obs! Kontrollera att datorn har tillräckligt RAM-minne och ledigt hårddiskutrymme. Minimikravet för
RAM är 4 GB och minimikravet för hårddiskutrymme är 128 GB.

Strömavbrott
Vid ett strömavbrott stängs instrumentet och datorn av. Om strömavbrottet är kortvarigt återupptar
instrumentet körningen av ett protokoll, men strömavbrottet noteras i Application Log (Applikationslogg).
Beroende på datorinställningarna och längden på strömavbrottet försöker instrumentet och programvaran
att återuppta körningen beroende på protokollsteget:

n Om protokollet är i ett steg utan någon plattläsning fortsätter protokollet att köras så snart
instrumentet återfår ström.

n Om protokollet är i ett steg med en plattläsning väntar instrumentet på att programvaran ska startas
om och återuppta kommunikationen för att samla in data. I en sådan situation fortsätter protokollet
endast om datorn inte stänger av programvaran. När datorn och programvaran startats igen fortsätter
protokollet.
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Överföra filer till CFX Maestro Dx SE-datorn
Du kan överföra data och loggfiler som finns på instrumentet till hårddisken på en ansluten CFX Maestro
Dx SE-dator.

Tips: Alla filer i instrumentbasens realtidsdatamapp överförs till datorn.

Obs! Från CFX Opus Dx-instrument kan du bara överföra loggfiler. Alla loggfiler på instrumentet
överförs till datorn.

Så här hämtar du filer från instrumentet

1. I rutan Detected Instruments (Hittade instrument) i hemfönstret högerklickar du på målinstrumentet
och väljer Retrieve Log Files (Hämta loggfiler).

2. Välj en mapp där du vill spara de hämtade filerna.

3. Klicka på OK.

Installera CFX Maestro Dx programvara, Security Edition manuellt
Så här installerar du CFX Maestro Dx SE manuellt

1. Koppla bort eventuella anslutna instrument från datorn.

Sök upp och koppla bort instrumentets USB-kabel på CFX Maestro Dx SE-datorn. Den ände som är
ansluten till instrumentet kan sitta kvar på plats.

2. Logga in på CFX Maestro Dx SE-datorn med administratörsbehörighet.

3. Sätt in USB-enheten med CFX Maestro Dx SE i datorns USB-port.

4. Gå till och öppna USB-enheten CFX Maestro Dx SE i Utforskaren.

5. Öppna mappen CFX och dubbelklicka på CFXMaestroDxSetup.exe för att installera CFX Maestro Dx
SE.

6. Följ anvisningarna på skärmen för att installera programvaran.

När detta är klart visas välkomstskärmen för Bio-Rad CFX Maestro Dx programvara, Security Edition
på datorskärmen och ikonen Bio-Rad CFX Maestro Dx programvara, Security Edition visas på
skrivbordet.

7. Nu kan du mata ut programvarans USB-enhet på ett säkert sätt och starta CFX Maestro Dx SE.
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Ominstallera drivrutinerna
Så här ominstallerar du instrumentdrivrutinerna

u I hemfönstret väljer du Tools > Reinstall Instrument Drivers (Verktyg > Ominstallera
instrumentdrivrutiner).

Obs! Om du har problemmed programvarans kommunikation med ett realtidssystem när du har
ominstallerat drivrutinerna och kontrollerat USB-anslutningen, bör du kontakta Bio-Rads tekniska
support.
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Bilaga E Bio-Rad Free and Open-Source Notices
for PCR Products

This document includes licensing information relating to free, open-source, and public-source software
and data (together, the “MATERIALS”) included with or used to develop Bio-Rad products and services.
The terms of the applicable free, open-source, and public-source licenses (each an “OPEN LICENSE”)
govern Bio-Rad’s distribution and your use of the MATERIALS. Bio-Rad and the third-party authors,
licensors, and distributors of the MATERIALS disclaim all warranties and liability arising from all use and
distribution of the MATERIALS. To the extent the OSS is provided under an agreement with Bio-Rad that
differs from the applicable OSS LICENSE, those terms are offered by Bio-Rad alone.

Bio-Rad has reproduced below copyright and other licensing notices appearing within the MATERIALS.
While Bio-Rad seeks to provide complete and accurate copyright and licensing information for all
MATERIALS, Bio-Rad does not represent or warrant that the following information is complete, correct, or
error-free. MATERIALS recipients are encouraged to (a) investigate the identified MATERIALS to confirm
the accuracy of the licensing information provided and (b) notify Bio-Rad of any inaccuracies or errors
found in this document so that Bio-Rad may update this document accordingly.

Certain OPEN LICENSES (such as the Affero General Public Licenses, Common Development and
Distribution Licenses, Common Public License, Creative Commons Share-Alike License, Eclipse Public
License, Mozilla Public Licenses, GNU General Public Licenses, GNU Library/Lesser General Public
Licenses, and Open Data Commons Open Database License) require that the source materials be made
available to recipients or other requestors under the terms of the same OPEN LICENSE.

The corresponding open source software is available for download from the links in the section that
follows.
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Software Notices

ZedGraph
Project homepage/download site:

https://sourceforge.net/projects/zedgraph/

Bio-Rad source code site:

https://github.com/bio-rad-lsg-open-source/ZedGraph-5.0.1

External source code site:

https://github.com/ZedGraph/ZedGraph

Project licensing notices:

/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

/sources/ZedGraph/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

Standard Open License Text

LGPL-2.1
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 59 Temple
Place, Suite 330, Boston, MA 02111-1307 USA Everyone is permitted to
copy and distribute verbatim copies of this license document, but
changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]
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Preamble

The licenses for most software are designed to take away your freedom
to share and change it. By contrast, the GNU General Public Licenses
are intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some
specially designated software packages--typically libraries--of the
Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about
whether this license or the ordinary General Public License is the
better strategy to use in any particular case, based on the
explanations below.

When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
you have the freedom to distribute copies of free software (and
charge for this service if you wish); that you receive source code or
can get it if you want it; that you can change the software and use
pieces of it in new free programs; and that you are informed that you
can do these things.

To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender
these rights. These restrictions translate to certain
responsibilities for you if you distribute copies of the library or
if you modify it.

For example, if you distribute copies of the library, whether gratis
or for a fee, you must give the recipients all the rights that we
gave you. You must make sure that they, too, receive or can get the
source code. If you link other code with the library, you must
provide complete object files to the recipients, so that they can
relink them with the library after making changes to the library and
recompiling it. And you must show them these terms so they know their
rights.

We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there
is no warranty for the free library. Also, if the library is modified
by someone else and passed on, the recipients should know that what
they have is not the original version, so that the original author's
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reputation will not be affected by problems that might be introduced
by others.

Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those
libraries into non-free programs.

When a program is linked with a library, whether statically or using
a shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with
the library.

We call this license the "Lesser" General Public License because it
does Less to protect the user's freedom than the ordinary General
Public License. It also provides other free software developers Less
of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain
special circumstances.

For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it
becomes a de-facto standard. To achieve this, non-free programs must
be allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free
software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
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operating system, as well as its variant, the GNU/Linux operating
system.

Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter
must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms
of this Lesser General Public License (also called "this License").
Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or
translated straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term
"modification".)

"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control
compilation and installation of the library.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output
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from such a program is covered only if its contents constitute a work
based on the Library (independent of the use of the Library in a tool
for writing it). Whether that is true depends on what the Library
does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's
complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the
Library. You may charge a fee for the physical act of transferring a
copy, and you may at your option offer warranty protection in
exchange for a fee.

2. You may modify your copy or copies of the Library or any portion
of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge
to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a
table of data to be supplied by an application program that uses the
facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table, the
facility still operates, and performs whatever part of its purpose
remains meaningful. (For example, a function in a library to compute
square roots has a purpose that is entirely well-defined independent
of the application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must be
optional: if the application does not supply it, the squareroot
function must still compute square roots.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
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distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Library.

In addition, mere aggregation of another work not based on the
Library with the Library (or with a work based on the Library) on a
volume of a storage or distribution medium does not bring the other
work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do
this, you must alter all the notices that refer to this License, so
that they refer to the ordinary GNU General Public License, version
2, instead of to this License. (If a newer version than version 2 of
the ordinary GNU General Public License has appeared, then you can
specify that version instead if you wish.) Do not make any other
change in these notices. Once this change is made in a given copy, it
is irreversible for that copy, so the ordinary GNU General Public
License applies to all subsequent copies and derivative works made
from that copy. This option is useful when you wish to copy part of
the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or
derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany
it with the complete corresponding machine- readable source code,
which must be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange. If
distribution of object code is made by offering access to copy from a
designated place, then offering equivalent access to copy the source
code from the same place satisfies the requirement to distribute the
source code, even though third parties are not compelled to copy the
source along with the object code.

5. A program that contains no derivative of any portion of the
Library, but is designed to work with the Library by being compiled
or linked with it, is called a "work that uses the Library". Such a
work, in isolation, is not a derivative work of the Library, and
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therefore falls outside the scope of this License. However, linking a
"work that uses the Library" with the Library creates an executable
that is a derivative of the Library (because it contains portions of
the Library), rather than a "work that uses the library". The
executable is therefore covered by this License. Section 6 states
terms for distribution of such executables. When a "work that uses
the Library" uses material from a header file that is part of the
Library, the object code for the work may be a derivative work of the
Library even though the source code is not. Whether this is true is
especially significant if the work can be linked without the Library,
or if the work is itself a library. The threshold for this to be true
is not precisely defined by law. If such an object file uses only
numerical parameters, data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in length), then
the use of the object file is unrestricted, regardless of whether it
is legally a derivative work. (Executables containing this object
code plus portions of the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or
link a "work that uses the Library" with the Library to produce a
work containing portions of the Library, and distribute that work
under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse
engineering for debugging such modifications. You must give prominent
notice with each copy of the work that the Library is used in it and
that the Library and its use are covered by this License. You must
supply a copy of this License. If the work during execution displays
copyright notices, you must include the copyright notice for the
Library among them, as well as a reference directing the user to the
copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-
readable source code for the Library including whatever changes were
used in the work (which must be distributed under Sections 1 and 2
above); and, if the work is an executable linked with the Library,
with the complete machine-readable "work that uses the Library", as
object code and/or source code, so that the user can modify the
Library and then relink to produce a modified executable containing
the modified Library. (It is understood that the user who changes the
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contents of definitions files in the Library will not necessarily be
able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a copy
of the library already present on the user's computer system, rather
than copying library functions into the executable, and (2) will
operate properly with a modified version of the library, if the user
installs one, as long as the modified version is interface-compatible
with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three
years, to give the same user the materials specified in Subsection
6a, above, for a charge no more than the cost of performing this
distribution.

d) If distribution of the work is made by offering access to copy
from a designated place, offer equivalent access to copy the above
specified materials from the same place.

e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.

It may happen that this requirement contradicts the license
restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot
use both them and the Library together in an executable that you
distribute.

7. You may place library facilities that are a work based on the
Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a
combined library, provided that the separate distribution of the work
based on the Library and of the other library facilities is otherwise
permitted, and provided that you do these two things:
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a) Accompany the combined library with a copy of the same work based
on the Library, uncombined with any other library facilities. This
must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that
part of it is a work based on the Library, and explaining where to
find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the
Library except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under
this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated
so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are

prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the
Library subject to these terms and conditions. You may not impose any
further restrictions on the recipients' exercise of the rights
granted herein. You are not responsible for enforcing compliance by
third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do
not excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under
this License and any other pertinent obligations, then as a
consequence you may not distribute the Library at all. For example,
if a patent license would not permit royalty-free redistribution of
the Library by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both it and this
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License would be to refrain entirely from distribution of the
Library.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended
to apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a
licensee cannot impose that choice. This section is intended to make
thoroughly clear what is believed to be a consequence of the rest of
this License.

12. If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time. Such
new versions will be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and
"any later version", you have the option of following the terms and
conditions either of that version or of any later version published
by the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published by
the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
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copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free
status of all derivatives of our free software and of promoting the
sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER MATERIALS), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest
possible use to the public, we recommend making it free software that
everyone can redistribute and change. You can do so by permitting
redistribution under these terms (or, alternatively, under the terms
of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It
is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should
have at least the "copyright" line and a pointer to where the full
notice is found.
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<one line to give the library's name and a brief idea of what it
does.>

Copyright (C) <year> <name of author>

This library is free software; you can redistribute it and/or modify
it under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is
distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public
License for more details.

You should have received a copy of the GNU Lesser General Public
License along with this library; if not, write to the Free Software
Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307
USA

Also add information on how to contact you by electronic and paper
mail. You should also get your employer (if you work as a programmer)
or your school, if any, to sign a "copyright disclaimer" for the
library, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the
library `Frob' (a library for tweaking knobs) written by James Random
Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!
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Minpack Copyright Notice (1999) University of Chicago. Med ensamrätt

Vidaredistribution och användning i käll- och binärformat, med eller utan ändring, tillåts under
förutsättning att följande villkor är uppfyllda:

1. Omdistributioner av källkoden måste innehålla ovanstående copyrightinformation, denna lista med
villkor och följande ansvarsfriskrivning.

2. Omdistributioner i binär form måste innehålla ovanstående copyrightinformation, denna lista med
villkor och följande ansvarsfriskrivning i dokumentationen och/eller andra material sommedföljer
distributionen.

3. Eventuell dokumentation för slutanvändare sommedföljer omdistributionen måste innehålla följande
erkännande:

"Den här produkten inkluderar programvara som har utvecklats av University of Chicago, som Operator of
Argonne National Laboratory."
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